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Resumen. El presente trabajo consisti6 en la actualizacion de la cartografia
geologica de la Sierra de Perija mediante la utilizacion de imagenes satelitales
LANDSAT 7 ETM (coordenadas 72°30° a 73°05’ longitud oeste y 9°40° a 10°00°
latitud norte). Este trabajo busca darle una solucion alternativa a la problematica que
representa la necesidad de la realizacion de un estudio geoldgico en aquellas zonas de
dificil acceso. En busqueda de una solucidon aplicable para todas aquellas regiones
que puedan presentar esa misma problematica, se propone el uso de los softwares
ENV1 4.2, ERDAS Imagine 8.6 y ArcGis 9.1 para el procesamiento e interpretacion
de imagenes satelitales, sirviendo como herramienta util para la actualizacion de
datos geologicos de zonas de dificil acceso. Durante el procesamiento de las
imagenes se obtuvo un grupo de subproductos, que de manera individual o conjunta,

aportaron informaciéon para la generacion del producto final, el mapa geoldgico



actualizado del area propuesta, que al ser comparado con informacion previa, a
manera de tener una referencia visual de la zona, permiti6 demostrar que con la
utilizacion de este tipo de estudio es posible llegar a resultados muy similares a los

que se han obtenido con estudios de geologia clasica.
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CAPITULO |

INTRODUCCION

La utilizacion de sensores remotos dentro de los estudios geoldgicos ha sido
desde su implantacion una herramienta de mucha utilidad para reconocer, identificar
y corroborar ciertos rasgos presentes en la superficie del planeta. Estos permiten
explorar la zona de estudio sin tener que trasladarse al sitio, ya sea como parte previa

a la fase de campo o como parte fundamental en la cual se base el estudio.

Una de las bondades de los sensores remotos, es que permite visualizar ciertos
rasgos que quizas en campo serian imposibles de determinar e identificar, siendo de
mucha utilidad entre otras cosas para la evaluacion de los sistemas de drenajes

existentes.

El empleo de los sensores remotos se remonta en un principio a la utilizacion
de fotografias aéreas, pasando luego a las imagenes de radar hasta llegar en la

actualidad a la interpretacion de iméagenes satelitales.

En la actualidad los sensores remotos incluyen fotografias, sensores aéreos y
barredores satelitales sofisticados, sin embargo, un sistema satelital ofrece las

siguientes ventajas sobre los demas:

» Los datos satelitales adquiridos por un sensor satelital pueden ser transmitidos a
través de radio o de microondas y almacenados en cintas magnéticas, de manera
que ellos pueden ser procesados y analizados facilmente con la ayuda de

computadores.
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» Muchos satélites en Orbita sobre la tierra cubren la misma area de la superficie

terrestre de una manera regular lo cual facilita la deteccion de cambios.

» Una vez que el satélite se ha lanzado, el costo de adquisicion de datos es bastante

menor que el de los datos obtenidos desde plataformas aéreas.

» Los satélites tienen una geometria muy estable, lo que significa que hay menos

posibilidad de distorsion u oblicuidad en la imagen final.

Un sistema satelital esta compuesto de un barredor con sensores y de una
plataforma satelital, a su vez, los sensores estin compuestos de detectores. El
barredor es el sistema completo de adquisicion de datos, tal como el barredor TM de

Landsat. El barredor incluye el sensor y los detectores.

El sensor es un dispositivo que recolecta energia, la convierte en seial
eléctrica y la presenta de forma adecuada para obtener informacién sobre el medio

ambiente (Colwell 1983).

Un detector es un dispositivo de un sistema sensor que registra la radiacion
electromagnética. En el caso del sistema sensor del barredor TM de Landsat existen
16 detectores por cada banda espectral (exceptuando la banda 6 que posee 4

detectores).

Por otro lado, las imagenes generadas por el Landsat 7 adquiridas por el
sensor ETM+ presentan una mejor relacion costo-beneficio que los datos generados
por satélites de resolucion media (de 15 a 30 metros). Un SIG esta disefiado para
capturar, almacenar, manipular, analizar y desplegar en todas sus formas la
informacion geograficamente referenciada con el fin de resolver problemas complejos
de planificacion y gestion; dicha informacion puede ser almacenada en formato raster

o vectorial.
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Adicionalmente, las imagenes satelitales pueden ser trabajadas en programas
como el ENVI, ERDAS y ArcGis, siendo procesadas y digitalizadas para su posterior
analisis. Los datos de una imagen obtenida mediante la percepcion remota son una
representacion de la superficie de la tierra. Dichos programas proveen muchas
herramientas disefiadas para extraer la informacion necesaria de las imagenes;

almacenandolas en archivos de datos llamados archivos de imagen.
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1.1. OBJETIVO GENERAL

Generar un mapa geoldgico actualizado a escala 1:50.000 del area
comprendida entre las coordenadas 9°40” a 10°00° latitud Oeste y 72°30 a 73°05°
longitud Norte, a partir de las cartas Rio Sirocuay (Hoja 5545) y El Tocuco (Hoja
5645) pertenecientes a la zona Occidental de la Sierra de Perijad, mediante la
integracion geoldgica de la informacion recopilada de datos bibliograficos y trabajos

previos con los resultados del analisis de imagenes satelitales (Landsat 7 ETM).

1.2.  OBJETIVOS ESPECIFICOS

» Determinar alineaciones y estructuras a través de la interpretacion de las

imagenes satelitales.

» Determinar unidades espectrales a través de las diferentes combinaciones y

cocientes de bandas de las imagenes Landsat 7.

» Realizar la clasificacion supervisada y no supervisada de las caracteristicas

geoldgicas de las imagenes.

» Realizar el Modelo Digital de Elevacion de la zona de estudio.

> Realizar la vectorizacion de la zona de estudio.

» Verificacion de los datos obtenidos en el proceso de interpretacion de las

imagenes satelitales con respecto a la recopilacion Bibliogréfica.

» Generar un mapa geoldgico actualizado a escala 1:50.000 de la zona de estudio en

ArcGis.
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» Realizar el informe final del Trabajo Especial de Grado con los resultados,
analisis, conclusiones y recomendaciones que se obtuvieron a través de las

imagenes satelitales y sus atributos.
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1.3. PLANTEAMIENTO DEL PROBLEMA

Ubicada en la regiéon Occidental de Venezuela, la Sierra de Perija ha sido
estudiada en anteriores oportunidades por diversos autores, cuyos trabajos aiin no han
podido generar una cartografia geologica tan enriquecida como la que existe de otras
regiones del pais. Esta situacion se ha generado por las dificultades que existen para
acceder a la zona, lo que ha hecho cada vez maés dificil la realizacion de estudios

geologicos dentro de la misma.

El area contemplada para desarrollar este Trabajo Especial de Grado se
encuentra dentro de la Sierra de Perija, la cual desde hace afios y hasta la actualidad
es considerada como una zona de dificil acceso, motivado principalmente a dos
factores;. el primero es el clima selvatico reinante en la region, lo que por si solo ha
representado un obstidculo para la penetracion en la zona; y la segunda, es la
presencia de grupos paramilitares y guerrilleros, que junto al desarrollo de otras
actividades delictivas tales como el narcotrafico y los secuestros impiden el acceso a

la region.

Debido a estos factores se hace complicado el desarrollo de estudios
geologicos con el objetivo de actualizar la cartografia geologica de la zona mediante
la aplicacion de la geologia clasica, por lo que se hace necesaria la busqueda de
nuevas herramientas que ayuden a cubrir la carencia de estudios geologicos de campo

en la Sierra de Perija.
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1.4. UBICACION DE LA ZONA DE ESTUDIO

La zona de estudio se encuentra ubicada en la Sierra de Perija, region

Occidental de Venezuela (ver FIGURA N°1.1), y comprende un area aproximada de
2330 Km” ubicada entre las coordenadas 72°30 a 73°05” longitud Oeste y 9°40° a
10°00’ latitud Norte(UTM:710330E-774160E y 1069170N-1106160N)(ver FIGURA

Ne 1.2).
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FIGURA N° 1. 1. Ubicacion de la zona de estudio segun su Situacion Relativa Nacional. La zona de estudio se encuentra
identificada con un recuadro negro. (Tomado y modificado de la Hoja 5545, Rio Sirocuay, Venezuela.)
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FIGURA N° 1. 2. Ubicacion de la zona de estudio seglin su Situacion Relativa Regional. La zona de estudio se encuentra
identificada con el area rayada. (Tomado y modificado de la Hoja 5545, Rio Sirocuay, Venezuela.)
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CAPITULO 1

MARCO TEORICO

En este capitulo se presentan las definiciones basicas relacionadas con la
teoria de sensores remotos, asi como también acerca de los programas a utilizar
(ArcGIS 9.1; ENVI 4.2; ERDAS Imagine 8.6) para la obtencion de los resultados.
Finalmente se presentan las caracteristicas mas resaltantes de la zona de estudio

ubicada en la Sierra de Perija.

2.1. CONCEPTOS BASICOS
2.1.1. Geomatica

En el presente trabajo el término de imagen har4 referencia a la representacion
de la superficie de la tierra obtenida a través de medios Opticos, electro-Opticos,
optico-mecanico o eléctricos registrando en forma digital la radiacion reflejada o
emitida por los objetos en esa superficie; donde también incluye las imagenes

captadas en el visible infrarrojo cercano y medio del espectro electromagnético.

Los datos espaciales estan determinados por la medicion, analisis y manejo de
los datos terrestres, comprendiendo de este modo un método integrado denominado
Geomatica. Estos datos provenientes de satélites que orbitan la tierra, sensores

marinos y aerotransportados, e instrumentos estacionarios de medicion.

2.1.1.1. Areas que integran la Geomética

La teledeteccion o también llamada percepcion remota, es aquella que
comprende la adquisicién y medida de datos de algunas de las propiedades de un

fendmeno, objeto o material a través de un dispositivo que no esta en contacto
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directo con el elemento de interés. Esta técnica se encuentra relacionada con el
conocimiento del objeto por medio de los campos de fuerza, radiacion
electromagnética; a través de camaras, laser, receptores de frecuencia de radio,
sistemas de radar, sonares, dispositivos termales, magnetometros, gravimetros, entre
otros instrumentos. El estudio de la radiacion electromagnética de la tierra se puede
adquirir e interpretar los datos geoespaciales para desarrollar informaciéon sobre los
rasgos, objetos y clases, principalmente de la parte continental de la superficie de la

tierra.

Al interactuar con los objetos es modificada de manera que la energia

resultante incorpora informacion que caracteriza al objeto y su posterior analisis.

La energia electromagnética de baja frecuencia es equivalente a ondas largas,

mientras que la de alta frecuencia corresponde a ondas cortas (ver FIGURA 2.1).

Pequeiia longitud de onda Longitud de onda grande
I :

FIGURA N° 2. 1. La energia electromagnética. (Tomado del Curso introductorio de la Geomatica, Freddy F, 2006)

De acuerdo a la longitud de onda, parte de la radiacion incidente en el objeto

es dispersada en diferentes direcciones, otra es absorbida por la materia, otra
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trasmitida y otra reflejada. Para el posterior andlisis de los objetos en la superficie
terrestre, la energia de interés es la reflejada o reflectancia y la emitida o emitancia en
el caso de mediciones de temperatura. La energia generada por el sol es la fuente de
energia primaria, dicha energia es reflejada por los objetos en la superficie terrestre y
detectada por sensores a bordo de satélites de observacion terrestre; esto debido a la
longitud de onda que percibe el satélite correspondientes a la ventanas atmosféricas;
las cuales son las longitudes de onda que representan la mayor energia solar filtrada a

través de la atmosfera que llega a la tierra denominada transmitancia.

2.1.2. Componentes del sistema de percepcion remota ®

» Fuente de energia: Es la que da origen al flujo energético que es detectado por el

S€nsor.

» Radiacion y atmosfera: Se refiere a la interaccidn que existe entre la radiacion
solar y la atmosfera; dicha interaccion es reciproca. Este fendmeno produce un

efecto de filtro permitiendo el paso de ciertos rangos del espectro.

» Interaccién con el objeto de interés: Los objetos estin conformados por las
diversas coberturas de la tierra: superficie terrestre, atmoésfera y océano; la
interaccion con los mismos se refleja en fendmenos como: reflexion, absorcion,
emision. La reflexion tiene que ver con el retroceso de la energia electromagnética
desde una superficie; el fenomeno de absorcion es causado principalmente por
tres agentes atmosféricos: ozono, didoxido de carbono y vapor de agua. El ozono
absorbe los rayos ultravioleta; el dioxido de carbono absorbe en la atmosfera
inferior en la region de los 13-17.5 micrometros; finalmente el vapor de agua
absorbe en las porciones de 5.5-7 micrometros y por encima de los 27. La emision
se refiere al cociente de la cantidad de la radiacion electromagnética reflejada

desde una superficie sobre la cantidad que originalmente choco con la superficie,
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es decir, es la radiacion absorbida por los materiales que es liberada en forma de

calor.

» Sistema del sensor: Se encarga de captar, grabar y codificar la radiacion que
devuelve el objeto en tierra, sin estar en contacto con ¢él; para luego enviar la

energia grabada al sistema de recepcion en tierra.

» Transmision, recepcion y procesamiento: Los datos recibidos en forma digital son

pre-procesados para la obtencién de una imagen.

» Interpretacion y analisis: Implica a la interpretacion de la imagen pre-procesada

en forma visual o por su posterior procesamiento a través de técnicas digitales.

» Aplicacion: Es la parte final del proceso de la percepcion remota. Al extraer la
informacion tematica de la imagen, se logra entender el comportamiento de los

objetos de interés para la solucion de algin problema en particular.

2.1.3. Algunas aplicaciones de la percepcién remota

Ordenamiento del territorio

Dinamica hidrografica

Mapas geoldgicos y geomorfologicos
Prospeccion minera

Estudios de vegetacion

Manejo forestal

Evaluacion de riesgos y desastres naturales
Estudio de cuerpos de agua

Climatologia/meteorologia

YV V V V V V V V V VY

Cambios climaticos globales
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2.1.4. Ventana atmosférica y reflectancia espectral

Las ventanas atmosféricas son las porciones del espectro electromagnético
que pasan a través de la atmosfera con poca o ninguna atenuacion. Muchos de los
sensores remotos son seleccionados para operar en una o varias ventanas
atmosféricas, haciendo sus mediciones con detectores calibrados para ciertas

frecuencias especificas o longitudes de onda que atraviesan la atmoésfera.

La reflectancia espectral se refiere a la cantidad de radiacion reflejada
(absorbida o transmitida) de acuerdo a la firma espectral que posea el elemento de
interés. Gracias a esta firma espectral que poseen todos los elementos de la
naturaleza, se pueden diferenciar obteniendo una vision del tamafio general y forma
de ellos; es decir, que de acuerdo a las caracteristicas que lo componen, el objeto
refleja con mayor o menor cada uno de los rangos de longitudes de onda. Debido a
esto, en algunas longitudes de onda las areniscas pueden reflejar més luz que la

vegetacion verde.

Cada elemento tiene su respuesta espectral caracteristica; en la siguiente
grafica se puede apreciar que para distintos elementos de la naturaleza existen
diferentes firmas espectrales; en este caso se presentan el agua, la vegetacion y el

suelo.

80

70k AGUA DE RIO TRANSPARENTE
~=-=-=  AGUA DE RIO TURBIA

= VEGETACION

gol —:— SUELOARCILLOSO ENCENAGADO

——= SUELO DE LODO

PORCENTAJE DE REFLECTANCIA

\

—_
L
a

L L
10 12 14 (] 8 20 2.2 24 26
LONGITUD DE ONDA {micrémetros)

GRAFICA N° 1. Firma espectral de diversas caracteristicas naturales de la superficie de la tierra. (Tomado de
http://www.fao.org/DOCREP/003/T0446S/T0446S04.htm.)
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En la siguiente figura (ver FIGURA N° 2.2) se logra apreciar la respuesta
espectral de el granito con una alta reflectividad en gris, la arena con una mayor
absorcioén en marron, la vegetacion con una respuesta que va a depender del tipo y su

contenido de agua; y finalmente la respuesta de mayor absorciéon como lo es la del

agua.
-
-
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FIGURA N° 2. 2. Reflectividad de diferentes elementos. (Tomado y modificado de www.javeriana.edu.co)

La respuesta espectral de la vegetacion varia de acuerdo a su estado; la sana
tiene una reflectividad baja en el visible; en el caso de la vegetaron enferma,

disminuye el infrarrojo y aumenta la reflectividad en el rojo y en el azul.

Con respecto a las propiedades espectrales del suelo son relativamente
simples, debido a que toda la energia se absorbe o refleja, es decir, la transmision es
nula. La reflectividad es relativamente baja para todas las bandas aunque aumentando
en el infrarrojo; en cuanto a la reflectividad hay cierta dependencia con el contenido
de agua del suelo, mientras mayor sea menor sera la reflectividad y los suelos se
veran con tonos mds oscuros. Al aumentar el tamafio medio de las particulas del
suelo, sera mayor la reflectancia (los suelos arenosos tienen mayor reflectividad que

los arcillosos); de acuerdo a esto se tiene que la reflectancia ira disminuyendo de
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acuerdo al tamafo de grano: arena (mayor reflectancia), limo y arcilla (menor

reflectancia).

El contenido de materia orgédnica tiene también cierta influencia en la
reflectividad, mientras mayor sea su contenido y no se encuentre tan descompuesta,
mas oscuro sera el suelo, es decir, menor reflectividad tendra. En cuanto a la
composicion quimica y mineralogica del suelo se puede decir que afectara a la
reflectividad del suelo dependiendo de su contenido, por ejemplo, se incrementara en

rojo si el contenido de oxido de hierro es elevado.

En conclusion, las diferentes cubiertas no presentan un comportamiento Uinico
y permanente que coincida con las curvas de reflectividad espectral y que permitan
reconocerlas sin confusion frente a otras superficies. Cada cubierta presenta una
variabilidad determinada por varios factores, entre ellos: angulo de iluminacion,
relieve, influencias atmosféricas, angulo de observacion, asi como también por sus
caracteristicas particulares de acuerdo al tipo de vegetacion o suelo se refiera; las

cuales dificultan en algunos casos su discriminacion.

2.1.5. Ventajas de la observacion espacial ®

» Cobertura global y periodica de la superficie terrestre.

Y

Cobertura de lugares inaccesibles.

» Vision panoramica (debido a la altura) que permite observar pliegues, fallas,
geoformas y capas de hielo.

» Amplia cobertura de superficie.

» Homogeneidad en la toma de datos; sin desigualdad en los tonos, brillos o
colores.

» Informacién de los objetos en regiones no visibles del espectro.

» Estructura digital que permite rapido acceso a los datos.
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2.1.6. Inconvenientes de la observacion espacial ®

Calibracion.

Cobertura nubosa.
Frecuencia de adquisicion.
Resolucion espacial.

Resolucion espectral.

VvV V.V V V VY

Vision estereoscopica.

2.2. IMAGENES LANDSAT 7

El satélite Landsat 7, lanzado en 1999, usa el sensor Enhanced Thematic
Mapper Plus (ETM+) para observar la tierra. El Landsat 7 incluye las siguientes

capacidades:

- Una banda pancromatica con 15 metros de resolucion espacial.
- Una calibracion radiométrica del 5% con apertura completa.

- Un canal infrarrojo térmico IR con resolucion espacial de 60 metros.

La estacion receptora principal de datos de Landsat 7 esta localizada en Sioux
Falls, Dakota del sur, en el Centro de Datos EROS (EDC) del Servicio Geologico de
los Estados Unidos (USGS). Los datos ETM+ son transmitidos usando la banda X, a
una rata de 150 Mbps. Landsat 7 es capaz de capturar escenas sin obstruccion de
nubes y las estaciones receptoras pueden obtener estos datos en tiempo real usando la
banda X. Sin embargo, las estaciones, localizadas alrededor del planeta, son
unicamente capaces de recibir datos para la porcion de la trayectoria terrestre ETM+,

en la cual el satélite puede ser visto por la estacion receptora.
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2.3. CONCEPTOS DE SISTEMA DE INFORMACION GEOGRAFICA
(SIG)®

Un SIG (en ingles GIS) es un sistema de informacion especializado en el
manejo y andlisis de informacion geografica (geoespacial); donde la informacion

geografia es la abstraccion o representacion de la realidad geografica.

El inicio de los SIG se remonta a comienzos de la humanidad. Los mapas mas
antiguos se conocieron 2500 a.C., pero probablemente haya sido de tiempos
anteriores. Desde entonces, el hombre ha continuado mejorando los métodos de

representacion de la informacion espacial.

El primer sistema SIG fue el sistema de informacioén geografica canadiense,
desarrollado en 1962 por Roger Tomlinson para el inventario de tierra del Canada.
Diferentes sistemas empezaron a ser desarrollados para aplicaciones especificas. En
este caso, se diseflo un sistema para almacenar mapas digitalizados y atributos
correspondientes al terreno canadiense en un formato de facil acceso. Este sistema

aun se encuentra en operacion (Parent y Church 1987).

La era moderna de los SIG empieza en los afios 70, cuando los analistas
comienzan a programar computadoras para automatizar algunos procesos manuales.
Algunas compaiiias de software como ESRI y ERDAS desarrollaron paquetes que
permitian la entrada, despliegue y manipulacion de datos geograficos para crear

nuevas capas de informacion.

Actualmente un sistema de informacion geografica o (SIG) es un sistema
unico disefiado para entrar, almacenar, recuperar, manipular y analizar capas de datos
geograficos para producir informacion interpretable. Un SIG también deberia ser
capaz de crear reportes y mapas (Marble 1990). La base de datos de un SIG incluye

imagenes de computador, mapas impresos, datos estadisticos y otros tipos de datos
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necesarios en un estudio. La tecnologia SIG puede usarse en casi cualquier disciplina
relacionada con la geografia, desde arquitectura paisajistica hasta el manejo de

recursos naturales o el disefio de rutas de transporte.

El proposito principal de un SIG es convertir datos geograficos en
informacion util; entre ellos tenemos: monitorear la influencia de los cambios
climaticos globales sobre los recursos de la tierra, redefinir las divisiones politicas en
un area metropolitana que crece rapidamente, ubicacion de grandes infraestructuras
que causen el menor impacto ambiental y que sean lo suficientemente estables (riesgo

geologico).

La tipica implementacion de un SIG incluye dos pasos: entrada de datos y su
posterior andlisis. En la entrada se reunen dentro de una base de datos las capas de
datos necesarias. En la fase de andlisis, estas capas son combinadas y manipuladas en

cierto orden para crear nuevas capas para luego extraer informacion ttil de ellas.

2.3.1. Temas y capas

Una base de datos usualmente contiene archivos con datos de la misma area
geografica, donde cada archivo contiene diferentes tipos de informacion. Cada uno de
estos archivos contiene diferente informacion, cada uno es un tema diferente. El
concepto de temas ha evolucionado desde los comienzos de los SIG, en los que se
crearon transparencias para cada tema y por superposiciones fueron combinadas de

diferentes maneras para derivar nueva informacion.

Un tema sencillo puede requerir mds que un simple archivo raster o vector
para describirlo completamente. En cambio para la imagen, hay atributos que
describen la informacion, un esquema de colores o una leyenda significativa para la
imagen. De este modo, una capa es una coleccion completa de datos que describe

cierto tema.
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Dependiendo de las metas propuestas de un proyecto, tal vez sea 1til combinar
varios temas dentro de una capa. Muchos de los analisis de los SIG se relacionan con
la combinacion individual de temas dentro de una o mas capas que responden las

preguntas manejadas en el analisis.

2.3.2. Capas continuas

Las capas raster continuas son cuantitativas (miden una caracteristica) y estan
relacionadas con valores continuos. Las capas raster continuas pueden ser multibanda

(Landsat TM) o de una sola banda (SPOT pancromatica).

Las imagenes de satélite, fotografias aéreas, datos de elevacion, mapas
escaneados y otros datos de capas continuas, pueden incorporarse a una base de datos
y proveer informacion que no esté disponible en capas tematicas o capas vector. En
efecto, estas capas forman el cimiento de la base de datos. Pueden crearse mapas base
precisos a partir de imagenes de satélite o fotografias aéreas rectificadas. Luego,
todas las otras capas que sean adicionadas a la base de datos pueden registrarse con

este mapa base.

Aunque alguna vez se usaron Unicamente para procesamiento de imagenes,
los datos continuos se estan incorporando a base de datos SIG y se usan en
combinacion con datos tematicos que inciden en el procesamiento e algoritmos;
también se usan como imagen de fondo en la presentacion de los resultados el
analisis. Actualmente los datos de satélite y fotografias aéreas son efectivos en la
actualizacion de datos vectoriales obsoletos. Los vectores pueden suponerse sobre un
fondo raster para actualizar dindmicamente elementos nuevos o que han cambiado,

tales como caminos, redes de servicios publicos o usos de tierra.
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2.3.3. Capas Tematicas ©

Los datos tematicos estan representados como capas sencillas de informacién
y se almacenan como archivos (.img) que contienen clases discretas. Las clases son

simplemente categorias de pixeles que representan la misma condicion.

Algunas veces a una capa tematica se le llama variable, porque representa una
de las muchas caracteristicas acerca del area de estudio. Las capas tematicas tienen
generalmente solo una banda, usualmente desplegada en modo de pseudo-color,
donde los colores particulares asignados sirven para ayudar a visualizar la

informacion.

2.4. ENTRADA DE DATOS @

Entrada de datos: Un SIG debe de tener la capacidad de recibir datos de

distintas maneras:

» Digitalizacion directa: Se refiere a los mapas en papel o mdas recientemente
mediante el método “heads up digitizing”, en ¢l cual se utiliza una foto aérea o
una reproduccidn escaneada de un plano y digitaliza los elementos que desee

en ese plano o foto.

» Entrada de coordenadas en archivos digitales: Se aplica en casos diversos
donde existen tablas que tienen coordenadas, tanto manuales o las que se

reciben directamente de aparatos GPS.

» Teledeteccion: Usualmente es complementaria con los SIG porque los
productos de un procesador de iméagenes suelen ser otras capas de informacion

que pueden ser utilizadas por los SIG.
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El Output es la representacion grafica y cartografica en digital, el cual aporta
las herramientas para hacer mapas y reproducir graficas. Para la manipulacion de
estos datos se deben de manejar herramientas como lo son las funciones para la
transformacion  matemdatica de coordenadas, proyecciones cartograficas,
transformaciones geométricas (rotacion, reduccion o ampliacion de escalas),
reformateo (integracion, generalizacion y depuracion), y por ultimo la importacion y

exportacion de datos.

2.5. FUNCIONES DE UNSIG @

El analisis es el componente mas importante dentro de un SIG; debido a que
se trata de utilizar la informacion disponible para producir nueva informacion. Las

funciones analiticas que debe poseer un SIG son:

» Seleccion geografica: Se basa en la busqueda compleja o simple tanto en el

aspecto geografico como en la base de datos.

» Proximidad: Determina la cercania de los objetos en base a distancias.

» Sobreimposicion cartografica (overlay & map algebra): Involucra a funciones
importantes y combina a las anteriores; ademas afade otras funciones tales
como: la reclasificacion y las funciones por celda (grupos de celda con un

mismo valor dentro de un layer).

» Rutas oOptimas: trata de la seleccion de rutas con la menor distancia o
resistencia posible. Puede darse en medios tales como una red de carreteras,

drenajes, tuberias, etc.
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2.5.1. Tipo de codificacién de los datos geograficos

La manera en que se guarda la informacion que representa los datos

geograficos en un SIG tiene dos vertientes:

» Representacion vectorial: Utiliza los elementos (primitives) llamados punto,

linea y poligono para representar la geografia.

» Representacion raster: Se basa en la unidad fundamental llamada celda o

pixel, los cuales definen toda una capa de informacion.

2.5.2. Utilidad de los SIG @

X/

%+ Inventarios de recursos:

= (Catastros

= Recursos naturales

» Infraestructuras: electricidad, agua, etc.

= Arqueolégicos

¢ Planificacion y urbanizacion:

Sirve para delimitar areas reglamentarias en base de criterios cientificos.
% Geomercadeo:
Herramienta para investigaciones de mercados segun la geografia censal y
los datos estadisticos de encuestas, etc.

X/

« Seguridad publica.

¢ Manejo de distribucion de fondos:

Programas sociales, educacion y fondos de emergencias por desastres.
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2.6. SOFTWARE ENVIROMENT FOR VISUALIZING IMAGES (ENVI)©)

ENVI es un software de procesamiento de imagenes satelitales con excelentes
algoritmos, que de manera ficil y completa permite hacer teledeteccion desde
plataformas Windows, Unix y Mac. Por su disefio tan abierto, este software hace facil
trabajar con datos Landsat, SPOT, RADARSAT, NASA, NOAA, etc. El ENVI anade a
su capacidad para el procesamiento general de imagen, herramientas de teledeteccion
clasicas, a las cuales se le suman otras mas avanzadas como las incorporadas para el

tratamiento RADAR o el hiperespectral, donde es el lider indiscutible del mercado.

Ademés de lo mencionado anteriormente, se afiade el hecho de que este
software se encuentra totalmente desarrollado en IDL, con lo que la capacidad de
implementacion y personalizacion hace de €l una herramienta inmejorable ya que la
potencia de IDL se incorpora de forma comoda a ENVI sin crear conflictos. Por todas
esas caracteristicas de facil manejo, es que ENVI fue seleccionado para ser utilizado

en la fase de procesamiento de la imagen satelital de este trabajo especial de grado.

2.6.1 Conceptos Bésicos

Para la utilizacion del software ENVI es necesario manejar los siguientes dos

conceptos:

2.6.1.1 Correccion Radiométrica™?

En el procesamiento de imagenes satelitales se requiere restaurar la imagen
de tal forma que se pueda obtener una representacion lo mas fiel posible de la
superficie de la tierra. Las imagenes de sensores remotos son tomadas
frecuentemente a una gran distancia de la superficie terrestre, en donde la energia

electromagnética requiere atravesar la atmosfera antes de llegar al sensor.
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Dependiendo de la longitud de onda y de las condiciones atmosféricas, la energia que

llega al sensor se ve sustancialmente modificada.

2.6.1.2 Calibracion de la Radiancia "

Los valores de los pixeles en imagenes satelitales representan la radiancia de
la superficie en forma de ntimeros digitales (DN), los cuales son calibrados para
ajustarlos en un cierto rango de valores. La conversion de DN a una radiancia
absoluta es un procedimiento necesario para comparar imdgenes tomadas por
diferentes sensores. Cada sensor tiene sus parametros de calibraciéon usados para
grabar los valores DN. El mismo valor DN de dos iméagenes tomadas por diferentes
sensores puede representar dos valores de radiancia diferente. Usualmente los
detectores son calibrados para que haya una relacion lineal entre el DN y la radiancia
espectral. Esta funcion lineal es descrita por tres parametros: el rango del valor del
DN en la imagen, la minima (Lmin) y la maxima (Lmax) radiancia medida por un
detector sobre la banda espectral del canal. Lmin es la minima radiancia espectral
correspondiente al valor DN minimo (usualmente cero). Lmax es la radiancia
correspondiente al maximo DN (usualmente 255). No solamente cada sensor, sino
cada banda dentro del mismo sensor tienen su propio Lmax y Lmin. La informacién
acerca de los pardmetros de calibracion del sensor (Lmin y Lmax) es usualmente

suplida con la imagen.

2.6.2 Pre-procesamientos ejecutables en ENVI

Como se menciona anteriormente, ENVI, es un software de facil manejo, que
por sus caracteristicas permite la ejecucion rapida y efectiva de procesos que resultan
imprescindibles para el analisis de imagenes satelitales, siendo este el motivo por el
cual fue seleccionado para ser utilizado en la realizacion del procesamiento de la

imagen satelital en este trabajo especial de grado. A continuacion, dichos procesos se
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explicaran de manera teorica y en el siguiente capitulo se describird la metodologia

que se siguid durante la ejecucion de todos ellos.

2.6.2.1 Calibracion de laimagen ETM

La calibracion de la imagen satelital, constituye uno de los pre-
procesamientos de la imagen y se fundamenta en el hecho de que las imagenes
capturadas por sensores remotos vienen procesadas como numeros digitales, los
cuales son necesarios transformar a unidades espectrales para su posterior utilizacion.
Para la realizacion de esta calibracion es necesario contar con las 8 bandas que
constituyen la imagen satelital, junto con la respectiva metadata de la imagen, en la
cual se encuentra la informacion basica de la misma. Cabe destacar que la metadata
se puede obtener via internet a través del comando get calibration parameters from

web.

2.6.2.2 Layer Stacking "

El Layer Stacking, es un proceso que se realiza luego de transformar los DN
de las bandas en radiancia y consiste en unir dichas bandas radiancia en una sola
imagen, siguiendo el orden creciente de las bandas, aspecto a tomar en cuenta, ya que

es de suma importancia seguir la secuencia original de las bandas.

2.6.2.3 Conversion a formato BIL ¢V

Al compilarse las bandas, su formato de salida se encuentra en BSQ (formato
secuencial de banda), sin embargo se requiere de su conversion al formato BIL
(formatos de bandas intercalados por linea), debido a que es el formato de archivo
recomendado para la mayor parte de las tareas del procesamiento (espacial y

espectral) de ENVI.
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2.6.2.4 Correccion Atmosférica (FLAASH) ¢

Debido a que los componentes de la atmosfera producen un efecto de
absorcion y dispersion, que modifica la sefial procedente de la superficie terrestre, se
necesita calcular la reflectividad del terreno estimando la transmisividad de la
atmosfera (la descendente y la ascendente), la irradiancia difusa y la radiancia
atmosférica debida a la dispersion. Los procedimientos para abordar estas
correcciones requieren contar con datos sobre las condiciones de la atmosfera en el
momento de la toma de la imagen. La correccion atmosférica en el ENVI se realiza a
través de la funcion FLAASH (Fast Line-of-sight Atmospheric Analisis of Spectral
Hypercubes), la cual estd basada en el modelo de transferencia radiactiva
MODTREAN4 (Moderate Resolution Transmitance 4). Los objetivos primordiales
del FLAASH es eliminar la radiancia recibida por el sensor asi como los efectos de
absorcion y dispersion de la energia electromagnética causada por las moléculas y
particulas atmosféricas en suspension; para luego, convertir esa radiancia en valores
de reflectividad de la superficie. EI MODTRAN4, requiere algunos pardmetros de
entrada, tales como: angulo solar, &ngulo de observacion, elevacion promedio de la
superficie, modelo atmosférico estandar, tipo de aerosol y rango de visibilidad
horizontal. En si, FLAASH corrige el vapor de agua, oxigeno, dioxido de carbono,

metano y ozono en la atmosfera, asi como la dispersion molecular y aerosoles.

El software ENVI cuenta con uno de los modulos (FLAASH) mas utilizados

para la correccion atmosférica de imagenes.

2.6.3 Procesamiento Hiperespectral para el Analisis de Datos Multiespectrales

El procesamiento hiperespectral consiste en un conjunto de procesos que se

aplican en la imagen satelital una vez esta haya sido corregida atmosféricamente.
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2.6.3.1 Maéscara de Nubosidad

Previo a la aplicacion de las herramientas de procesamiento hiperespectral y
para obtener mejores resultados, se procede a eliminar las 4reas que representan
nubosidad y las sombras asociadas a estas, debido a que no es de interés geoldgico y
ademas afectan al calculo estadistico del procesamiento en la evaluacion de la pureza
de los pixeles. Para ello se genera un archivo Shapefile (.shp) con el contorno de las
nubes y sus sombras en el programa ArcGis, y luego se convierte el archivo a ROI

(.evf) en ENVI 4.2.

2.6.3.2 Transformacion de la Fracciéon Minima del Ruido (MNF) 2

La aplicacion de esta herramienta tiene como finalidad minimizar el ruido en
la data espectral, determinar la dimensionalidad espectral de los datos y reducir los

requerimientos computacionales.

Este procedimiento incluye la disminucion del autovalor con el incremento de

las bandas MNF, siendo el ruido mayor hacia las bandas MNF mayores.

2.6.3.3 Indice de Pureza del Pixel (PPI) *?

Este procedimiento es utilizado para encontrar espectralmente los pixeles
puros o los pixeles extremos en los datos multiespectrales o hiperespectrales
(normalmente no alcanzan el 1%). La finalidad de encontrar estos pixeles puros es
poder trabajar con la mayor cantidad de pixeles verdaderos y eliminar aquellos que no
aportan informacién que se esta analizando. La imagen PPI representa los niimeros
digitales de cada pixel que se corresponde con el nimero de veces que fue registrado
como extremo. Los pixeles mas brillantes en la imagen muestran la localizacion

espacial de los pixeles puros.
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El estatus de procesamiento muestra el total de nimero de pixeles extremos
que satisface el criterio de tolerancia del PPl como una funcion del nimero de

interacciones.

La Grafica N° 2 muestra una linea plana asintdtica (pendiente cero) cuando

los pixeles extremo son encontrados.

|| File Edit Options Plot_Function Help

Fixel Purity Inde ot

GRAFICA N° 2. Grafico que hace referencia al indice de Pureza de Pixeles.

2.6.3.4 Visualizador N-Dimensional

Este procedimiento se utiliza para extraer el espectro del edmenber, usando el
espacio de mezcla espectral. La distribucion de los puntos permite estimar el namero
de edmenber puros espectrales, asi como sus firmas espectrales. Los pixeles puros se

encuentran en los vértices de la figura geométrica.

2.6.3.5 Spectral Angle Mapper (SAM)

El SAM es el angulo de medida entre el espectro y el espectro de referencia.
El algoritmo calcula la similaridad entre dos espectros mediante el calculo del angulo
espectral entre ellos. Dicho angulo es visto a través de vectores en el espacio
espectral con una dimensionalidad igual al nimero de bandas; y determina la

separacion angular de un pixel con respecto al espectro de referencia. La clase es
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asignada si el angulo es inferior a un valor predefinido. Mientras mas pequefio sea el

angulo, mejor correspondencia al espectro de referencia tendra.

2.6.3.6 Modelo Digital de Elevacion (en inglés DEM) “”

El Modelo Digital de Elevacion (MDE) es una estructura numérica de datos
que representa la distribucion espacial de la elevacion de la superficie del terreno,
siendo su unidad bésica de informacion un valor de elevacion Z, al que acompafian
los valores correspondientes de X e Y (ver GRAFICA N° 3), que expresados en un
sistema de proyeccion geografica permiten una precisa referenciacion espacial y una

perspectiva tridimensional de la imagen (ver FIGURA 2.3).

¥ N

GRAFICA N° 3. Unidad bésica del MDE “Z” que acompaiia los valores “X” ¢ “Y”. (Tomado de www.ciat.cgiar.org)

FIGURA N° 2. 3. Dos ejemplos de MDE. A la izquierda muestra un 3D Pseudo Color 10 m DEM Pensilvana E.E.U.U; a
la derecha 3D Mapa Topografico 10 m DEM Pensilvana E.E.U.U. (Tomado de www.satimagingcorp.es)

29 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO II
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) MARCO TEORICO

UNIVERSIDAD CENTRAL DE VENEZUELA

2.7 SOFTWARE ERDAS IMAGINE

El software ERDAS Imagine incorpora las funciones de procesamiento de
imagenes y de SIG, que por sus caracteristicas y facil manejo en ciertas aplicaciones
fue seleccionado para ser utilizado en este trabajo. Estas funciones incluyen

importacion, visualizacion, trasformacion y analisis de datos raster y vectoriales.

2.7.1 Fundamentos de ERDAS Imagine

A continuacién se presentan un grupo de conceptos y fundamentos del

software ERDAS Imagine:

2.7.1.1 Datos de la imagen *®

Una imagen es la representacion o grafico digital de un objeto. Los datos de
una imagen obtenida mediante la percepcién remota son una representacion de la
superficie de la tierra; ellos son almacenados en archivos de datos llamados archivos
de imagen, en cintas magnéticas, discos de computador u otros medios; los datos

consisten inicamente de nimeros.

Cada nimero en un archivo de imagen es un nivel digital, los cuales son
llamados valores de pixel. EI termino pixel es la abreviacion de Picture element
(elemento grafico), es la parte mas pequefia de un grafico (el area que se ha barrido)
que tiene un valor unico. El nivel digital es el valor de brillo el pixel en una longitud

de onda especifica.

La celda de grilla (gris cell) esta representada por un pixel en una cuadricula
donde se encuentran los datos raster. En los datos de imagenes obtenidas
remotamente, cada pixel representa un area de la superficie terrestre en una locacion

especifica. El nivel digital asignado a ese pixel es el registro de la radiacion reflejada
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o de la emision de calor de la superficie terrestre en esa posicion. Los términos pixel

y nivel digital no son intercambiables en ERDAS Imagine.

2.7.1.2 Bandas®?

Los datos de una imagen pueden incluir varias bandas de informacion. Cada
banda es un conjunto de niveles digitales para una porcion especifica del espectro
electromagnético de luz reflejada o de emision de calor o alguna otra informacién
definida por el usuario y creada por combinacion o realce de las bandas originales. El
programa ERDAS Imagine puede manejar un ntimero ilimitado de bandas de datos de

la imagen en un solo archivo.

En ERDAS Imagine las bandas de los datos son ocasionalmente referidas
como capas. Al importar una banda a un SIG, se vuelve una capa de informacion que
puede procesarse de varias maneras. Asi como también, pueden crearse capas
adicionales y agregarse al archivo de la imagen (extension .img) en ERDAS Imagine,

tales como las capas creadas a través de las capas existentes.

El Viewer (visor) permite mostrar varias imagenes; en este caso cada imagen

(incluso una imagen multibanda) puede ser una capa.

2.7.1.3 Percepcion Remota

Normalmente los datos de percepcion remota se refieren a los datos de la
tierra recolectados por sensores que estdn a bordo de satélites o aviones. La mayoria
de las imagenes usadas en el sistema ERDAS Imagine son obtenidas mediante

percepcion remota.
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2.7.1.4 Resolucion ??

Es un término que se utiliza para describir el nimero de pixeles que hay en un
dispositivo de despliegue, asi como también el area en la tierra que representa en un

archivo de la imagen.

Se consideran cuatro tipos de diferente resolucion que son adecuadas para

describir datos de sensores remotos:

» Resolucion Espectral: Los intervalos de longitud de ondas especifica que un

sensor puede grabar.

» Resolucion Espacial: El area de la tierra representada por cada pixel.

» Resolucion Radiomeétrica: El nimero posible de niveles digitales en cada
banda.

» Resolucion Temporal: La frecuencia en que un sensor obtiene imagenes de un

area en particular.

2.7.1.5 Entrada de datos *?

La adquisicion de los datos apropiados para un proyecto supone crear una
base de datos de capas que abarquen el area de estudio. Una base de datos creada con

ERDAS Imagine puede estar constituida por:

» Capas continuas: imagenes de satélite, fotografia aéreas, datos de elevacion,
etc.

» Capas tematicas: uso de tierras, vegetacion, hidrologia, suelos, pendientes, etc.
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» Capas de vector: vias, redes de comunicacion y servicios publicos, parcelas,
etc.
» Estadisticas: frecuencia de una ocurrencia, demografia, etc.

» Datos de atributos: caracteristicas de las carreteras, tierras, imagenes, etc.

El paquete de software ERDAS Imagine emplea una arquitectura orientada a
objetos, que utiliza imagenes raster y datos topoldgicos vector. Las imagenes raster
son almacenadas en archivos .img y las capas vector son coberturas basadas en los
modelos de datos ARC/INFO. La perfecta integraciéon de estos dos tipos de datos

permite al usuario aprovechar los beneficios de ambos formatos en un solo sistema.
En las siguientes aplicaciones podrian ser mas apropiados los datos raster:

Seleccion de sitios
Manejo de recursos naturales

>
>
» Exploracion de petroleo
» Planeacion de misiones
>

Deteccion de cambios
De otra parte, los datos vector pueden ser ttiles en estas aplicaciones:

» Planeacion urbana
» Valoracion de impuestos y planificacion
» Ingenieria de trafico

> Gestidn de instalaciones

La ventaja de sistema vector y raster integrado tal como ERDAS Imagine es
que una estructura de datos no sobresale sobre la otra. Ambos formatos de datos

pueden ser usados y las funciones de ambos tipos de sistemas pueden ser utilizadas.
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Dependiendo del proyecto, pueden ser necesarios solo dato vector o raster, pero se

obtienen mas beneficios de las aplicaciones si se usan ambos.

2.7.1.6 Datos Geocodificados ?*

También conocida como georeferenciacion es el registro o codificacion
geografica de los pixeles de una imagen. Los datos geocodificados son imagenes que
han sido rectificadas a una proyeccidon cartografica y a un tamafo de pixeles

particulares.

Los datos de imagenes de percepcion remota son adquiridos por un sensor a
bordo de una plataforma, tal como un aviéon o un satélite. En su forma original, los
datos no estan referenciados en un mapa. La rectificacion es el proceso de proyectar
los datos en un plano y hacerlos conformes con un sistema de proyeccion. Las
imagenes originales se pueden geocodoficar con las herramientas de rectificacion de
ERDAS Imagine.

a. Georeferenciacion ??

Es el proceso de enlazar el espacio raster de una imagen a un modelo espacial
(por ejemplo sistema cartografico). El espacio raster define como se colocan las
lineas de cuadricula del sistema de coordenadas en relacion con el centro de los
pixeles de la imagen. En ERDAS IMAGINE, las lineas de cuadricula del sistema de
coordenadas siempre interceptan en el centro de un pixel. GeoTIFF permite que el
espacio raster se defina teniendo las lineas de cuadricula interceptando en el centro
de los pixeles (pixel Is Point) o teniendo las lineas de cuadricula interceptando en la
esquina superior izquierda de los pixeles (pixel Is Area). ERDAS IMAGINE convierte
los valores de georeferenciacion para imagenes Pixel Is Area de manera que se
ajusten a su definicion del espacio raster. GeoTIFF permite la georeferenciacion a

través de una escala y un desplazamiento, de una trasformacion afin completa o de un
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conjunto de puntos de enlace. ERDAS IMAGINE actualmente ignora la

georeferenciacion de la forma de multiples puntos de enlace.

b. Geocodificacion “?

Es el proceso de enlazar coordenadas en el modelo espacial a la superficie de
la tierra. ERDAS Imagine puede interpretar la geocodificacion GeoTIFF de tal
manera que se pueda interpretar la latitud y longitud de las coordenadas cartograficas
de las imagenes GeoTIFF. Esta interpretacion también permite que la imagen

GeoTIFF sea reproyectada.

En GeoTIFF, las unidades de las coordenadas cartograficas se obtienen a
partir de la geocodificacion, no de la georeferenciacion. Adicionalmente, GeoTIFF
define un conjunto de sistemas estandar de coordenadas proyectadas. El uso de un
sistema estandar de coordenadas proyectadas en GeoTIFF restringe las unidades que
se pueden usar con ese sistema estandar. Por consiguiente, si las unidades usadas con
una proyeccion en ERDAS IMAGINE no son iguales a las unidades de una
geocodificacion GeoTIFF equivalente, ERDAS IMAGINE transforma la
georeferenciacion para ajustarla a las unidades implicadas de tal manera que se pueda
usar el codigo del sistema estandar de coordenadas proyectadas. La alternativa de
preservar la georeferenciacion como tal y producir un sistema de coordenadas

proyectadas no estandar se considera poco viable.

2.7.1.7 Uso de datos de imagenes en un SIG

ERDAS Imagine provee muchas herramientas disenadas para extraer la
informacion necesaria de las imagenes a una base de datos; hay opciones disponibles
para obtener archivos de imagenes adicionales de las que son adquiridas (en nuestro
caso ENVI); las cuales involucran la combinacion de archivos, elaboracién de

mosaicos y cortes.
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Los programas de ERDAS IMAGINE procesan datos de imagenes con un
numero ilimitado de bandas, pero los tipos mas comunes son Landsat y SPOT; tienen

siete 0 menos bandas.

Para poder combinar dos o mas archivos de imagenes, cada archivo debe de

estar georeferenciado en el mismo sistema de coordenadas, o registrados uno a otro.

2.7.1.8 Subconjuntos (Subset) *?

Se refiere al fraccionamiento de un archivo grande en uno o mas archivos
pequetios. Muchas veces, los archivos de imagenes contienen ares mas extensas que
el area bajo estudio. En estos casos es util reducir el tamafo el archivo de la imagen
incluyendo solamente el area de interés (AOIl); eliminando de esta forma los datos
extraios en el archivo y agiliza el procesamiento debido a la cantidad pequefia de

datos a procesar. Esto es importante cuando se trabaja con datos multibanda.

La opcion Import del ERDAS Imagine permite definir un subconjunto de una
imagen para visualizar o importar; también se puede usar la opcion Imagine

Interpreter/Subset para definir un subconjunto.
2.7.1.9 Mosaicos

El estudio del area puede cubrir varios archivos de imagenes; en este caso, es
necesario combinar las imagenes para crear un archivo mas grande; elaborando de
este modo Mosaicos.

2.7.1.10 Clasificacion Multiespectral **

La clasificacion multiespectral es el proceso de ordenar los pixeles en un

numero finito de clases individuales o categorias de datos, basados en sus niveles

36 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO II
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) MARCO TEORICO

UNIVERSIDAD CENTRAL DE VENEZUELA

digitales, para asi crear archivos temdticos. Esto se realiza usando el reconocimiento
de patrones espectrales para identificar grupos de pixeles que representan la
caracteristica de escena, si un pixel satisface cierto conjunto de criterios, el pixel es
asignado a la clase que corresponde a ese criterio. Este proceso se conoce también

con segmentacion de la imagen.

Dependiendo del tipo de informacidon que se requiera de los datos originales,
las clases pueden asociarse con elementos conocidos del terreno o pueden

simplemente representar areas que se ven diferentes en el computador.

2.7.1.11 Edicion de datos Raster ??

ERDAS Imagine provee herramientas para editar los niveles digitales de los
datos raster tematicos y continuos. Ellas constituyen un mecanismo para corregir los
niveles digitales errdneos, ruidos, picos y huecos en la imagen. Las funciones de
edicion raster pueden aplicarse a la imagen completa o a un area de interés (AOI)

seleccionada.

Con la edicion de datos raster, los niveles digitales de una capa tematica
pueden ser grabados de acuerdo la clase. La recodificacion es una funcion que

reasigna niveles digitales a una region o a una clase entera de pixeles.

Importacion significa que los datos son convertidos del formato original a otro
formato (por ejemplo: Img, TIFF, o Grid Stack), el cual puede ser leido directamente

por el ERDAS Imagine.

La funcion Import convierte los datos raster al formato de archivo de ERDAS

Imagine (.img) o a otros formatos que puede escribir directamente ERDAS Imagine.
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2.7.1.12 Colores ??

La percepcion humana del color proviene de las cantidades relativas de luz
roja, verde y azul que son medidas por los conos (sensores) del ojo. La luz verde,
roja y azul se retinen para producir una gran variedad de colores, por lo tanto son

colores aditivos primarios.

Al combinarse dichos colores, pueden producirse un niimero casi infinito de
tonalidades. En un despliegue, diferentes colores (combinaciones de rojo, verde y

azul) le permiten percibir cambios a través de una imagen.

2.7.1.13 Cafiones de color ??

En un despliegue, los haces de electrones de los cafiones de color caen sobre
fosforo rojo, verde y azul; los cuales aparecen como pequefios puntos coloreados. El
0jo humano integra estos puntos y percibe las combinaciones de rojo, verde y azul.

Cada pixel esta representado por el mismo numero de fosforo rojo, verde y azul.

2.7.1.14 Despliegue de capas Raster *?

Los archivos de imagen (.img) son archivos raster en el formato de ERDAS

Imagine. Existen dos tipos de capas raster: tematicas y continuas.

a. Despliegue de capas Raster Contintas *?

Un archivo de imagen (.img) puede tener varias capas continuas; por lo tanto,
cada pixel puede tener multiples niveles digitales. Cuando se despliega un archivo de
imagen con capas raster continuas, es posible asignar cuales capas (bandas) seran
desplegadas con cada uno de los tres cafiones de color. Los niveles digitales en cada

capa son la entrada para la asignacion de cada candn de color. Las asignaciones de
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color mas utiles son aquellas que permiten en la imagen desplegada una facil
interpretacion; por ejemplo: una imagen en color natural tiene aproximadamente los
mismos colores que apreciaria en la escena el 0ojo humano; en cambio, una imagen en

color —infrarrojo muestra la escena como apareceria en una pelicula color infrarrojo.

Las asignaciones de las bandas son expresadas cominmente en el orden R, G,
B (siglas de rojo, verde y azul en ingles). Por ejemplo: la asignacion 4,2,1 significa
que la banda 4 esta asignada al rojo, la 2 al verde y la 1 al azul. Algunas asignaciones

de bandas a los cafiones de color (Faust, 1989) son:

» Lansat TM- color natural 3,2,1: Este es color natural porque la banda 3 es
roja y es asignada al caidn rojo, la banda 2 es verde y es asignada al cafion

verde, asi como también, la banda 1 es azul y es asignada al cafion azul.

» Lansat TM- color infrarrojo 4,3,2: Esta es infrarroja debido a que la banda 4

es infrarroja.

b. Despliegue de capas Raster Tematicas **

Generalmente una capa Raster temadtica contiene pixeles que han sido
clasificados o asignados a distintas categorias. Cada nivel digital es un valor de clase,
que es simplemente un numero para cada categoria en particular. Una capa Raster
tematica se guarda en un archivo imagen (.img). Solo un nivel digital (el valor de la
clase) es almacenado para cada pixel. Puesto a que estos valores de clase no
necesariamente estan relacionados, las gradaciones posibles en el modo de color
verdadero usualmente no son ttiles en pseudo color. El sistema de clases da a la capa

tematica una vision discreta, en la que cada clase tiene su color.
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Cuando es desplegada una capa Raster tematica, ERDAS Imagine crea
automaticamente una tabla de color; en la cual, se guardan los valores de los brillos

rojo, verde y azul para cada clase.

2.7.1.15 Uso de visor (Viewer) ¢?

El visor de ERDAS Imagine es una ventana para desplegar capas Raster,
vector y de anotacion. Se pueden abrir tantas ventanas Visor como soporte el
manejador de ventanas. Entre mas visores se encuentren abiertos, mas memoria RAM

se necesitara.

No solamente hace visibles imdgenes digitales rapidamente, sino que también
puede ser usado como una herramienta para el procesamiento de iméagenes y el

modelamiento en SIG.

2.7.1.16 Enlace de visores ¥

Es apropiado enlazar visores cuando los dos cubren la misma area geografica
(al menos parcialmente) y estdn referenciados a las mismas unidades de mapa.

Cuando se alzan dos visores ocurre:

» El mismo punto geografico es desplegado en los centros de ambos visores o
una caja muestra donde una vista ajusta dentro de otra.

Moverse a través de un visor afecta al otro.

Se puede manejar el factor de zoom de un visor desde otro.

Cualquier consulta con el cursor en un visor aparece en el otro.

YV V VYV V

El auto-zoom esté disponible, si los visores tiene el mismo factor de zoom y un

tamafio de ventana muy cercano.

40 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO II
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) MARCO TEORICO

UNIVERSIDAD CENTRAL DE VENEZUELA

Esto es util para desplegar una vista grande de una escena en un visor y
aproximarse a un area en particular en el otro visor. Cuando dos visores estan
enlazados, se abre una caja en la ventana para mostrar donde estd la vista mas

cercana.

2.7.2 Procesamiento de imagenes en el Software ERDAS Imagine **

2.7.2.1 Proceso de clasificacion ??

2.7.2.1.1 Reconocimiento de patrones %

Es la ciencia, y arte de encontrar patrones significativos en los datos que
puedan extraerse a través de la clasificacion. Mediante mejoramientos espaciales y
espectrales de las imagenes, se puede realizar reconocimiento visual de patrones; el

cerebro humano clasifica automaticamente ciertas texturas y colores en categorias.

En un sistema computacional, el reconocimiento de patrones espectrales
puede ser mas cientifico. Se derivan estadisticas de las caracteristicas espectrales de
todos los pixeles en una imagen. Luego, los pixeles se ordenan basados en criterios
matematicos. Los criterios de clasificacion son divididos en dos partes: entrenamiento

y clasificacion.

2.7.2.1.1 Clasificacién No Supervisada

Permite especificar algunos paradmetros que el computador usa para revelar
patrones estadisticos que son inherentes a los datos. Estos patrones no necesariamente
corresponden a las caracteristicas directamente significativas de a escena, como areas
contiguas y facilmente reconocidas de un determinado tipo de suelo o uso de la tierra;
ellos simplemente son pixeles acumulados con caracteristicas espectrales similares.

En algunos casos, puede ser mas importante identificar grupos de pixeles con
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caracteristicas espectrales similares que ordenar los pixeles dentro de categorias

reconocibles.

La clasificacion no supervisada depende de los datos en si mismos para la
definicion de las clases. Este método se utiliza normalmente cuando no se conocen
muy bien los datos antes de la clasificacion. Es entonces, (después de la clasificacion)
que se debe de agregar el significado a las clases resultantes (Jensen 1996). La
clasificacion no supervisada solo es util si las clases pueden interpretarse

apropiadamente.

2.7.2.1.1 Clasificacion Supervisada *?

La clasificacion supervisada es controlada por el usuario; en este proceso, se
selecciona pixeles que representan patrones o rasgos de la cobertura terrestre que el
reconoce, o que ¢l puede identificar con ayuda de otras fuentes, como fotografias
aéreas, datos de terreno o mapas. Antes de la clasificacion se requiere conocer los

datos y las clases deseadas.

Mediante la identificacion de patrones, se puede entrenar el sistema
computacional para identificar pixeles con caracteristicas similares. Si la
clasificacion es exacta, las clases resultantes representan las categorias de datos que

se identificaron originalmente.

La clasificacion supervisada también incluye el uso de un conjunto de clases
generadas por una clasificacion no supervisada; empleando una combinacion de
clasificacion supervisada y no supervisada pueden obtenerse resultados Optimos;
sobre todo en conjuntos de datos (multiples escenas de Landsat). Por ejemplo, la
clasificacion no supervisada puede ser util para generar un conjunto basico de clases

y luego usar la clasificacion supervisada para definir mas las clases.
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2.7.2 Anadlisis del terreno ??

El analisis del terreno involucra el procesamiento y la simulacion grafica de
los datos de elevacion. Los datos del terreno son usados a menudo como un
componente de modelamiento o clasificacion. Las imdgenes de pendiente y aspecto
son usualmente un factor importante para evaluar la aptitud de un sitio para un uso
propuesto. Los datos del terreno también pueden ser usados para la clasificacion
vegetal de especies que son dependientes del terreno. Se tiene que los datos

topograficos incluyen:

» Imagenes de pendiente: Ilustran cambios en elevacion sobre la distancia.

» Imagenes de aspecto: Ilustran la direccion predominante que la pendiente enfrenta
en cada pixel.

» Imagenes sombreadas del relieve: Ilustran variaciones en el terreno mediante la
diferenciacion de las areas que estarian iluminadas o ensombrecidas por una

fuente de luz que simula el sol.

Las imagenes de relieve sombreado se generan a partir de una superficie de
elevacion, sola o en una combinacion con un archivo de imagen desplegada sobre el
terreno. Cabe destacar, que el programa del relieve identifica las areas sombreadas, es
decir, aquellas que no reciben la luz solar directamente. El programa no calcula la

sombra que es proyectada por objetos topograficos en la superficie adyacente.

2.8 SOFTWARE ARCGIS

2.8.1 Fundamentos del ArcGis ©®

Sus fundamentos se basan en digitalizar, manipular capas de informacion,

geoprocesamiento con funcionalidad limitada y creacién de geodatabases personales

de limitada funcionalidad.
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Los layers o capas de informacion es una referencia a un archivo fisico
existente en algiin lugar dentro de la base de datos SIG o archivo separado. Sirve
para guardar maneras de mostrar la informacién mediante esquemas de colores o

simbolos.
2.8.2 Extension en ArcGis ¢®

Una extension de ArcGis es una herramienta que se puede cargar cuando se
necesite una funcionalidad adicional. ArcGis posee varias extensiones entre las que se
destacan las extensiones opcionales que proporcionan un analisis mas avanzado y

otras capacidades funcionales.
2.8.3 Modulo de Analisis Espacial de ArcView ©?

Provee funciones basadas en raster que incluyen cuencas, contornos, analisis
de distancia y superposiciones (overlays) de capas de informacion. Permite el
modelado raster y vectorial integrado. Este modulo permite la generacion de curvas

de nivel a partir de modelos de elevacion del terreno (DEM).

La extension de analisis espacial del ArcGis proporciona una amplia gama de
caracteristicas espaciales de gran alcance para el modelamiento y el analisis. Entre

algunas de las funciones tenemos:

Crea, mapea y analiza pixeles basado en datos de tipo raster

Realiza un analisis integrado de raster / vector

>
>
» Algebra de mapas
» Consulta informacion a través de capas de datos multiples
>

Integra completamente datos raster con fuentes de datos tradicionales del

tipo vector.
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2.8.4 Modelo de Datos ©“?

Un modelo de datos de objetos permite la creacion de bases de datos
orientadas a la informacién geografica (Geodatabase). Una base de datos de este tipo
permite combinar las propiedades de los objetos con su “comportamiento”. Estas
bases de datos inteligentes otorgan la habilidad de afiadir definiciones y
comportamiento a objetos, proporcionando todas las herramientas necesarias para

crear y trabajar con datos geograficos.

El modelo de geodatabase define un modelo genérico para informacién
geografica; este modelo genérico puede ser usado para definir y trabajar con una
amplia variedad de usuarios o modelos para aplicaciones especificas. Definiendo e
implementando diferentes comportamientos sobre un modelo geografico genérico, se
proporciona una plataforma para la definicion de diferentes modelos de datos de

usuario.

2.8.5 Modelo de Datos Geograficos ©¢?

Un dato geografico posee tres componentes fundamentales que describen
espacialmente cualquier entidad. Estas son por un lado la ubicacion geométrica
especifica que este posee en algun sistema de referencia determinado, las

caracteristicas de la entidad y las relaciones espaciales que posee con su entorno.

ArcGis tiene un modelo de datos geograficos de muy alto nivel para
representar informacion espacial tales como features (vectores), raster y otros tipos

de datos.

ArcGis es capaz de soportar una implementacion del modelo de datos, tanto
para los sistemas de archivos como para los manejadores de bases de datos. Los

modelos basados en archivos incluyen un conjunto de datos SIG tales como
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coberturas, shapefiles, grids, imagenes y redes de triangulos irregulares (TIN). El
modelo de bases geograficas o geodatos administra los mismos tipos de informacion
geografica.

(36)

2.9 Interfaz grafica de ArcMap

» Title bar: Muestra el nombre del archivo compuesto de mapas y capas de

informacion.

» Toolbars: Son moéviles y pegadizos.

» Table of contents: Provee la lista de las capas de informacion incluidas, ademas

de sus respectivas leyendas. Es movible y pegadiza.

> Display area: Area donde se despliegan los mapas.

» Status bar: Muestra coordenadas, descripciones de botones y elementos del menu.

» Data view: Sub interfaz para mostrar, hacer cambios, introducir datos, hacer

busquedas geograficas o en las tablas de atributos.

» Layout view: Sub interfaz para producir mapas y graficas.

» Layers: Capas de informacion geografica (representacion grafica de los datos).

» Data Frames: Organiza los layers

» Table of contents: Puede tener mas de un data frame con multiples layers.

El menu Layer Properties tiene las siguientes funciones:
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Source: Define la referencia fisica del archivo.

General: Define como se muestra el mapa mediante escalas.

Selection: Cambia la forma de mostrar los datos seleccionados.

Symbology: Escoge los simbolos para representar datos; asi como también
escoge cuales son los campos o atributos asociados al archivo que se desee
abrir; muestra un campo en particular, cambia el modo de visualizar los datos
en cada campo numérico.

Labels: Define como mostrar los labels o etiquetas.

Definition query: Selecciona cuales datos se desea visualizar.

Joins & Relates: Define como y cuales tablas o datos de referencia se puede

relacionar un layer en particular.

Simbologia: Formato y/o resumen de informacién tabular 2

Arcmap provee multiples opciones para la representacion y/o resumen de la

informacion contenida en los mapas. Entre las opciones se encuentran:

>

>

>

Single Feature: Despliegue para todos los elementos.

Categories: Cambia el formato de colores para distinguir elementos en la tabla

de atributos.

Quantities: Se relaciona directamente con la representacion y/o resumen de

datos tipo numérico. Tiene varias opciones:
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0 Graduated colors: Diferentes colores y tonalidades segin los valores
numéricos. Usado normalmente para valores normalizados, porcentajes, etc.

0 Graduated symbols: Se utiliza para representar valores numéricos de
cantidad tales como poblacion, etc.

0 Proportional symbols: A diferencia del anterior, esta opcioén asigna un

tamafio de simbolo proporcional al valor real de cada elemento.

» Charts: Muy util para ahorrar espacio y hojas de mapas adicionales cuando se

necesita representar diferentes variables que se intentan relacionar entre ellas.

» Multiple attributes: Al igual que la opcion Charts este también se utiliza para

mostrar diferentes atributos en un mismo mapa.

Como se menciond anteriormente, Arcmap tiene la funcion de afiadir labels
(etiquetas) a los elementos geograficos. Provee la funcionalidad de para etiquetar
desde la tabla de atributos, o manualmente. Ademas, se puede cambiar caracteristicas
tales como tamafio, mayusculas, color, etc. También puede mostrar mayor o menor
informacion grafica segin la escala o nivel de acercamiento al objeto o area a ser
vista (Scale dependent display). Mientras mas pequefia sea la escala, menor

informacion se presentara.

2.11 Layer Files

Las definiciones de simbologia se guardan dentro del archivo mxd o map
document. Son utiles para guardar y re-usar simbolos definidos, compartir
definiciones de simbologia, copiar elementos seleccionados en otro archivo y
exportar a otros formatos (shape, geodatabase feature class). Otros tipos de layers
son los temporeros, los cuales residen en la memoria y desaparecen cuando finaliza la
sesion y son utilizados también para la ejecucion de modelos de andlisis geografico

(model builder).
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CAPITULO 111

GEOLOGIA REGIONAL

Por la diversidad de eventos y de ciclos tectono-estratigraficos ocurridos a lo
largo de la historia geologica de Venezuela, los distintos autores han propuesto
dividir el territorio venezolano en dos regiones bien diferenciadas, la cuenca

occidental y la cuenca oriental, basandose en su historia tectonoestratigrafica.

3.1. GEOLOGIA ESTRUCTURAL

Para Zambrano et al. (1970), la region occidental de Venezuela se divide en
cuatro grandes unidades estructurales, entre las que se encuentra La Sierra de Perija,
zona donde se ubica el area de estudio de este trabajo especial de grado y la cual esté
situada en el extremo mas occidental del pais formando parte de la Cuenca Occidental
de Venezuela. La Sierra de Perija se encuentra estructuralmente levantada entre la
Cuenca del Lago de Maracaibo y los valles de los rios Cesar y Rancheria (ambos en
Colombia), representando en el lado venezolano la continuacion de la faja de
plegamientos de la Cordillera Oriental de Colombia, aunque con una variacion en la

alineacion principal de la estructura.

Miller (1960), basandose en un estudio fotointerpretativo postula que las
estructuras compresivas (fallas y pliegues) tienen un rumbo promedio de N35°E,
siendo estas dominadas por los fuertes alineamientos formados por la falla de Perija y
El Tigre. Asi mismo, propone tres sistemas de directrices estructurales:

% longitudinal (rumbo aproximado de N35°E);

¢ transversal (rumbo aproximado N50°E);
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¢ meridional,

de las cuales, la mas notoria es la longitudinal, que entre sus estructuras mas
complejas cuenta con dos (2) levantamientos mayores, formados uno por el Arco de
la Serrania de Valledupar y la Sierra Septentrional, y el otro por el Arco de la Sierra

Meridional, el Anticlinal Rio Negro y la Alineacion El Totumo.

Para Bowen (1971), la Sierra de Perija posee un estilo estructural mas
sencillo que su vecino los Andes de Mérida, sobre todo en lo que se refiere a la parte

central de la misma.

Posteriormente Maze (1984%) propone a la Sierra de Perija como un terreno
aloctono que llegd al sitio donde se encuentra durante el Jurasico, en medio de un
marco tectonico que se caracterizo por la subduccion de la Placa del Pacifico al Oeste
de la Placa Sudamericana; la formacion de un “rifting” asociado con la apertura del
Caribe; y el desplazamiento transcurrente. Este autor, basandose en estudios
paleomagneticos, sugiere que tanto la Sierra de Perijd como los Andes de Mérida no
pueden interpretarse bajo un modelo tectonico de extension simple como lo proponen

otros autores.

Testamark et al. (1994), en base a estudios de lineas sismicas, propone que las
fallas inversas de orientacion NE, presentes en el area, fueron reactivadas por fallas
normales de edad Jurdsico-Cretacico, ademas plantearon la existencia de una
importante zona triangular, coincidiendo con Audemart (1991), quien para el
Neogeno sugiere la formacién de importantes zonas triangulares consecuencia del
desarrollo de estructuras de retrocorrimiento o backthrust dentro de la Sierra de

Perija.
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3.1.1. Inventario de Estructuras de mayor importancia dentro de la Sierra de

Perija
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FIGURA N° 3. 1. Principales estructuras en la zona noroccidental de Venezuela. (Tomado de www.pdv.com)

A continuacion se presenta una breve resefia de las estructuras mas

importantes y resaltantes que se encuentran dentro de la Sierra de Perija.

3.1.1.1. Fallas

Miller (1960), explica que ademas del esquema longitudinal que presentan las
estructuras dentro de la Sierra de Perija, existen varios rumbos de fallamientos y
perturbaciones locales de cierta relevancia, en donde destacan aquellas fallas de
rumbo Sur que se ramifican de fallas longitudinales en la seccién Norte de la Sierra y
se extienden hasta la Cuenca de Maracaibo. Relacionada con la directriz de la
Alineacion de Arena Blanca se encuentra un sistema de fallas transversales que cruza
a través de la parte meridional y Surcentral de la Sierra. A su vez, el sistema
transversal de la Falla de Oca, cuya direccion es Este-Oeste, limita el extremo Norte

de la Sierra.

Entre las estructuras que forman parte del sistema longitudinal se encuentran

las Fallas El Tigre, Cuiba y Perija.
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a. Falla Perija

Miller (1960) plantea que en el extremo Nororiental de la Sierra, un conjunto
de desplazamientos ramificados y paralelos componen la llamada falla o desgarradura
de Perija, cuya linea principal es una traza persistente y recta, que se encuentra
acompafiada de otras trazas casi paralelas entre si y que tienden a ramificarse,
desaparecer y volver a unirse a la traza principal. La directriz de la Falla de Perija es
indicada por el drenaje, mientras que su movimiento transcurrente es inferido por el
posicionado de rocas antiguas. El sistema de Falla Perija marca una fosa sinclinal y

depresion estructural la cual divide la Sierra.

b. Alineamiento de las Fallas Cuiba-Socuy

Miller (1960) identifica del lado Oriental de la Sierra el alineamiento de la
Falla de Cuiba y la Falla Socuy, lo que define la linea de levantamiento que divide la

Sierra de Perija y la Cuenca de Maracaibo.

El mismo autor, al referirse a la Falla de Cuiba, explica que entra
diagonalmente en la Sierra y esta consiste del desplazamiento de rocas Cretacicas y
Paleocenas, mientras que de la Falla de Socuy sugiere un menor desplazamiento e
incompetencia de las rocas, lo que la hace confusa y discontinua en algunas

secciones.
c. Alineamiento de las Fallas Arena Blanca- Ariguasa
Miller (1960), explica que las Fallas Ariguasa y Falla Arena Blanca, penetran

de manera alineada a la Sierra, constituyendo un desplazamiento transversal que se

inicia en el extremo Sur de la Falla de Cuiba y se prolonga hasta el Valle del Cesar.
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d. Fallamiento de Macoa y de la zona del Totumo

Segun Miller (1960), un grupo de fallas que principalmente son inversas se
encuentran buzando hacia el Este y se ramifican hacia el Sur a partir de los
desplazamientos del Tigre y Cuiba, formando un papel importante en el
levantamiento frontal de la Sierra. Entre los desplazamientos presentes, Miller (op.

cit) incluye a Cogollo, La Luna, La Gé, El Totumo y El Palmar.

e. Fallael Tigre

Rod (1956), identifica este desplazamiento como una falla rectilinea de gran
angulo (N35°E) del lado Noroccidental del arqueamiento El Totumo-Inciarte y en el
limbo Suroriental del Sinclinal de Manuelote, la cual se encuentra alineada con la
Falla Perija, relacionandose las dos con una posible ruptura de gran profundidad.
Rod (1956) junto con Alberding (1957), proponen un movimiento transcurrente
lateral izquierdo, que en la actualidad no queda claramente evidenciado,
encontrandose alineado paralelamente y de manera perpendicular a los esfuerzos

compresivos del Terceario Superior.

f. Fallade Oca

Rod (1956) y Alberding (1957), se refieren a la Falla de Oca como un
movimiento lateral derecho que en el Rio Limoén se desvia hacia el Sureste, motivado

al colapso estructural a lo largo del rio Limon.

3.1.1.2. Pliegues

Miller (1960), al referirse a los pliegues presentes en el area septentrional de
la Sierra de Perijd, explica que estos se ajustan a la fibra longitudinal de la Sierra.

Desde el extremo septentrional de la Serrania de Valledupar los ejes de los pliegues
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se inclinan hacia el Norte y presentan una pendiente hacia el Este, en lo que es el

limbo oriental de la Serrania.

El mismo autor sugiere que en la extremidad meridional de la Serrania de

Valledupar, existe un descenso de los ejes hacia la tierra alta de Maraca.

La parte meridional de la Sierra se encuentra separada de la estribacion de

Animito por un sinclinal enrumbado al Norte.

Al Oeste de la Sierra existen dos anticlinales conocidos como Becerril y

Verdesia, los cuales descienden gradualmente hacia el Suroeste.

En el estudio realizado en la region de Machiques-Rio Negro, Padilla y Ortiz
(1973), reconocen dos periodos de plegamientos:
¢+ Mesozoico Inferior: caracterizado por pliegues inarmoénicos, cuyos ejes se

orientan con direccion aproximada Este-Oeste.

++ Oligoceno-Pleistoceno: caracterizado por la presencia de pliegues
armonicos anchos de tipo paralelo que forman sinclinales y anticlinales;
ademds de pliegues inarmonicos anchos que se encuentran asociados a
fallas regionales. Estos dos tipos de pliegues tienen sus ejes orientados en

direccién Nor-Noreste.
a. Anticlinal de Rio Negro.
Presente a lo largo del lado Oriental de la falla de Perija, los limbos de esta

estructura se encuentran delineados por filas confinantes casi continuas de las

areniscas de Rio Negro.
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Hacia el nticleo del anticlinal, el eje se inclina al Norte hasta el Rio Negro,

donde se observa una pronunciada ensilladura.

Esta estructura se relaciona en su extremidad Norte con el Arco del Totumo-
Inciarte, mientras que hacia el Sur probablemente se relaciona con el plegamiento
generado durante el levantamiento mas complejo de la parte meridional de la Sierra,

donde la mayoria de los ejes del plegamiento son probablemente longitudinales.

3.2. ESTRATIGRAFIA
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TABLA N° 1. Tabla de correlacion de formaciones del occidente de Venezuela.

Graf (1971), afirma que “el tectonismo activo a lo largo de accidentes
estructurales influye y localmente controla la accion de los procesos sedimentarios”,

donde los elementos positivos, entre los que se encuentra la Sierra de Perija, no solo
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controlan la extension geografica que pueden tener los diferentes ambientes
sedimentarios, sino que ademas seran determinantes en el tipo de sedimento que se

deposita.

Parnaud et al. (1995) proponen dividir la historia estratigrafica del occidente
venezolano en dos grandes sucesiones, la Paleozoica y la Mesozoica-Cenozoica, esta
ultima caracterizada por la diversidad de eventos tectonicos, marcados por
inconformidades, que llevaron a este autor a dividirla en seis (6) grandes
supersecuencias que mas adelante se explicaran y que internamente estan
conformadas por secuencias menores dominadas por variaciones tectono-

estructurales.

3.2.1. Sucesion Paleozoica

Para Parnaud et al. (1995), el Paleozoico en la Sierra de Perija se empicza a
evidenciar a partir del Paleozoico Medio con la aparicion del Grupo Cachiri, el cual
estd representado por rocas sedimentarias de ambiente plataformal marino. Estos
autores proponen dos series para el periodo comprendido en el Paleozoico Tardio, la
primera constituida por las formaciones Cafio del Noroeste, Cafio Indio y Rio Palmar,
y una serie mas joven conformada por la Formaciéon Palmarito, cuyo origen se

interpreto como de ambiente de plataforma interior.

3.2.2. Sucesion Mesozoica-Cenozoica

Para Parnaud et al. (1995), la sucesion Mesozoica-Cenozoica en Venezuela es
el producto de dos grandes eventos tectonicos que ocurrieron a partir del Jurasico. El
primero es una fase de rift Jurasico consecuencia del proceso de fragmentacion del
supercontinente conocido como Pangea; el segundo, es una fase Cretdcica-Terciaria

producto de la colision de la Placa Sudamericana y la del Pacifico.
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Mendoza (2005) propone que el periodo comprendido por esta sucesion se
inicia de igual manera con la ruptura de Pangea, en donde la aparicion de vulcanismo
en el area de Perija explica la existencia de rocas volcanicas en la region a principios
del Mesozoico. Posteriormente y a medida que sigue avanzando el proceso de
separacion de Pangea se fueron generando nuevos mares y surge el Proto-Caribe,
depositandose sedimentos propios de ambientes deltaicos a marinos poco profundos
con algo de influencia terrigena y volcanica, los cuales se evidencian en las
formaciones Tinacoa y Macoita. Simultaneamente se formaron semigrabens, que
poco a poco se fueron rellenando. Con el transcurso del tiempo el Proto-Caribe se
fue profundizando para dar inicio al gran evento transgresivo del Cretacico Inferior,
en el que se empiezan a depositar sedimentos de ambientes fluvio-deltaicos a marinos
muy someros evidenciados en la Formacion Rio Negro, la cual se depositd sobre las
capas rojas de la formacion La Quinta. A medida que avanzo el Cretacico la
transgresion tomo mas fuerza, lo que gener6 un cambio en las facies que se
depositaron, pasandose a calizas y lutitas. Posteriormente, se paso a condiciones de
ambiente marino mas profundo lo que trajo consigo un aumento en la cantidad de
material carbonoso y practicamente llevaron a la desaparicion del aporte de clasticos.
Esta condicién se mantiene hasta finales del Cretacico cuando el régimen transgresivo
finaliza y se da inicio a un evento regresivo que se encuentra con una cuenca mas
profunda e inclinada hacia el Norte y hacia el Este, por lo que este régimen afecta con

mayor incidencia a la cuenca occidental.

Para esta sucesion Parnaud et al. (1995) establece seis (6) supersecuencias,
cada una caracterizada por su evolucidon tectonica. Esas seis supersecuencias se

explican a continuacion:

3.2.2.1. Supersecuencia A (JURASICO): Extension

La depositacion de la supersecuencia A es resultado del episodio de rifting

ocurrido durante el Jurdsico como consecuencia del proceso de ruptura del
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supercontinente Pangea, el cual, estuvo impulsado por esfuerzos divergentes
orientados en sentido noreste y auroeste. Yoris, Ostos y Zamora (1997), explican que
este proceso extensivo trajo consigo la apertura del Proto-Caribe, lo que género
dentro de la Venezuela continental una serie de estructuras que posteriormente serian
determinantes en la formacion de las cuencas sedimentarias de Venezuela. Entre esas
estructuras se encuentran los valles de extension o grabens, que como se observa en la
FIGURA 3.2 estan orientadas de manera preferencial con sentido Noreste, tal es el
caso del graben de Perija. Todas esas estructuras extensivas tienen en comun que se
rellenaron durante el Jurdsico con sedimentos continentales de coloracidon rojiza,
sedimentos volcanicos y ocasionalmente clasticos y calizas consecuencia de

invasiones marinas al continente.

73 Guajira 63" o

Mar Caribe 1

Falla de EI Pil
—
2,

Trinidad

N
Caracas

Graben
de Espino

® Macizo-==-— ... .

de Santander Graben e — R
AF}U.FG- Mantecal 0 100 200 300 km .
I T e

FIGURA N° 3. 2. Distribucion de las rocas jurasicas en Venezuela, mostrando que las mismas se encuentran
aflorando en la Sierra de Perija (1), como parte del basamento en el subsuelo de la Cuenca de Maracaibo (2), en los Andes (3),
en el subsuelo de las cuencas de Barinas-Apure y Oriental y en la Serrania del Interior (4). Tomado de Bartok (1993),
Passalacqua et. al. (1995) y Lugo y Mann (1995).

Otros autores, tales como Pindell & Erikson (1994), proponen que para el
Triasico-Jurasico, en la parte noreste de Sudamérica se gener6é una cuenca retroarco
que permitid la generacion de los grabens de Machiques(Venezuela ) y de Bogota
(Colombia), todo esto como consecuencia de la subduccion existente al este y por

debajo de la Cordillera Central. Consecuencia de la formacion de esos grabens fue

que el mar tuvo acceso a territorio colombiano.
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» Grupo La Gé

Hea y Whitman (1960) proponen el nombre de Grupo La Gé para agrupar el
conjunto de sedimentos continentales contenidos dentro de las formaciones Tinacoa,
Macoita y La Quinta. Estas formaciones representan una asociacion litologica de
caracter provincial con presencia de productos volcénicos y presentan como
caracteristica resaltante el hecho que los contactos entre ellas son transicionales. Por
lo general se le asigna una edad que va desde el Carbonifero (Pennsilvaniense) hasta

el Jurasico.

o0 Formacion La Quinta

Kiinding (1938-a, b) divide la Formacién La Quinta en tres partes sin
definirlos nunca como miembros. La parte inferior se encuentra formada por
conglomerados rojos oscuros que eventualmente presenta material tobaceo y mucha
biotita, que ademads se interestratifican con capas espesas de areniscas arcillosas; la
parte media esta constituida por lutitas de color rojo oscuro y verdoso que se
encuentran interestratificadas con areniscas conglomeraticas blancas que desaparecen
hacia el tope; la parte superior se presenta con una estratificacion cruzada de
areniscas rojas blandas que hacia el tope se interestratifican con areniscas cuarzosas

de grano grueso.

Segun Miller (1960), la seccion de la Formacion La Quinta que se encuentra
en la Sierra de Perija esta caracterizada por la presencia de areniscas y lutitas rojas,
conglomerados, duras areniscas grises, todo esto acompafiado de basalto y de lutita

cuarcifera y aglomerados.

Mendoza (2005) propone que las capas rojas de la formacion La Quinta
representan facies de conos piemontinos y de sedimentos aluviales, y que su contacto

superior es ocasionalmente concordante y en otros casos discordante.
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Esta formacion se presenta angularmente discordante en la base, mientras que

en el tope se ha reconocido cierta discordancia que en ciertas zonas no se presenta.

La Formacion La Quinta es de edad Tridsico Superior a Jurasico Inferior (ver

FIGURA N° 4.1).

3.2.2.2. Supersecuencia B (CRETACICO): Margen Pasivo

Yoris et al. (1997), refiriéndose al Cretacico Temprano en el occidente de
Venezuela, propone que la sedimentacion durante el inicio de ese periodo fue
controlada por el sistema de fallas asociadas a los grabens del Jurasico, lo cual quedo
evidenciado por el dominio de material arenoso que conforma la formacion Rio
Negro. El mismo autor, sugiere que seguidamente se estabilizé la subsidencia y en
consecuencia se generd un gran mar epicontinental transgresivo, donde se deposito la
formacion Cogollo (primordialmente carbdnatica) que es su principal exponente. Ya
para el Cretacico Tardio, Yoris et al. (1997), hacen mencion al dominio que tuvo el
evento transgresivo sobre la sedimentacion en toda Venezuela y el resto del mundo,

reflejdndose en la presencia de calizas, lutitas y ftanitas ricas en materia orgénica.

Para Parnoud et al. (1995), existen tres evidencias principales de que la
supersecuencia B engloba una fase de margen pasivo que se desarrollo desde el
Cretacico Temprano hasta el Cretacico Tardio, la cual estuvo asociada con un proceso
de subduccion hacia el Oeste con la placa del Pacifico. La fase de margen pasivo
concluye con la colision del arco del Pacifico con la placa Sudamericana y la

subsidencia flexural de la cuenca foreland. Dichas evidencias son:

e Aparente reduccion de la falla controladora de la subsidencia;
¢ la total profundizacion de la transgresion de la cuenca;

e la estratigrafia.
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Durante el periodo de la fase de margen pasivo se depositaron un total de seis

secuencias, las cuales se describen a continuacion:

» Formacién Rio Negro

Padilla y Ortiz (1973) se refieren a la Formacion Rio Negro como areniscas
liticas, representadas por subgrauvacas y protocuarcitas, ademas de conglomerados y
en menor proporcidn ortocuarcitas, lutitas y tobas, asigndndole como edad el

Cretacico Inferior.

Miller (1960) refiriéndose a la seccion perteneciente a la Sierra de Perija, la
define como areniscas arcosicas que son parcialmente conglomeraticas, potentes
areniscas de grano grueso interestratificadas con arenas de grano fino y poca
presencia de limolitas y lutitas arenosas. Este autor refiere a la zona potente como la

parte central y meridional de la Sierra.

Est4d formacion en su parte basal se presenta discordante, mientras que en el

tope con la Formacioén Apon pudiese ser concordante y hasta un poco diacronico.

La edad para esta formacion es Cretacico Temprano (FIGURA N° 4.1).

» Grupo Cogollo

Nombrado originalmente por Garner (1926) como “Caliza de Rio Cogollo”,
fue descrita por este autor como calizas cristalinas macizas grises que se encuentran
por debajo de la Formacion La Luna. Posteriormente estd unidad cambia de nombre
y eleva su rango a Grupo por iniciativa de Sutton (1946), para mas adelante ser
dividida en dos partes, motivado a las diferencias existentes entre los tipos de calizas

presentes, siendo las de la base calizas macizas a las que le sigue un intervalo de
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areniscas y calizas interestratificadas; al tope se trata de una caliza con abundante

contenido de grandes ostiones.

En la actualidad esas dos unidades fueron renombradas en tres (3)

formaciones (Apon, Lisure y Maraca) (ver FIGURA N° 4.1).

0 Formacion Apon

Esta unidad presenta ciertas variaciones locales que son de interés, destacando
en la seccion perteneciente a la Sierra de Perija la presencia de calizas y lutitas
arenosas hacia la base, lo cual es evidencia de la transicion que viene de la Formacion
Rio Negro, que a continuacion le sigue un grueso intervalo biostromico de calizas

macizas que en algunas locaciones se encuentran dolomitizada.

En su base, Apon se encuentra en contacto transicional y diacrénico con la
Formacion Rio Negro, mientras que en el tope el contacto es transicional con la

Formacion Lisure.

Kieser (1977) le asigna una edad a esta formacion de Aptiense-Albiense (ver

FIGURA N° 4.1).

o Formacioén Lisure

En el Léxico Estratigrafico Venezolano II (1970) definen esta formacion
como predominantemente de areniscas glauconiticas y calizas arenosas, intercaladas

con arcillas laminares arenosas y algunas capas de caliza conchifera.

Esta unidad cuenta con espesores comprendidos entre los 55m y los 180m,
presenta un contacto discordante con la formacién infrayacente, mientras que con la

Formacion suprayacente su contacto es transicional.
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Autores como Rod y Maync (1954), reportaron la presencia de foraminiferos

y fauna equinoideos.

La edad de la formacion esta establecida como Albiense Medio a Superior

(ver FIGURA N° 4.1).

» Formacion La Luna

Miller (1960), propone que la formacion La Luna se encuentra caracterizada
por la presencia de calizas y lutitas pelagicas concrecionarias, practicamente de color

negro, que se encuentran estratificadas y laminadas densamente.

En el Léxico Estratigrafico II (1970), ademés de las calizas laminares y
ftanitas negras propuestas por Gonzalez de Juana et al. (1980), incluye calizas

coquinoides y lutitas calcareas.

Para Mendoza (2005), la litologia de esta formacion consiste de calizas
negras oscuras y densas, las cuales se encuentran laminadas y poseen un alto
contenido de foraminiferos planctonicos, ademas de ser carbondceas a bituminosas.
Este mismo autor propone que ocasionalmente estas calizas son piriticas, y que
adicionalmente hay presencia de arcillas y lutitas de color negro que pueden ser
calcareas o no; en Perija, este autor reporta esta formacion como de color negro y de

caracteristicas euxinica.

Los espesores de esta formacion varian hacia el norte y estan alrededor del

orden los 100m y 300m de profundidad.

Miller (1960), propone una edad Coniaciense-Turoniense, mientras que el
Léxico Estratigrafico I1 (1970) y Gonzalez de Juana et al. (1980) ubican la formacion

en el Cenomaniense-Santoniense (ver FIGURA N° 4.1).
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La formacion La Luna se encuentra en contacto concordante tanto con la

formacién que la infrayace como con la que la suprayace.

3.2.2.3. Supersecuencia C (CRETACICO TARDIO-PALEOCENO
TEMPRANO): Margen Transicional de Pasivo a Activo

Para Parnaud et al. (1995), la colision del arco volcanico del Pacifico con la
placa Sudamericana dio inicio a la transformacion de margen pasivo a margen activo,
siendo esto el principal causante de los procesos de sedimentacion durante la
generacion de la Supercecuencia C, la cual estuvo dominada por un evento de tipo
regresivo que se inicio durante el Cretacico Tardio, y que Mendoza (2005) propone se

inicio en el Paleoceno.

Pindell & Erickson (1994), explica que a partir del Cretacico Tardio la
subduccion del arco del Pacifico vuelve a invertirse hacia el Este (luego de haber
cambiado su direccion hacia el Oeste durante el Cretdcico Medio) empezando la
generacion de la placa del Caribe con los fragmentos del arco que no llegaron a

colisionar con la placa Sudamericana.

Parnaud et al. (1995) proponen dividir este periodo en dos (2) secuencias.

Dichas secuencias se explican a continuacion:

a. SecuenciaK6 (Campaniense Superior-Mastrichiense)

Para Parnoud et al. (1995), el proceso de colision del arco del Pacifico genero
en Venezuela occidental una cuenca foreland, que hacia el oeste se encuentra
asociada con un foredeep, donde se deposito en el Campaniense Superior la
Formacion Colon, la cual es la base de la secuencia K6. Esta secuencia se prolonga
hasta el Mastrinchiense Tardio, donde el proceso de sedimentacidon se encuentra

controlado por un sistema extensivo, representado por la depositacion de la
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Formacion Mito Juan. La secuencia K6 se caracteriza por las indeterminadas
superficies de inundacion y en ella la Formacion Colon representa el final del evento
transgresivo del Cretdcico mientras que la Formacion Mito Juan se identifica como
un sistema depositacional de alta progradacion. Las unidades presentes dentro de la

Secuencia K6 son las siguientes:

» Formacion Colén

Miller (1960), describe la Formaciéon Colon como una unidad
primordialmente consistente de lutitas grises que se depositarén dentro de un
ambiente marino relativamente profundo y las cuales le asign6 una edad de

Cenomaniense a Daniense.

En el Léxico Estratigrafico III (2008), adicionalmente la describen como
microfosiliferas, macizas, piriticas y hasta micaceas o glauconiticas, ademas de

proponer la presencia ocasional de margas y capaz de caliza.

Con gran presencia de fosiles, esta formacion es datada por varios autores
dentro del Léxico Estratigrafico III (2008) como de edad Cretacico Tardio,
ubicandola especificamente en el Campaniense Tardio-Mastrinchiense Temprano,

aunque hay quien la ubican en el Santoniense (ver FIGURA N° 4.1).

La Formacion Coldn se encuentra en contacto concordante con la Formacion
La Luna mientras que con la formacion Mito Juan el contacto ademés de ser
concordante es también transicional.

» Formacion Mito Juan

Miller (1960) se refiere a la Formacion Mito Juan como una facies algo

arenosa que se deposito dentro de un ambiente de aguas poco profundas.
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En el Léxico Estratigrafico III (2008) se describe litolégicamente a esta
unidad como arcillas grises, que pueden llegar a ser grises verdosas o negras, con
contenido local de arenas, y que a medida que se asciende se van haciendo mas ricas
en material limoso y arenoso, llegdndose a encontrar delgadas capas de calizas y

areniscas en el tope de la formacion.

Esta formacion se encuentra en contacto transicional y concordante con la
Formacion Colon y al igual que estd posee contenido fosil, aunque segun Hedberg y

Sass (1937) con menor presencia de foraminiferos.

Sutton (1946) y Key (1960), coinciden en asignarle una edad de
Mastrinchiense Superior a esta formacion (ver FIGURA N° 4.1).

b. Secuencia K7 y K8 (Mastrinchiense Superior-Paleoceno Inferior)

Parnaud et al. (1995), propone que para finales del Cretacico la cuenca
foredeep se termino de rellenar con la depositacion de la Formacion Mito Juan, al
mismo tiempo que se fue erosionando la misma a consecuencia de la somerizacion
del basamento, mientras que desde el Noreste se iniciaba un nuevo evento
transgresivo representado por la depositacion de una secuencia inferior conocida
como K7 (Formacidon Guasare), cuyas cararteristicas son de ambiente marino; y una
secuencia superior llamada K8 (Grupo Orocue, constituida a su vez por la Formacion
Barco y la Formacion Los Cuervos; y la Formaciéon Marcelina), la cual se deposito
en un ambiente deltaico. Las formaciones que comprenden las Secuencias K7 y K8

son las siguientes:

» Grupo Orocue

Mendoza (2005) se refiere a este grupo como sedimentos molasicos que pasan

de ambiente marino poco profundos (Form. Catatumbo) a deltaico (Form. Barco) a
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continental (Form. Los Cuervos), béasicamente constituido por arcilitas, lutitas y

areniscas, intercaladas y alternantes, con presencia ocasional de capas de carbon.

o Formacion Catatumbo

En el Léxico Estratigrafico III (2008) describen esta formacion como una
unidad compuesta principalmente por lutitas y arcilitas gris oscuro, algo carbonaceas,
donde las lutitas se intercalan con capas de areniscas y hacia la base definen capas de
caliza gris glauconiticas, capas de carbon y glauconita. En su parte inferior esta
formacion se encuentra en contacto concordante y transicional con el Miembro Rio
de Oro, lo mismo que en el tope donde el contacto es concordante con la Formacion
Barco. La Formacion se caracteriza por la presencia de fosiles en su base, siendo
poco fosilifera en el resto de ella, lo que permitié6 asignarle una edad de
Mastrinchiense Tardio aunque posteriormente Kuyl et al. (1955) la ubica dentro de

todo el Paleoceno.

o Formacion Barco

Seglin el Léxico Estratigrafico III (2008), la Formacion Barco esta constituida
por una intercalacion de areniscas grises de grano muy fino a medio que se
caracterizan por poseer estratificacion laminada o cruzada, ademas de la presencia de
lutitas y limolitas de colores grises oscuros. Su contacto basal es de tipo concordante
en aquellos casos donde se encuentre con la Formacién Catatumbo y concordante en
su tope con la Formacion Los Cuervos. Esta formacion es principalmente propia de
ambiente deltaico y se caracteriza por el poco contenido de fosiles. Kuyl et al. (1955)

define esta formacion como del Paleoceno.
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o Formacion Los Cuervos

Para Notestein et al. (1944) esta formacion basicamente consiste de arcilitas y
lutitas, que en la base presenta carbon y algunas capas de areniscas. El contacto
inferior de la Formacion Los Cuervos es concordante, mientras que en el tope
Notestein et al. (op.cit) reporta que el contacto es discordante en varias localidades.
La diversidad en el contenido fosil presente en esta formacion, genera ciertas
discrepancias entre los autores al momento de proponer una edad, es asi que Monroy
y Arnstein (1984) proponen todo el Paleoceno; Gonzdlez Guzmén (1967) propone
una edad que comprende desde el Paleoceno Temprano a la parte inferior del Eoceno
Temprano; y Teran et al. (1986) dato la formacion desde el Paleoceno hasta el

Eoceno Tardio.

3.2.2.4. Supersecuencia D (PALEOCENO SUPERIOR-EOCENO MEDIO):
Cuencas Colisionales

Parnaud et al. (1995), explican que para finales del Paleoceno, las 1lamadas
napas de Lara, que no son mas que escamas tectonicas producto de la colision oblicua
del arco volcanico de las Antillas Menores con la parte Norte de la Placa
Sudamericana, comienzan su emplazamiento al Norte de la Cuenca del Lago de
Maracaibo, invadiendo el terreno existente y generando nuevas cuencas foreland, una
orientada con direccion N 20° W y otra con direccion E-W. La ocurrencia de este
evento segiin Parnaud et al. (1995) queda evidenciado con la identificacion de ciclos

transgresivos y regresivos.

Yoris et al. (1997) proponen al menos tres ambientes sedimentarios en los
cuales se depositaron los sedimentos durante el Eoceno, siendo estos de tipo deltaico-
estuariano, fluvio-costero y marino, los cuales se ubicaron por delante del frente de

corrimiento.
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Para Duerto (1998), la Sierra de Perija, posiblemente antes de iniciarse el
proceso de deformacion estaba conformado por un sistema de fallas normales, que
con el primer pulso tectonico, da inicio al primer estado de deformacién relacionado
al fallamiento de Cerrejon, en el Cerro Pintado (Colombia), al tiempo, que el flanco
Oriental de la Sierra de Perija experimento una inversion tectonica consecuencia del
movimiento del corrimiento de los Motilones, a la cual le siguid el fallamiento de

Macoa.

Segiin Parnaud et al. (1995) el periodo comprendido para la Supersecuencia
D se caracteriza por subsidencias intermitentes y una posible sobreimpresion

eustatica representada por tres secuencias depositacionales.

La supersecuencia D se compone de las siguientes formaciones:

» Formacion Mirador

Para Gonzalez de Juana et al. (1980) la Formacion Mirador se compone de
areniscas claras, lutitas, material carbonaceo y conglomerados, siendo caracteristico

las areniscas limpias, claras y macizas formando prominentes escarpes y cascadas.

Para Ramirez y Campos (1972) la Formacion Mirador y la Formacion
Carbonero (suprayacente) se encuentran en contacto concordante mientras que otros
autores como Notestein et al. (1944), Liddle (1946), Sutton (1946) y Staff of
Caribbean Petroleum Co (1998) consideran ambos contactos concordantes o

discordantes.

En el Léxico Estratigrafico II (1970) se refieren a foraminiferos arenaceos
como los tnicos fosiles presentes en la unidad, mientras que Gonzalez de Juana et al.
(1980) manifiestan que no se encontraron fosiles marinos, sino solo carbonaceos,

restos de plantas y escaso polen.

69 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO III
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) GEOLOGIA REGIONAL

UNIVERSIDAD CENTRAL DE VENEZUELA

La Formacion Mirador se deposito en ambientes de tipo fluvial, llanura

deltaica y de pantanos salobres.

En cuanto a la edad de la formacion existen discrepancias, teniendo que cierto
grupo de autores la consideran de edad Eoceno Inferior a Medio, y otros le atribuyen

una edad que puede ser Oligoceno a Eoceno Tardio (ver FIGURA N° 4.1).

3.2.25. Supersecuencia E (EOCENO TARDIO-MIOCENO TEMPRANO):

Cuencas Colisionales

Para finales del Eoceno la Placa del Caribe continua avanzando hacia el este
con respecto a la Placa Sudamericana generando cuencas antepais a lo largo de del
borde Norte de Venezuela, que estuvieron acompanadas de dos hechos particulares,
primero, zonas de obduccion, donde ocurrieron el emplazamiento de parte de las
ofiolitas de la Placa del Caribe sobre la Placa Sudamericana; segundo, el
emplazamiento de bloques aloctonos al Norte de Venezuela en zonas de acrecion

tectonica.

Parnaud et al. (1995), establecen que para el Eoceno tardio la parte occidental
de Venezuela sufri6 modificaciones, donde resalta la separacion de los relieves
positivos de la cuenca continental del Lago de Maracaibo con respecto a la cuenca

marina de Falcon.

Parnaud et al. (1995), proponen dos secuencias depositacionales para esta
supersecuencia. La inferior es de diferentes dominios y comprende desde el Eoceno
Tardio hasta el Oligoceno Temprano, estando representada al oeste por las
Formaciones Carbonera y la Sierra (Colombia) de dominio deltaico, mientras que al
este se encuentra el Miembro Arauca de la Formacion Guafita, la cual es de dominio

marino. La secuencia Superior comprende del Oligoceno Superior hasta Mioceno
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Temprano y esta representada al oeste por la Formacion Ledn, la cual se deposito

durante una inundacion marina.

Para Yoris et al. (1997), durante el Eoceno en el occidente de Venezuela los
sistemas deltaicos-estuarianos, fluvio-costeros y marinos controlan la depositacion de
sedimentos en la Cuenca de Maracaibo, siendo luego caracteristico para el Oligoceno
los clasticos arenosos al Oeste de la cuenca, mientras que al sur y al este se depositan

sedimentos finos.

Las formaciones que componen esta supersecuencia son:

» Formacion Carbonera

Gonzalez de Juana et al. (1980) se refieren a la Formacion Carbonera como
una unidad principalmente compuesta de arcilitas y lutitas grises, estratificadas
irregularmente con areniscas arcillosas, que adicionalmente presenta capas de lignito

y calizas.

Para Notestein et al. (1944), el contacto entre las Formaciones Carbonera y la
Formacion Mirador es discordante, mientras que Kuyl et al. (1955) propone un
posible hiato cronologico, basandose en estudios palionoldgicos, a la vez que Sutton
(1946) y el Staff of Caribbean Petroleum Co no observan las evidencias en que se
basan los otros autores para establecer un contacto transicional. EI contacto superior

de la Formacién Carbonera con la Formacion Ledn es transicional.

Gonzalez de Juana et al. (1980), ubican esta formacion dentro de un ambiente
sedimentario de llanura baja de aguas salobres que se van profundizando hacia el tope

de la unidad.
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Sutton (1946) identifica basicamente moluscos de aguas salobres y de
ambiente costero-lagunar, ademas de la presencia de foraminiferos de aguas salobres

a marinas llanas.

La edad para esta formacion se ha establecido entre el Eoceno Tardio y el
Oligoceno aunque por su contenido paleontoldégico no es posible discriminar (ver

FIGURA N° 4.1).

» Formacion La Sierra

Hedberg y Sass (1937), se refieren a estd formacién como areniscas de color
pardo, masivas, presenetes en capas gruesas a medianas, con intercalaciones de lutitas

y lutitas arenosas.

Dependiendo de su ubicacion el contacto inferior varia entre concordante y

discordante.

Con escazo contenido fosil, su edad es asignada al Eoceno superior por

correlacion con la Formacion Carbonera (ver FIGURA N° 4.1).

» Grupo EIl Fausto

Segin Hedberg y Sass (1937), el Grupo El Fausto comprende arcillas
endurecidas con algunos intervalos de arcilla laminar y areniscas gris verdoso de

grano fino.

En el Léxico Estratigrafico II1 (2008) se refieren al Grupo El Fausto como una
unidad conformada principalmente por arcilitas y limolitas de tonalidades apagadas
rojo puroura, gris, verde y marrdn, con ciertos intervalos menores de lutitas o arcilitas

gris verdoso o gris oscuro y areniscas verdosas de grano fino.
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El contacto inferior es concordante al sur y discordante al Norte con respecto
a la Formacién La Sierra, mientras que al tope el contacto es transicional con la

Formacion Los Ranchos.

A manera general este grupo es poco fosilifero y es considerado de edad

Oligoceno a Mioceno Tardio.

3.2.2.6. Supersecuencia F (MIOCENO MEDIO-PLEISTOCENO): Cuencas

Colisionales

Para el periodo comprendido para la Supersecuencia F tiene una sucesion de
eventos tectonicos, que como explica Yoris et al. (1997), son producto de la
interaccion de la Placa Caribe con la Placa Sudamericana que a partir del Oligoceno e
inicios del Mioceno, ocasiono el levantamiento y formacion de montafas, ademas de

la formacion de cuencas extensionales y de tipo antepais.

Con la orogénesis del Plioceno se definieron las cuencas petroliferas de
Venezuela y se levanto las montafias de Venezuela. El levantamiento de los Andes
de Merida tuvo su origen durante el proceso de formacion del arco de Panama, ya sea
como resultado del cierre de la Placa Caribe en su limite occidental o por el choque
continente-continente entre Panama y Colombia que fue finalmente impulso el
levantamiento de los Andes de Mérida con orientacion NNO-SSE, lo que implico la
separacion de la Cuenca del Lago de Maracaibo de la Cuenca Barinas-Apure,
generandose cuencas flexurales en ambos flancos de los recién levantados Andes de
Mérida, donde se depositaron sedimentos molasicos que formaron discontinuidades

angulares debido a las constantes pulsaciones.

Lugo (1998), explica que el levantamiento de los Andes de Mérida y la Sierra
de Perija es producto de la colision de los terrenos Baudé y Choco, evento que

ocurri6 desde el Oligoceno y se extendio hasta el Pleistoceno. Ya para el Mioceno y
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hasta el Plioceno Duerto (1998) informa de un levantamiento generalizado que
deformo Perija Sur y Central, generando una zona de despegue en la Formacion
Colon.  Este mismo autor propone un desplazamiento del corrimiento de los
Motilones para el Pleistoceno, lo que posiblemente estuvo acompanado de la
reactivacion de corrimientos anteriores que generaron nuevos fallamientos que

cortaran a los anteriores.

Parnaud et al. (1995) explica que la formacion de la Sierra de Perija y los
Andes de Mérida se correlacionan con la formacion de dos secuencias
depositacionales. Parnaud et al. (1995) explica que durante el Mioceno se inicia una
fase transgresiva en la Cuenca del Lago de Maracaibo donde se deposita la
Formacion La Rosa. A esta fase le siguié un evento regresivo donde se depositaron

formaciones como Lagunilla, La Puerta, Los Ranchos y Betijoque.

Las unidades que componen esta supersecuencia son las siguientes:

» Formacion La Villa

Para el Léxico Estratigrafico III (2008), esta formacion se encuentra
constituida por arcilitas, areniscas de grano fino a medio, mal escogidas, que
localmente pueden ser conglomeraticas, ademas de la presencia ocasional de lutitas
carbondceas y vetas de lignito, mientras que al tope de la unidad reporta la existencia

de capas de conglomerados lateriticos.

Esta formacion en su contacto basal es concordante y transicional con la
Formacion Los Ranchos y hacia el tope es discordante con respecto a la Formacion

Milagros.
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Gonzéalez de Juana et al. (1980) menciona la presencia de foraminiferos
redepositados, difiriendo en ese sentido del Léxico Estratigrafico III (2008) quien

reporta esta formacion sin contenido fosil.

Esta formacion se ubica posiblemente dentro de un ambiente continental y una

edad Mioceno Medio a Superior (ver FIGURA N° 3.3).
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FIGURA N° 3. 3. Ubicacion de las formaciones que conforman el area de estudio dentro de La Sierra de Perija. (Tomado y
modificado de HACKLEY, P., URBANIL F., KARLSEN, A., and GARRITY, C. (2006) Mapa Geoldgico de Venezuela,
Escala: 1:750.000)

75 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO V
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) METODOLOGIA

UNIVERSIDAD CENTRAL DE VENEZUELA

CAPITULO IV

METODOLOGIA

4.1 RECOPILACION BIBLIOGRAFICA Y MATERIAL CARTOGRAFICO

Esta primera fase consistid en la recopilacion bibliografica de textos y trabajos
previos, ademas de la recopilaciéon del material cartografico y de las imagenes
satelitales relacionadas con la zona de estudio. Entre las actividades que

comprendieron esta etapa se encuentran:

»  Recopilacion de trabajos previos, tesis y publicaciones mediante visitas a la
Biblioteca Central y a la Biblioteca Virgil Winkler de la Escuela de Geologia,
Minas y Geofisica (ambas ubicadas dentro de la Universidad Central de
Venezuela); y en el Instituto de Estudios Avanzados (Universidad Simoén

Bolivar).

»  Recopilacion del material cartografico en la sede de la Direccion de Cartografia

Nacional (ubicada en el Centro Simén Bolivar, Caracas).

»  Recopilacion de la imagen satelital a utilizar, la cual se obtuvo de forma gratuita

de internet, en el dominio “Global Land Cover Facility Earth Data Interface”.
4.2 TRABAJO DE OFICINA
Una vez se dio inicio a la recopilacion del material bibliografico y material

cartografico, la primera fase del trabajo de oficina, consistié en el procesamiento,

analisis e interpretacion de la informacion que se fue obteniendo del area de estudio.
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La segunda fase del trabajo de oficina se inicio de manera simultdnea con la
primera fase de la misma y consistio en la revision del material cartografico y
procesamiento de la imagen satelital, para lo cual se siguieron una serie de

procedimientos que se describen a continuacion:

4.2.1 Preparacion de Imégenes Landsat ETM para la Correccion Atmosférica

Las caracteristicas de los diversos tipos de imagenes satelitales van a depender
del tipo de sensor remoto que las origine, de ahi que se debe de realizar el pre-
procesamiento de las imagenes con el objetivo de llevarlas a pardmetros estandar
dentro de cierto rango de valores, que posteriormente permitan obtener una imagen lo
mas real y limpia posible, ademds de permitir la comparacion de estas con imagenes

de diferentes sensores.

4.2.1.1 Calibracién de las Imagenes LANDSAT 7ETM en radiancia mediante la
utilizacion del software ENVI 4.2

La primera fase del pre-procesamiento, consiste en calibrar las imagenes en

radiancia siguiendo los pasos que se describen a continuacion:

1. Abrir el software ENVI 4.2 y seleccionar del menu principal la funcion “Basic
Tools > Preprocessing > Calibration Utilities > LANDSAT TM” (ver
FIGURA 4.1);
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File [Basic Tools | Classification  Transform _Filter Spectral Map Vector Topographic Radar Window Help
Resize Data (Spatial/Spectral)
Subset Data via RO
Rotate/Flip Data

Layer Stacking

Convert Data (BSQ, BIL, EIP)
Stretch Data

Statistics 3
Spatial Statistics 3
Change Detection 3
Measurement Tool

Band Math

Spectral Math

Segmentation Image

Region Of Interest 3
Mosaicking 3

Masking »

Preprocessing » Calibration Utilities » AVHRR

General Purpose Utilities 3 Landsat MS§
Data-Specific Utilities Landsat TM
QuickBird Radiance

FLAASH
ATREM

Flat Field

Log Residuals

IAR Reflectance

Empirical Line »
Thermal Atm Correction

TIMS Radiance

Calculate Emissivity »

FIGURA N° 4. 1. Ventana del menu principal de ENVI 4.2 donde se despliegan las subsiguientes pestafas y se
selecciona la opcion “Landsat TM”.

2. Se abre la ventana “TM Calibration Input File” donde se selecciona la funcion
“Open > New File” (ver FIGURA.4.2);

=R N

Radar  Window Help

] ENVI4.2
File Basic Tools Classification  Transform  Filter Spectral Map Vector Topographic
==

£7) TM Calibration Input File )

Select Input File

File Information

o [cwes [ o | o]

Previous File 3

Mew File...

Spectral Library...
ROI File...
EVF File...

FIGURA N° 4. 2. Ventana “TM Calibration Input File” de donde se despliega “Open > New File”.
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3. Se despliega una nueva ventana en la cual se buscan cada una de las bandas de la
imagen para importarlas al ENVI 4.2, quedando cargadas automaticamente en el
“Select Input File” al ser seleccionadas desde su lugar de origen; dichos

archivos encuentran en formato .TIFF (ver FIGURA 4.3);

] ENvI42 l=]=] 2 |
[[File Basic Tools Classification Transform _Filter Spectral Map Vector Topographic Rader Window _Help |

] ™™ Calibration Input File L]
‘ [ Select input File Il Fils Infomation |
Please Select a File

@'Qﬂ J <« Descomprimidas N - [ |[ Buscar |

Nombre Fechadecaptura  Etiquetas  Tamario -
£ pO081053 7420011004 718 nnbL
pO0H053_7k20011004 718 nn62

Vinculos favaritos
£l Documentos

il Sitios recientes

pO0E053_7p20011004_218 nnB0

W Escritorio  pO08r053_7¢20011004_z18_nn10
F p008r053_7t20011004_z18_nn20
M Equipo

i ! p008r053_7t20011004_218_nn30
[E/ Imagene: p008r053_7t20011004_218_nnd0
B Musica pO08r053_7t20011004_218_nnS0

. p008053_7t20011004 218 nn70

[ Cambiados reciente
B Bisquedas

Ji Acceso publico

Carpetas ~

Nombre: p008-053_720011004_z218_nn10 ¥ :}

FIGURA N° 4. 3. Ventana donde se selecciona el archivo de la banda a importar al ENVI 4.2.

4. Una vez cargado(s) el(los) archivo(s) dentro del “Select Input File” se selecciona

de manera ordenada la banda a calibrar y se hace click en la opcién “OK™ (ver

FIGURA .4.4);

] ENVI42

Select Input File
p008053 7120011004 218 10

Upper Left Comer: 1.1
Description: GEO-TIFF File Imported
into ENVI [Man Dec 10 02:49:24
[2007)

| Spatial Subset [Full Scene ‘

| 0K | Cancel |Plevluus l‘.hmV‘

FIGURA N° 4. 4. Ventana “TM Calibration Input File” con la banda a procesar.
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5. Luego se abre la ventana “TM Calibration Parameters”, donde se colocan los
datos de la banda seleccionada, mientras que en el “Output Result to” se
selecciona el tipo “File” y en el boton “Choose” se busca la ubicacion y nombre
de salida del archivo, para finalmente seleccionar “OK” (ver Fig.4.5). Los datos
de cada una de las bandas y de la imagen en general se encuentran en el archivo

“Metadata” (ver Fig.4.6). Datos como:

0 “Scale Maxy Min” son diferentes para cada banda;

0 “Fecha de Adquisicion, Sun Elevation y LANDSAT Satellite” son los

mismos para todas las bandas.

R = ameoea

|Fi|e Basic Tools  Classification Transform  Filter Spectral Map Vector Topographic Radar Window Help |

=
1] TM Calibration Parameters L]‘

Landsat Satelite ¢ 4 5 % ETM+7

Data Acguistion Maonth: IOctcber vl

Data Acquisition Day :|4 §
Data Acquisition Year :IZ'DD'I g

Sun Elevation (deg) :|60.58

Calibration Type % Radiance (" Reflectance

Scale: Min: |-6.200 Max:|191.6'|}ﬂ

Get Calibration Parameters from Web

Output Resultto % Fle ¢ Memory

Erter Qutput Filename Choose | [~ Compress

I'ﬁ\lmageﬂes_Tmbajadas\ﬂadiance\Had_Ban1 “hdr

‘ QK | Oueuel Cancel ”

FIGURA N° 4. 5. Ventana “TM Calibration Parameters” donde se vacian los datos de la Metadata y se colocan las
especificaciones de salida del archivo.
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o de pagina Referencias Correspondencia Revisar Vista

GROUF=METADATA_FILE
PROI

CREATION_TIME = 2004-02-12T15:14:052

GROUF = ORTHO_FRODUCT_METADATA
SPACECRAFT_ID ="LandsatT"
SENSOR_ID ="ETM
ACQUISITION_DATE = 2001-10-04
WRS_FATH =008
WRE_ROW =053
SCENE_CENTER_LAT=

SUENE LL CORNER_MAFY
SCENE_LR_CORMER_MAF: G853, 000
SCENE_LR_CORNER_MAPY = 1017353.000

11004_z18_nni0.tif"
11004_z18_nn20.tiF"
11004 _z18 rr3{)||f'
11004_z18_nn40.tif"
04_z1E_nnS0.tif"

=1

BANDE_FILE_NAM pO0SI052_Tp20011004_z18_nnBO.tiF"

GROUF=PROJECTION_PARAMETERS
‘REFERENCE_DATUM = '\"10554
REFERENCE_ELLIFSOI 58

GRID_CELL_ORIGIN

UL_GRID_LINE_NUMEE]
UL_GRID_SAMFLE_NUMBER=1

GRID: ELL SIZE] REF— 8,500
FALSE NORTHING
ORIENTATION ="NUP"
RESAMPLING_OFTION ="NN"
MAF_PROJECTION ="UTM"
END_GROUF=PROJECTION_PARAMETERS
GROUF=UTM_FARAMETERS
ZONE_NUMBER =+18
END_GROUF=U PARAMETERS
SUN_AZIMUTH 6860243
SUN_ELEVATION = 60.5843536
QA_FERCENT MISEING_DATA=0
CLOUD_COVER =0
PRODUCT_SAMPLES_PAN = 15445
FRODUCT_LINES_PAN = 14440
PRODUCT_SAMPLES_REF =7723
PRODUCT_LINES REF =TZ20
PRODUCT_SAMPLES_THM = 3862
PRODUCT_LINES_THM =3610
OUTPUT_FORMAT ="GEOTIFF"
END_GROUP = ORTHO_PRODUTT_METADATA
GROUF =L1G_FRODUCT METADATA
BAND_COMBINATION 23456678
CPF_FILE_NAME ="LTCFFZ0011001_20011231_06"
GROUF = MIN_MAX_RADIANCE
LMAX_BAND1 = 151.600
LMIN_BAND1 =-6.200

FIGURA N° 4. 6. Archivo Metadata con los parametros a utilizar resaltados.

4.2.1.2 Generacién del archivo con las 6 bandas calibradas

La segunda fase del pre-procesamiento, consiste en la union de las distintas
bandas calibradas en una sola, mediante la utilizacion del software ENVI 4.2,

siguiendo el procedimiento que se explica a continuacion:

1. Seleccionar del menu principal del ENVI 4.2 la funcion “Basic Tools > Layer
Stacking” (ver Fig.4.7);
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7] ENVI 4.2 (e o e |

Basic Tools | Classification  Transform  Filter  Spectral Map Vector Topographic  Radar  Window Help

Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (BSQ, EIL, BIP)
Stretch Data

Statistics 3
Spatial Statistics 3
Change Detection 4
Measurement Tool

Band Math

Spectral Math

Segmentation Image

Region Of Interest 4
Mosaicking 3
Masking 3
Preprocessing 3

FIGURA N° 4. 7. Ventana del menu principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona la
funcion “Layer Stacking”.

2. Se abre la ventana *“Layer Stacking Parameters”, donde se selecciona “Import
File” (ver Fig.4.8);

ave S ErD)

File Basic Tools Classification  Transform  Filter  Spectral Map Vector Topographic  Radar  Window Help

Selected Files fi Stacking:
iles for Layer Stacking Output Map Projection  New...

Arbitrany
Geographic Lat/Lon

State Plane {NAD 27)
State Plane (NAD 83)
Argentina - Zone 1
Argentina - Zone 2
enting - Zone 3

Datum... | Ic"'“’”e>

Import File... | Reorder Files... | Delete |

Output File Range:

i Units... ||Me¢er5
¢ Inclusive: mnge encompasses all the files

" Exclusive: range encompasses file overap Znnel g *N 5 Set Zone |

Output Resultto @ File ' Memory X Pixel Sizel— Meters
Enter Output Filename Choose | W=l ez
I Resampling W
il Cancel |

FIGURA N° 4. 8. Ventana “Layer Stacking Parameters”.
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3. Se despliega la ventana *“Layer Stacking Input File”, en donde se seleccionan
cada una de las bandas previamente calibradas, comenzando en orden ascendente

desde la banda 10 hasta llegar a la 70 (ver Fig.4.9);

& e 42 =[@] 2 |
| File Basic Tools Classification’ Transform  Filter Spectral Map Vector Topographic Radar Window Help |
] Layer Stacking Parameters |£|
Selected Files Stacking:
Aeslort o Sacing Output Map Projection  New... I
‘ M_IEHEY -~
] Layer Stacking Input File h
Select Input File: File Information:
Rad Banl File: C:\Users"Gerardo‘\Documents' Tesis\Imagen_|
Rad_Ban2 Dims: 7723 x 7220 1 [B50]
Rad_Ban3 Size: [Floating Point] 223,040,240 bytes.
Rad_Band File Type : ENVI Standard
Rad_Ban5 Sensor Type: Unknown
Rad_Ban7 Byte Order : Host (Intel)
Projection : UTM, Zone 18 MNorth
Pixel :28.5 Meters
Datum : WGS5-84
Wavelength : Mone
Upper Left Comer: 1,1
Description: Landsat TM Calibration
Result [Thu Dec 06 02:32:13 2007]

| Spatial Subset |[Full Seene ||Select By [Fie L'_”

| 0K | Cancel ||| Frevious |

Onmvi|

FIGURA N° 4.9. Ventana “Layer Stacking Input File”.

4. En la misma ventana ‘“Layer Stacking Parameters”, en la seccion
correspondiente al “Output Map Projection” se colocan los siguientes datos de la

imagen (ver Fig.4.10):

“Output Map Projection”: UTM
“Datum”: WGS-84

“Units”: Meters

“Zone”: 18 N

“X Pixel Size”: 28.50000000

“Y Pixel Size”: 28.50000000
“Resampling”: Nearest Neighbor

O O O O O o o
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G amoo=s

Selected Files for Layer Stacking L
Rad_Ban1 [Band 1] Output Map Projection New |

Rad_EanZ [Band 1] Arbitrany
Rad_Ban3 [Band 1] i
oret o 11 Geographic Lat/Lon
Rad_Ban5 [Band 1 State Plane (NAD 27)
State Plane (NAD 83)
Argerting - Zone 1
Argentina - Zone 2
entina - Zone 3

Import File... | Reorder Files... I Delete |

Output File Range
. Uriits... IMeters
' Inclusive: range encompasses all the files

" Bxclusive: range encompasses file overlap Zone |18 g N (5 Set Zone...

Output Resultto @ Fle " Memory X Pocel Swze|235|)DDDDDD Meters

Y Pixel 5i IZS.SQDDDDDB Met
Enter Output Filename Choose e e
Resampling |Mearest Meighbor VI

FIGURA N° 4. 10. Ventana “Layer Stacking Input File” con los datos del “Output Map Projection”.

En la misma ventana “Layer Stacking Parameters” se procede a seleccionar
como “Output Result to” el tipo “File” y en el boton “Choose” se busca la
ubicacion y nombre de salida del archivo, para finalmente seleccionar “OK” (ver

Fig.4.11).

ETR mmouss

File Basic Tools Classification  Transform Filter Spectral Map Vector Topographic Radar Window Help

Selected Files for Layer Stacking:
Rad_Ean1 [Band 1]
Rad_EanZ [Band 1]
Rad_Ean3 [Band 1]
| [Band 1]
Rad_Ban5 [Band 1

Argentina - Zone 2
enting - Zone 3

Import File... | Reorder Files.. | Delete |

Output File Range:

& Inclusive: range encompasses all the files

" Exclusive: range encompasses file overap Zonelw g &N 5 Set Zone..

Output Resultto & Fle ¢ Memary X Pixel Size IZBEDDDDDDD Meters

Y Pixel Si |23 50000000 Mets
Enter Output Filename Choose e e
L Trabajadas"Radiance\Rad_Band1-7 hd
Imaganes_ rabaEcas enee —-=an i Resampling |Nearest Meighbor

OK | Cancel

FIGURA N° 4. 11. Ventana “Layer Stacking Input File” con los nuevos parametros.
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4.2.1.3 Transformacion del archivo de la unién de las bandas calibradas a
formato BIL

La tercera fase del pre-procesamiento de las imagenes consiste en convertir el
formato de salida BSQ, en que se encuentra la unién de las bandas, a un formato BIL,
el cual permitird aplicar varias de las tareas del procesamiento de la imagen. El
procesamiento para convertir a BIL se realiza en el software ENVI y tiene los

siguientes pasos:

1. Seleccionar del menu principal del ENVI 4.2 la funcioén “Basic Tools > Convert
Data (BSQ, BIL, BIP)” (ver Fig.4.12);

File | Basic Tools | Classification Transform  Filter  Spectral Map Vector Topographic Radar Window Help

Resize Data (Spatial/Spectral]
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (BS(Q, BIL, BIP)

Stretch Data

Statistics 2
Spatial Statistics 3
Change Detection 3

Measurement Tool

Band Math
Spectral Math

Segmentatien Image

Region Of Interest 3
Meosaicking 3
Masking 3
Preprocessing 3

FIGURA N° 4. 12. Ventana del ment principal de ENVI 4.2 donde se despliega la subsiguiente pestana.

2. Se despliega la ventana “Convert File Input File”, donde se selecciona la imagen

que contiene la union de las bandas calibradas y se presiona “OK” (ver Fig.4.13);
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ETE oamooes
File Basic Tools Classification Transform  Filker  Spectral Map Vector Topographic Radar Window Help

—
B] Convert File Input File =]

Select Input File: File Information:

File: C:\Users\Gerardo.Documents* Tesis'Imagen_|
Dims: 7723x 7220 x 6 [BSQ]
Size: [Floating Point] 1,338,241 440 bytes.
File Type : ENVI Standard
Sensor Type: Unknown
Byte Order : Host (Intel)
Projection : UTM, Zone 18 Morth
Poesl : 28.5 Meters
Datum  : WES-84
Wavelength : None
Upper Left Comer: 1.1
Description: Create Layer File
Result [Thu Dec 06 03:25:56 2007]

‘ Spatial Subset ||F|.|II Scene
‘ Spectral Subset IIG."'G Bands

‘ QK | Cancel |H Previousl (hmvu

FIGURA N° 4. 13. Ventana “Convert File Input File” donde se selecciona la union de las bandas.

3. Se abre la ventana “Convert File Parameters” y en ella se selecciona BIL como
“Output Interleave”, colocando NO en el “Convert In Place”, para
posteriormente seleccionar como “Output Result to” el tipo “File” y en el boton
“Choose” se busca la ubicacion y nombre de salida del archivo, para finalmente

seleccionar “OK” (ver Fig.4.14).

e = ]
File Basic Tools Classification Transform Filter Spectral Map Vector Topographic Radar Window Help

—
1] Convert File Parameters L[

Input Intedeave: BSQ

Output Intedeave: ™ BIL BIP

Convert In Place ?INo ﬂ
Enter Output Filename Choose |

IB\Imagenes_Tmbajadas\E IL\Rad_Band1-7BIL hdr

| OK | Queuel Cancel ”

FIGURA N° 4. 14. Ventana “Convert File Parameters” con los datos de salida del archivo BIL.
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4.2.2 Correccion Atmosférica de la Imagen LANDSAT 7

Una vez llevada la imagen a un formato adecuado para su procesamiento, el
siguiente paso es realizar la correccion atmosférica de la imagen. Este proceso se
realiza en el software ENVI, utilizando el comando FLAASH, el cual sera el
encargado de corregir la presencia de vapor de agua, oxigeno, dioxido de carbono,

metano y ozono en la atmoésfera, siguiendo los siguientes pasos:

1. Seleccionar del menu principal del ENVI 4.2 la funcion “Basic Tools >
Preprocessing > Calibration Utilities > FLAASH” (ver FIGURA 4.15);

Basic Tools | Classification Transform Filter Spectral Map Vector Topographic Radar Window Help

Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (BSQ, BIL, BIF)
Stretch Data

Statistics »
Spatial Statistics »
Change Detection 3
Measurement Tool

Band Math

Spectral Math

Segmentation Image

Region Of Interest »

Meosaicking »

Masking »

Preprocessing » Calibration Utilities 3 AVHRR
General Purpose Utilities 4 Landsat M55
Data-Specific Utilities 3 Landsat TM

QuickBird Radiance

FLAASH
ATREM

Flat Field

Log Residuals

IAR Reflectance

Empirical Line 3

Thermal Atm Correction
TIMS Radiance

Calculate Emissivity 3

FIGURA N° 4. 15. Ventana del ment principal de ENVI 4.2 donde se despliegan las subsiguientes pestaias y se selecciona
la funcion “FLAASH”.
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2. Se despliega la ventana “Flaash Atmospheric Correction Model

Parameters”, donde se abren los siguientes campos:

Input

0 “Input Radiance Image”: al seleccionar este campo se abre la ventana

“FLAASH

Input File”, de

donde se

selecciona el archivo BIL

correspondiente a la unidon de las bandas y se presiona el botén “OK” (ver

FIGURA 4.16);

] Envi 42

|Fi|e Basic Tools  Classification’ Transform  Filter Spectral Map Vector Topographic Radar Window Help

|

] FLAASH Atmospheric Correction Model Input Parameters |Ml
Input Radiance Image "
Output Reflectance File "C:\Users\Gemrdo\
Output ] ] FLAASH Input File [

Rootnam

Scene C

oy
Lon [0

HAmosphii
Water Ry |

Water A}

Select Input File:

Rad_Band1-7BIL

File Information:

File: C:\Users'\Gerardo Documents' Tesis Imagen_|
Dims: 7723x 7220 6 [BIL]
Size: [Floating Point] 1,338,241 440 bytes.
File Type : ENVI Standard
Sensor Type: Unknown
Byte Order : Host (Intel)
Projection : UTM, Zone 18 North
Pixel :28.5 Meters
Datum :WGS-34
Wavelength : None
Upper Left Comer: 1,1
Description: Create Layer File
Result [Thu Dec 06 03:25:56 2007]
[Thu Dec 06 03:36:222007]

‘ Spatil Subset |[FulSoene ‘

‘ oK | Cancel |

Frewvious |H (hm'”

FIGURA N° 4. 16. Ventana “FLAASH Input File” del comando “Input Radiance Image” perteneciente a la ventana
“FLAASH Atmospheric Correction Model Input Parameters”.

0 Seguidamente se abre la ventana “Enter ASCII Filename containing

wavelengths and fwhn”, donde se selecciona el archivo llamado ondas (el

cual ha tenido que ser creado previamente y debe de contener el promedio

de las longitudes de onda para cada banda) (ver FIGURA 4.17);
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@ eviaz Ele %]
| File Basic Tools Classification Transform  Filter Spectral Map Vector Topographic Radar Window Help ‘
@ FLAASH Atmospheric Correction Model Input Parameters |ﬂ"
Input Radiance Image ||
0 o | Fa) .
“ Enter ASCI Filename containing wavelengths and fwhm | 3
- - - -
@Uv‘ ) €:-Ts|s + Imagen_Perija_0853 » [ ¢ || Buscar Pl E

| =

E Vincilos Favoitos Numb’re Fecha med.. Tipo Tamafio Etiquetas
[E Documentos i Compriidas
& || Descomprimidas
1| Sitios recientes 3
| Imagenes_Trabajadas
B Escritorio @Metadata
18 Equipo _ |Ondas
| [ Imigenes —
| B Musica
[ Cambiados reciente...
| BB Busquedas
o[ J& Acceso piblico
K| .
‘——|| Carpetas ~
Nombre:  Ondas v | o

FIGURA N° 4. 17. Ventana “Enter ASCII Filename containing wavelengths and fwhn” del comando “Input Radiance
Image” perteneciente a la ventana “FLAASH Atmospheric Correction Model Input Parameters”.

0 Al momento en que se acepta el archivo se abre la ventana “Input ASCII

File” y se presiona “OK”, dejando todos los valores sin modificar (ver
FIGURA 4.18);

€] eviaz2 (=[] = ]
[ File Basic Tools Classification Transform _Filter Spectral Map Vector Topographic Radar Window Help |
S
] FLAASH Atmospheric Correction Model Input Parameters =@ & |
Input Radiance mags ||

Output Reflectance File [[C\Users'Gerardo'.

Output Directory for FLAASH s, |[CAUsers'\Gerardo's
Rostrame for FLAASH Fies | | Bl A RE

npt Fle: C-\User=\Gerardo\Documentz\Tesis\ima ~
Columns: 1. Rows: & r
0485

Scene Center Location DD <> ,‘
3 <] o005
Lat [0 o [omw o LA -
165 (HH:MM:SS}
e T | — = h e
Wavelength Column |1

Muttiply Factor ~ |1.000000
Atmospheric Modsl | Tropical al Polishing |Yes ﬂ
Wavelength Urits [mioon =

umber of bands) [3

Water Retrieval IE‘ _;ﬂ

N
Water Absorption Feature: [11354)| | 2K _| Cancd i Recalibration Mo 41|

Apply | Cancel | Help Hyperspectral Settings... || Advanced Settings... | Save... | Restore... |

FIGURA N° 4. 18. Ventana “Input ASCII File” del comando “Input Radiance Image” perteneciente a la ventana
“FLAASH Atmospheric Correction Model Input Parameters”.
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0 Luego se activa la ventana llamada “Radiance Scale Factors” donde se
selecciona la opcion “Use single scale factor for all bands” y en el
parametro “Single scale factor” se coloca como valor 10 y se presiona

“OK?” (ver FIGURA 4.19);

Fide Basic Tocks Classificstion  Transform  Fiter Spectral Map Vector Topographic Radar Window Help

[m ENVIAZ @ 8 ]

FLAASH Atmospheric Comectian Model Input Pacameters =8 8

rons Fadarce inage || — -
Output Fesinctance Fie [\ Livery Gerarda',
FLAASH Fles |[C

Fuoctrume for FLASH Fine [ @] Radisnce Scale Factors ==

R vy of mcse Enctors {1 paw bawd] bom ASCH e
O [Linn ingle scale factor for o bande| :l 200 =

Sngle acale facter|1 00000 M 55)
| oK | cancel || F

I.mm Trepical =] Aemsnt Mo [ 7] et P [Yes 41|

Water Retneval [Yer 41 Aersec Fnsserenl [t (7] = Wit be of banda [§
Water Absorption Froturs (1136 rem = Intial Visbliy fom) [2050 wm.mlﬂTﬂ
|:~m|r--4|H¢: [ omespocts Settrgs || dvarced Setigs | Save | stre I:Z

FIGURA N° 4. 19. Ventana “Radiance Scale Factors” del comando “Input Radiance Image” perteneciente a la ventana
“FLAASH Atmospheric Correction Model Input Parameters”.

0 *“Output Reflectance File”: al seleccionar este campo se coloca el nombre
de salida del archivo, que en este caso sera Reflectance (ver FIGURA.4.20);
“Output Directory for Flaash File”: al seleccionar este campo se le da

ubicacion al archivo recién creado (ver FIGURA 4.20);

[ Irpns Rasdance image F.‘-Lhui\duuﬂo\ﬂm-mu\lm\hm Pecs_085Tmagenes_Trabajodas BIL'\Rad_Band1-7BIL
Outpnt e Perja_D557 magenes_Trabaisdas Fefectance Fefiectance 550 har
Output Dimctory for FLAASH Fles [[C-Uary\Garards\Diocuments' Tesa\Imagen_Perya_DSST Imagenes_Trabajadas' Fefiectance’.
Fockinarms for FLAASH Fiea

Scene Corter Location DD <3 DMS | Sersce Typm prga| Pt Dee
—_—T

wfp [ pw Serwcr Mutute fm) 0000 o= [ =] P02
wf e Ground Bevater b 0003 [Foght Time GMT §HH MM.55)

i 2:fp 2 3
Pl Size b} 28500 ,_[_[_
Hmaspherc Model [Trorcal v]  Aerosd Moded [Rural -
W“WI"Tﬂl Aaroscl Retneval [20and (T =]
Water Cokumn Mligher 100 & el Viskalty i) [40.00

FIGURA N° 4. 20. Ventana “FLAASH Atmospheric Correction Model Input Parameters™ con los parametros “Output
Reflectance File” y “Output Directory for Flaash File” completados.
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3. Posteriormente en la misma ventana “FLAASH Atmospheric Correction Model
Input Parameters” se rellenan los datos correspondientes al momento de la
generacion de la imagen , algunos tales como datos del vuelo, coordenadas de
Longitud y Latitud se encuentran en la “Metadata” (ver FIGURA 4.21 y
FIGURA .4.22);

G TR W o]

|H‘e Basic Tools Classification Transform  Filter Spectral Map Vector Topographic  Radar  Window Help ]

Input Radiance Image |C “\Users'Gerando\Documents' Tesis\Imagen_Penija_0853\Imagenes_Trabajadas‘\BIL\Rad_Band1-7BIL
Output Reflectance File Iseantl\Ducuﬂerl:\Tesi5"-.|magen_Paia_O%Eﬂ\lmageﬂes_TlabaJadas"ﬂeﬂedace'ﬂeﬂedaﬂceoﬂﬁlhd
Output Directory for FLAASH Files I|C:\Usus\Gerarﬂo\Doamems\Tcsls‘-Jmagen_Peqa_O&SS‘-' _Trabajadas'\Refh

Rootname for FLAASH Fles |

Scene Certer Location DD <-> DMS | Sensor Type UNKNOWN-MSIl Fight Date

[oa =] 2001 &
Lat [+10.112259 Seror Alitude fan)  [0.000 oa =] 4 =] =

Flight Time GMT (HH MM 55)
Lon [73.2762781 Ground Blevation (km) [0.000
i5efdals &
Paxsl Size m) 28500

Atmospheric Model | Tropical - Aerosol Model | Rural -
Water Retreval [No 41 Aerosol Retreval [2:Band (KT) =

Water Column Muttiplier [1.00 2 Initial Visibiity fm) [40.00

Boply | Cancel | Heb | | Mukispectral Selfings. . ||| Advarced Settings... | Save.. | Restore... ||

FIGURA N° 4. 21. Ventana “FLAASH Atmospheric Correction Model Input Parameters” con los parametros de la
generacion de la imagen completos.

Metadata - Microsoft Word

Fio de pagina Referencias Correspondendia Revisar Vista

GROUP = METADATA_FILE

PRODUCT_CREATION_TIME = 2004-02-12T15:14:05Z

PRODUCT_FILE_SIZE = 558.9

STATION_ID ="EDC"

GROUND_STATION ="EDC"

GROUP = ORTHO_PRODUCT_METADATA
SPACECRAFT_ID = "Landsat7"
SENSOR_ID = "ETM+"
ACQUISITION_DATE = 2001-10-04
WRS_PATH =008
WRS_ROW =053
SCENE_CENTER_LAT = +10.1129259
SCENE_CENTER_LON = -73.2762781

FIGURA N° 4. 22. Archivo “Metadata” con los parametros a utilizar en la ventana “FLAASH Atmospheric Correction
Model Input Parameters” resaltados.
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Otros datos como los que se enumeran a continuacion son propios del tipo
de sensor e imagen que se este utilizando. Todos esos datos se colocan en los
espacios correspondientes dentro de la misma ventana “FLAASH Atmospheric

Correction Model Input Parameters” (ver FIGURA 4.23):

0 “Sensor Type > Multispectral >LANDSAT TM7”
0 “Sensor Altitud (Km)”: 705000

0 “Graund Elevation (Km)”: 1,2

0 “Pixel Size (m)”: 30

o . W B

|FMe Basic Tools  Classification  Transform Filter  Spectral Map Vector Topographic  Radar  Window Help ‘
= = —_—

Output Reflectance File Iiemrdu\Documems\Tesis\\magen_F‘erij3_0853\Imagenes_Tlabajadas\Reﬂedance\ReﬂedanceﬂBSB hdr

Output Directory for FLAASH Files IC “Users"Gerardo\Documents' Tesis'Imagen_Perija_|

Footname for FLAASH Files |

ASTER

p od p
Input Radiance Image IC “\Users\Gerardo*\Documents' Tesis\Imagen_Perija_0853\Imagenes_Trabajadas\BIL"\Rad_Band1-7BIL
N

AVHRR-7

AVHRR-8
AVHRR-2

Lat [+10.1123259 Sensor Alttud Hyperspectral D AVHRR-10
Multispectral >

AVHRR-11
Lon |-73.2762781 Ground Bl T

15 § AVHRR-12
Pixel Size {m) IW AVHRR-14

e |

Scene Certer Location DD <> DMS |  Sensor Type | UNKNOWN-ms 119 D3

Atmospheric Model | Tropical |  Aerosol Mode! |Rural - AVHRR-16

AVHRR-17

Water Retrieval |No l_tl Aerosol Retrieval |2-Band (K-T) v

IKONOS
Water Column Muttiplier | 1.00 g Initial Visibility m) [40.00

IRS LISSI

===
ce

Landsat TM4
Landsat TM5
Landsat TM7

Landsat M554
Landsat MS55

MODIS
SeaWiFS

SPOT1
SPOT4
SPOTS

FIGURA N° 4. 23. Ventana “FLAASH Atmospheric Correction Model Input Parameters” con la seleccion del tipo de
sensor que proporciono la imagen.

4. Se selecciona la opcion “Multispectral Settings”, abriéndose la ventana con el

mismo nombre y se escoge la opcion GUI en “Select Channel Definitions by” y
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a continuacion se selecciona la pestaiia “Kaufman-Tanre Aerosol Retrieval”

donde se rellenan los siguientes campos:

R/

% “KT Upper Channel”: Banda 70

7

< “KT Lower Channel”: Banda 30

Los demas datos quedan iguales y se hace click en “OK” (ver FIGURA 4.24);

GRS E 2 oamoo=s
File Basic Tools Classification  Transform  Filter  Spectral Map  Vector Topographic Radar Window  Help

— - —eeaa
&) FLAASH Atmospheric Correction Model Input Parameters =lE] ® ]

Input Radiance Image |IC:\Users\Gemrdo\Documents\Tesis\lmagen_F‘eﬁja_ﬂBSS\lmagenes_Tlabajadas\BIL\Had_Band1-TBIL
COutput Reflectance File |IC:\Usefs\Gemrdo\Documents\Tesis\lrnagen_F‘eﬁja_DRS.?\Imagenes_TlElbajadas\Heﬂedance\Heﬂedan:

Output Directory for FLAASH Files ||C:\Users\Gerclrdo\Documents\Tesis\lmagen_F'erija_DEEﬂ\Imagenes_Tmbajadas\Heﬂedance\

Rootname for FLAASH Files I

Scene Center Location DD <> DMS | Sensor Type  Landsat TMT | Flight Date

- - IZDD1 g
Lat |1D.11292553 Sensor Altitude {kkm) I?D&.DDD IOd —I I‘i —I

Lon [B276278E] mutspectral settne: D ==]

Select Channel Defintions by ¢~ File GUI

Aemospheric Mol Water Retrieval  Kaufman-Tanre Aerosol Retrieval |

Aszsign Default Values Based on Retrieval Conditions  Defaults-= |

Wiater Hetrieyal

Water Column
KT Upper Channel ILayer (TM Cal (Band 1:p008r053_A20011004_z18_nn7... ;I
Aoy | Cance KT LowerCharnel  |Layer (TM Cal (Band 1p008r053_720011004_218_nn3... = |

Maximum Upper Channel Reflectance |0.10 Reflectance Ratio ID.-!& g

Cimuz Channel (optional) IUndeﬁned ;I

Fitter Function File | IC:\HSI\IDLGZ‘qududs\envi-iZ\ﬂlt_func\tm.sli
Index to first band I‘IZ g

‘ oK |CanceI|Hﬂ”

FIGURA N° 4. 24. Ventana “Multispectral Settings” con todas las modificaciones realizadas.
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5. Se abre nuevamente la ventana “FLAASH Atmospheric Correction Model Input
Parameters” vy se selecciona la opcion “Apply” (ver FIGURA 4.25).

] ENvT 4.2 A N =lE] = |
‘F\Ie Basic Tools Classification  Transform  Filter  Spectral Map Vector Topographic Radar Window Help |
s

7] FLAASH Atmospheric Correction Model

Input Radiance Image |IC'\USers\Gemrdn\Dncuments\TesAs\lmagen_F'erija_ﬂRSB\lmagenes_TlabaJadas\E\L\Had_Eand'l-?ElL

Output Reflectance File IIC'\Llsers\Gerﬁrdn\Dncumen(s\Tesws\Imagan_Penja_ﬂESB\\magenes_Tmhajadas\Reﬂedance\Reﬂedant

Output Directory for FLAASH Files ||C:\UsErs\Gamrdo\Documents\Tesls\\magen_PenJa_DS&?:\Imagenes_Tmba]adas\ReﬂectancE\

Rootname for FLAASH Files I

Scene Center Location DD <> DMS | Sensor Type  Landsat TM7 Flight Date
ot ~| [4 -] |2007
Lat |10.11292553 Sensor Altitude (km) |7D5.Dﬂﬂ lj

Flight Time GMT {HH:MM:55)
Lon |-73.27627563 Ground Blevation (km) IT 2

15 o[z 2fe
hsew T [5efiesf g

Atmospheric Model | Tropical VI Aerosol Mode! |Rural -
Water Retrieval [No 1_1" Aerosol Retrieval IZ—Eand KTy vI

Water Column Multiplier |1.00 § Initial Visibility fkm) |40.00

Apply | Cancel | Help ‘ Multispectral Settings.. ||| Advanced Settings | Save.. | Restore... I|

FIGURA N° 4. 25. Ventana “FLAASH Atmospheric Correction Model Input Parameters” con todos los parametros
completamente llenos.

4.2.3 Procesamiento Hiperespectral de Imagenes LANDSAT 7 mediante la
utilizacion del Software ENVI 4.2

Concluido el proceso de correccion atmosférica y como preambulo al
procesamiento hiperespectral de las imagenes se genera un archivo de tipo Shapefile
en el software ArcGis, donde se vectorizan las nubes y sus respectivas sombras con el

objetivo de minimizar la incidencia de estas en la imagen.
4.2.3.1 Generacion de archivos shapefile
El procedimiento que se describe a continuacidn, es el que se sigue para

generar los archivos shapefile, los cuales seran de mucha utilidad para representar

todos los rasgos geologicos reconocidos dentro del area de trabajo de la imagen.
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1. Del ment principal del software ArcGis 9.1 se selecciona la funcion “ArcCatalog
ArcView” (ver FIGURA 4.26);

[ s
o et ot [ e
DEEa + 2EP o[- > - z
fomsunary » aaunzne voms
) -]
P = !
peeas k|07 A0 ldm O e AT e

ST A e ks

FIGURA N° 4. 26. Ventana “ArcMap-ArcView” donde se resalta dentro de un circulo rojo en el menu de herramientas la
opcion “ArcCatalog”.

2. Una vez desplegada la ventana del “ArcCatalog — Arc View”, dentro de su
explorador se ubica la carpeta donde se guardara el nuevo archivo shapefile.
Colocandose sobre esa carpeta, se hace click al boton derecho del mouse con lo
que se despliega una pestaiia donde se selecciona “New > Shapefile...” (ver

FIGURA 4.27);

soresiVeciorizacion

Conterts | Previewe | Metadeta |
s
Camapas

Shapef [
e B copy cwhc
¥ pointe
Rename  F2
2 mefresh |
0 e
B seach.. ) gersonal Geodatabise:
[ Fropetties.,, <O bver
E— L YT
o T
@ Toobox
[E) gonse Table

Crsates & new shapsfie

FIGURA N° 4. 27. Ventana “ArcMap-ArcView” donde se selecciona la opcion “Shapefile” para generar los archivos de
este tipo.
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3. Se despliega la ventana “Create New Shapefile”, colocando en los campos
“Name” el nombre del archivo y en “Feature Type” el tipo de simbolo con el que

se delineara. Una vez completados estos campos se hace click en “Edit” (ver

FIGURA 4.28);

3 ArcCatalog - ArcYiow - C:\Documents and SattingsWsuarioWis documentos\losis Sansorus\Wactarizacion
Fio Edt Yaw Go Tods Wrdow bek

B RREX L EmR A QRO |V |(@@ @0 |H

Location:  [CY0 i |

Styiashest: B &3

Cortemis | Preview | Metaasts |
Daress

Cittapss

e
D hapefie
Fealure Type Pt <]

Fonl
Spatia Reference —|Pokine

Descrplion: Ml Port
(lPaich

I tom

[ Cosdnates wil contain M values. Used to stare oufe dala.
™ Comdinates wil contain 2 vahaes. Used to sio 30 data

o

Crastes a naw shapsile

FIGURA N° 4. 28. Ventana “Create New Shapefile” con la seleccion de la “Spatial Reference” y encerrado en un circulo
rojo la opcién “Edit”.

4. Se despliega la ventana “Propiedades de Spatial Reference” y se hace click en el

boton “Select” (ver FIGURA 4.29);

- ecCatalos, - ArcYlow - C:\locuments and Sottings\Usuaria Wi documenos\tesis SensoresiVec torizacion
Ele Edi Yo Go Jeok Window pelo
oW e X

Locatior:

® 0 ®

- 4
Corkents | Proview | Metadats |
s :
IMapas Details:
shapafie

Styeshaet

Yetect 2 predefned codrate system

Inpcst @ cocrdnete sysiem and 547 2 and M
Trpot domaina fiom an eczing geodatasel (5.0
festure dataset, eature class, taster]

New. =|  Creats anew cooinate system.
Edk the propsite: of the cunenty selected.
cooidnate ytem
Sots the coordnale system 1o inkrown.
Save the eocdinale system 0 4 fle

e | o]

Creates anew shapefie

FIGURA N° 4. 29. Ventana “Propiedades de Spatial Reference” donde se hace click en el boton “Select”.
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5. Seguidamente se abre la ventana “Browse for Cordinate System”, se selecciona

la opcion “Projected Coordinate Systems” y se hace click en “Add” (ver
FIGURA 4.30);

O G Pew G Jock Yndee el
nah P LEER A @D W A8 80X
Lacaon [ [

T 7

Siwiant [ 4
Carteres | o | Mtniat |

T

e

shapniie

ermese do1 Cantdinate Syeire =

i G =) ] el Bl

S secirihic Coordnate Syt

| e coumiiate e b Ly

| S e i sy 2

_towis | Cown | v |

Craatad o i gl

FIGURA N° 4. 30. Ventana “Browse for Coordinate System” donde se selecciona la opcion “Proyected Coordinate
Systems” y resaltado en rojo el boton “Add”.

6. Se muestran en la misma ventana los diferentes sistemas de proyeccion de

coordenadas y de estos se elige el “UTM” y se hace click en “Add” (ver FIGURA
4.31);

) ArcCatalog - ArcView - C:\ocuments and mnpwuurl-_\uh documentos tesis S-un_nl\'wnln-'nn
Ele Edt Wew Go Joos Window Help

. am REX sEESAAae0 N a4 @ 0 %]

Corveres | Previom | Metocaia |
e
B Datsis
Dishapefie

Mame: [T Add
Shawoltype.  [Spaial efererces B Careel

St the coudinals setsm o Unknown,

Savethe coodnate system o a file
_poopin | Coosa | e |

Crestes new shepehe.

FIGURA N° 4. 31. Ventana “Browse for Coordinate System” donde se selecciona la opcion “UTM” y resaltado en rojo
el boton “Add”.
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7. Dentro del sistema UTM se escoge el “Wgs 1984” y se hace click en “Add” (ver
FIGURA 4.32);

2 ArcCatalog - ArcView - C:\Documents and Settings\suario\ldis documsntos\esis Sensores\Vactorizacion

Fie Edt Yew Go Tecls Window Hel

Name s 1584 add |
Show o ype: [ Spatial references Eal Cancel

Sels the cocrdnete system fo Unknorn.
Save the cocrdinate syatem 10 a F

Aneptar Cancelar i

Crestes & new shapefiie

FIGURA N° 4. 32. Ventana “Browse for Coordinate System” donde se selecciona la opcion “Wgs 1984” y resaltado en
rojo el boton “Add”.

8. Posteriormente se selecciona el huso que le corresponda a la zona de trabajo y se

hace click en “Add” (ver FIGURA 4.33);

Y ArcCatalog - Arc¥iew - C:\ocuments and SettingsWsuarioWiis documentos\esis SensoresWeelorizacian

fle Edt View Go Took Window Help

Syestwec [FobiESR 2] of

Cocedinate System \

Conteris | Preview | Metadsta | N [

Carcas

Datapes i

Cashapefile Browse for inate System &
Lookin: [0 was 1384 | & 2le|m] & =)ee
59 WG 1984 UTH Zone 135 pri- e
T WS 1984 UTM Zone 14h.pri WS 1984 UTM Zone 185,51 Bwes
(Erws 1354 UTM Zone 195, prf (WS 1984 UTM Zane 190 pr) Bwes
(w5 L35+ UTM Zore 15M.pr (wGS 1984 UTM Zone 195.1) Bwes
8 WGS 1984 UTM Zooe 155.prj WS 1984 UTM Zone 1N.orj @wes
() W65 L984 UTH Zone 16M.gri (WS 1984 UTM Zone 15,5 Bwas
{3 WGS 1984 UTM Zone 165 61} (TS 1984 UTM Zane 20N g Bwes
(1 ws5 L5+ UTH Zore 1710pr (TS 1984 UTM Zone 205.51) Bwes
8 wGs 1984 UTM Zone 175.pr @ wss 1984 UTM Zone 21 pr Bwes
£ | L]
Name [wB5 1984 UTM Zone 1M p Add
Show of ype:  [Spatial eferences ~ Lcai[

Sets the cocrdinate system to Linknown.
il Save the conidnale system |0 2 e
Acepls Cancels o
Creates anew shapefile

FIGURA N° 4. 33. Ventana “Browse for Coordinate System” donde se selecciona la opcion “WGS 1984 y resaltado en
rojo el boton “Add”.
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9. Nuevamente se despliega la ventana “Propiedades de Spatial Reference” y en el
cuadro “Details” se verifica que estén correctos los datos del huso seleccionado
en el paso anterior. Una vez verificado estos datos se hace click en el boton

“Aceptar” (ver FIGURA 4.34);

3 ArcCatalog - ArcView. - C:\Ducumants and SottingsWsuarioVis documonteskiesis Sensores\Wactorizacion
Be E& Yow Go Tock Widow e

=8 REX LEER L AOR €@ "9 0 =

Sylesheet  [Tooin o] A % | Coudnate System |

Name:  WGS_1984_UTM_Zoe_16N

e Oslaks

\Abbreviaion:

[Flemks:
[Profecton: Transverse_ Mercator
Parameser:

(Geopapine Cooudrsie Spsem:

Fiome: GCS W5 1384 @

h.pmmm
Inpot 3 condinae ytam snd XY, Z snaM

domai from an e e

Toahan cataso. foakrm clrs, (rierl

Nom | Crea a v comdinate e

E the propetis of the curerily selecled
Mod, coonnate ystem
o Seltsthe coodnaie tpstem 0 Urknonn

Saveds | Savethe coodnate syetem lo afis.
Aceptar Cancely Aghcar

Import

Creates a new shapefie

FIGURA N° 4. 34. Ventana “Propiedades de Spatial Reference” donde se hace click en el boton “Aceptar”.

10. Se abre la ventana “Create New Shapefile” y se hace click en “OK” (ver
FIGURA 4.35);

3 ArCatabng - e ¥iew . Cimemnents ga Settings Lot decimaninstesi Semprmvestoricoenn |~ & X]

B G Yew Go Inok W bep

“ B RPX LEAR QA QOO M a4 & 0 #
localen: [T 0 =l
L )

it | o | Mot

Camate Mew Shapeiile

e Hlamar [Mutcun

i shapehie e
Fastion Typm [ =

Spal Rarererce

Deicagton

e Comie S
N WHIS_1904_LITM_Zore,_ 1IN

Grepaphe: Coondnane Symem
Marme: GL5_WGS,_ 1534

F S

I Comdrumes sl cantan b valmt. Lsed 9 sioey rous duta.
™ Coumtnstes vl conton 2 vk Used 1o stoe 30 data.

C o Do |

Crmate a to shiagmie

FIGURA N° 4. 35. Ventana “Create New Shapefile” donde se hace click al boton “OK”.
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11. Seguidamente se regresa a la ventana principal del ArcGis 9.1 y de su menu se

selecciona “File > + Add Data” (ver FIGURA 4.36);

= Sim tituls - Arclap - ArcVies:

e bt pew et gelemon jods wrdow bee

D e, anh | =] r Ol
S = el |t eeaw|
Lo o ot =] &
Save A Crow.
+ I —
D Fram It v
L} Page and Prnt Setup.
[ Pt Pregess...
B g
B e Properties...
R ——
ot Mg,
T T L ——
ZOIAL AP KA BG5S
[ e
gy [ | Soion] | | w4 o
e L] O~ A~ ree Sl = ms oy A me e -

Ackd reve ot e s acties ot frame I 119,69 Urbrowe Unka

FIGURA N° 4. 36. Ventana “ArcMap-ArcView” donde se selecciona de su ment principal la opcion “File > Add Data..”.

12. Se selecciona la imagen reflectance (previamente transformado su formato de
salida a .img) y el archivo shapefile. Una vez abiertos los archivos, se hace zoom
en el area a trabajar y se activa el ment de la funcion “Editor > Star Editing”

(ver FIGURA 4.37);

* Sin titulo - Arcap - ArcView

Fle Edt Yew [nsest Selecton Toos Window Mep

Edtor ¥ - - -

@ - - & 1555 <] &GO N || gy - | Lom et o] (O 4D

@

@

= ..

=

L]

-

=

More Edtng Tooks *

o

]

&

S99697,04 1291180,6% Meters

FIGURA N° 4. 37. Ventana “ArcMap” donde se observa desplegado el ment de la funcion “Editor” y la opcion “Star
Editing” seleccionada.
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13. Del menu de “Editor” se selecciona la funcion *“Sketch Tool” y colocando el
puntero sobre el rasgo se hace click consecutivamente sobre el mismo para
delinearlo (ver FIGURA 4.38). Una vez terminado el delineado se hace doble
click para cerrar la linea y se selecciona del ment de herramientas la opcion

“Editor > Save Editing” (ver FIGURA 4.39);

*= Sin titulo - Arcap - ArcYiew

Ele Edt Yew Insent Selecton Teok Window bel

Edkor ¥ Task: [Creats tew Featurs =] | Target: [Mascara R e ol BN - B t - = .
DERETRBX » &6 -2 &S0 W ~ | Lrer [elecincaiSnimg =] O~ @
B
= B Mascara @
i) Q
= B reflectanciaBS3uneing |
s A
MlRed: Layer 1 o
I Green: Layer 2 ﬂ
MM Be: Layer 3
@
-
=
L
k
°
#
=3

Displey | Source [ Selecton @0 =g
Draving > Rt I Ox A~ o ol o=l B s ulAy &y Ly 2~

Numbee of Features selactad: 1 Lengeh 45,669, Direction: 66,5560 766635,95 1101725, 32 Metars.

FIGURA N° 4. 38. Ventana “ArcMap” donde se observa encerrado en un circulo rojo la funcion “Sketch Tool” y en la
imagen la secuencia de puntos que en este caso representan el cauce de uno de los drenajes.

= Sin liluly - ArcMap - Arc¥iew

Fie Edt e [sert Selection Tools Window el
Edtor > | b | @ 7 Task [creste New Feature x| | Target: [Drensie =1 . mE| @@ W * [ o=l
! X | = & ([T16040 ERNAROE =% - | L Bl A=

Mors Edting Tooks »

“PEOFXFBILOZIUNLS

SnEOpIng. .,
Optiors...

= | =
Dipley [Srrce ] Selecion] jan = 4

Dring v R EREmIE M g B @) Arial -0 =] B ru A Dde B o~

Savres any pending sdkc 785000,33 1064325,68 Matare

FIGURA N° 4. 39. Ventana “ArcMap” donde se observa desplegado el ment de la funcion “Editor” y la opcion “Save
Editing” seleccionada.
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14. Para concluir, una vez delineado todos los rasgos se despliega nuevamente del

ment de herramientas la opcion “Editor > Stop Editing” (ver Fig 4.40);

= Sin titulo - ArcMap - ArcView

Elle Edit View Insert Selection Tools Window Help

Editor * | k| @ 7 Taski [Create New Feature =] | Target: [Mascara =

i) ) & |[T1438 o] | +ff | & @ F1 K2 | Georsferencing ¥ | Laver [reflectanciaBauriimg B RO
Stop Editing = B
By Save Edits @
iLimg e
e
"n
“u
More Editing Tacls — »
L]
]
Snapping. .. &
Options...
Diisplay - Selection
Drawing v K O~ A~ (0] Arial - Bz U Av D g o~
Stops the edit session F65526,256 1101550,70 Meters

FIGURA N° 4. 40. Ventana “ArcMap” donde se observa desplegado el menii de la funciéon “Editor” y la opcion “Stop
Editing” seleccionada.

4.2.3.2 Importacién del archivo Shapefile al software ENVI 4.2

Una vez generado el archivo Shapefile, es necesario importarlo al software
ENVI 4.2 para iniciar el procesamiento hiperespectral de la imagen, debido a que el
formato del mismo no se adapta a dicho software. Dicho procedimiento se realiza de

la siguiente manera:

1. Seleccionar del menu principal del ENVI 4.2 la funcion “File > Open Image
File” (ver Fig.4.41),
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File| Basic Tools _Classification Transform _Filter Spectral Map Vector Topographic Radar Window Help

Open Image File
Open Vector File

Open External File »
Open Previous File >
Edit ENVI Header

Generate Test Data

Data Viewer

Save File As 3
Import from IDL Variable
Export to IDL Variable
Compile IDL Module

IDL CPU Parameters

Tape Utilities »

Scan Directory List
Change Output Directory

Save Session to Script
Execute Startup Script
Restore Display Group

ENVI Queue Manager
ENVILog Manager

Close Al Files
Preferences

Exit

FIGURA N° 4. 41. Ventana del ment principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona
“Open Image File”.

2. Abrir el archivo que contiene la imagen corregida atmosféricamente (reflectance)

(ver FIGURA 4.42);

[@ ENVIA2

4] #1 (RFLAASH [Layer (TM Cal (Band 1p008053 70 | = =11 & |

] Available Bands List L0128 |

= [ Reflectance0853 =
2 FLAASH (Layer (TM Cal (Band
FLAASH (Layer (TM Cal (Band
FLAASH (Layer (TM Cal (Band _
2 FLAASH (Layer (TM Cal (Band =
FLAASH (Layer (TM Cal (Band
FLAASH (Layer (TM Cal (Band
W @ Map ko
= @ Rad_Band1-7BIL
Layer (TM Cal (Band 1p0080%
o Layer (TM Cal (Band Tp00BAE ~
'

© GrayScae % RGEColor
@ R [FLAASH (Layer (TW Cal (Band 15l
[ome B e |

FIGURA N° 4. 42. Ventanas que se despliegan al abrir la imagen “Reflectance”.
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3. Seleccionar del ment principal la funcion “File > Open Vector File” (ver
FIGURA 4.43);

] [E= e
File | Basic Tools _Classification_Transform _Filter _Spectral _Map _Vector Topographic Radar Window _Hel
pe p pagrapl p

Open Image File
Open Vector File

Open External File »

Open Previous File »
Edit ENVI Header

Generate Test Data

Data Viewer

Save File As »
Import from IDL Variable

Export to IDL Variable

Compile IDL Module
IDL CPU Parameters

Tape Utilities »

Scan Directory List
Change Output Directory

Save Session to Script
Execute Startup Script
Restore Display Group

ENVI Queue Manager
ENVI Log Manager

Close All Files
Preferences

Exit

FIGURA N° 4. 43. Ventana del menu principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona
“Open Vector Fie”.

4. Se despliega la ventana “Select Vector Filenames” y se busca el archivo
shapefile de la mascara creada en ArcGis (ver FIGURA 4.44);

l@:uu\u =@ = ]

1E] #1 [RFLAASH [Laper T Cal (Rand &

'][ | EII

FIGURA N° 4. 44. Ventana “Select Vector Filenames”, donde se busca y se selecciona el archivo shapefile de la mascara.
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5. Inmediatamente se abre la ventana “Import Vector Files Parameters”, donde se

selecciona el archivo shapefile recién importado, dejando los demas campos sin

modificar, solo revisando que la ubicacion del archivo de salida “.evf” sea la

correcta, para finalmente hacer click en “OK” (ver FIGURA 4.45);

I B Colr
i e Tl v 152
i e Tl v 152
B e (708 o 150
Bioringer e

e |

FIGURA N° 4. 45. Ventana “Select Vector Filenames™ donde se selecciona el archivo shapefile de la mascara.

6. Se abre la ventana “Available Vectors List” donde se selecciona el archivo
shapefile, al tiempo que se muestra la informacion de este en el cuadro, para

luego elegir la opcion “Load Selected” (ver FIGURA 4.46);

PRGN fayer (7ML fard 120
BLAEH [Laper (TM Cal B 150
i 7320 fréwoee) [BL]

£ | Dt 1|

FIGURA N° 4. 46. Ventana “Available Vectors List” donde se selecciona el archivo shapefile de la mascara.
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7. Se despliega una nueva ventana llamada *“Load Vector”” donde se selecciona el

“Display #1” y se presiona “OK?”, cargandose asi el archivo shapefile sobre la

imagen (ver Fig.4.47);
] Envi 42 =B8] % |
| File ~Basic Tools Classification  Transform  Filter Spectral Map Vector Topographic Radar Window Help |

] #1 (RFLAASH (Layer (TM Cal (Band 1:p008r053 7200 = | B | R [} [ &) Available Bands List =[] % |

Fite Overlay Enhance Tools Window

FLAASH (Layer (TM Cal (Band 1:p
FLAASH (Layer (TM Cal (Band 1:p
FLAASH (Layer (TM Cal (Band 1:p
FLAASH (Layer (TM Cal (Band 1:p
FLAASH (Layer (TM Cal (Band 1:p
FLAASH (Layer (TM Cal (Band 1:p
Map Info

@ Load Vect... -

Select Vector Window
Display | b
New Vector Window

icale  + RGB Color

oK | Cancel ooen Peria_ || JFLAASH (Layer (TM Cal (Band 1p(

FLAASH (Layer (TM Cal (Band 1:pC

Mame: Layer;
File: C:\Users]
Size: 7,394.64
Records: 1.7

Proj : UTM, Zone o eters
Datum: WGS-34

Attributes: Yes FLAASH (Layer (TM Cal (Band 1;pC

Select Al Layers ] Deselect Al Layers |

x 7220 (Integer) [BIL] ‘

& #1 Scroll (0.027.. | ‘ Load Selected | Remove Selected ”

B | Disghay 111~

% v,

FIGURA N° 4. 47. Ventana “Load Vector” donde se selecciona la opcion “Display #1”.

8. Al momento que se carga el archivo shapefile sobre la imagen se abre la ventana

“#1 Vector Parameters Cursor Query”, donde la opcién “Image” debe de estar

seleccionada como “Window” al igual que el archivo shapefile en la seccion

“Available Vector Layer”, para posteriormente pulsar el boton “Apply” (ver

FIGURA 4.48);
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FIGURA N° 4. 48. Ventana “#1 Vecotr Parameters: Cursor”.

9. En el ment principal de la ventana “#1 Vector Parameters Cursor Query” se
debe seleccionar “File > Export Active layer to ROIs” (ver FIGURA 4.49);

[ File Basic Tools Classification Transform _Filter Spectral Map Vector Tepographic Radar Window Help I

] envia2 !ﬂ‘]

—

1] #1 (RFLAASH (Layer (TM Cal (Band 1:p008r053_7t200.. = [ B[ B 18] Available Bands List = [B] B |

File Overlsy Enhance Took ns

fJectance0853

FLAASH {Layer (TM Cal Band 1
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FLAASH (Layer (TM Cal {Bard T
FLAASH {Layer (TM Cal {Band 1p
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FLAASH {Layer (TM Cal {Band 1p
Wzp Ifo

File Options

ode Edit Options Help

Open Vector File..

b 3
Bale  (* RGB Color

Create New Layer.

Save Layers to Template...

Restore Layers from Template.. H (Layer (TM Cal (Band 15L
Export Active Layer to ROIS, B (yer (7 Cal o 1ot

Export Active Layer to Shapsfile.

FLAASH r (TM Cal (Band 1:p{
Calculate Buffer Zone... sl ! R

Cancel : b 7220 (Integer) [BIL]
Bl ] | Dty 11+

e

] #1 5croll 0027.. | = B1]

Y| Window W image ¥ Scroll [ Zoom |

FIGURA N° 4. 49. Ventana “#1 Vector Parameters: Cursor” donde se despliega una pestafia de la opcion “File” y se
selecciona la funcion “Export Active Layer to ROls...”.
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10. Se despliega la ventana “Export EVF Layers to ROI” donde se selecciona la
opcion “Convert all records of an EVF layer to one ROI” y se hace click en
“OK?”, completandose asi el procedimiento (ver FIGURA 4.50).
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FIGURA N° 4. 50. Ventana “Export EVF Layers to ROI” donde se selecciona la opcién superior.

4.2.3.3 Construccién de la Mascara

Una vez importado el archivo se procede a construir la mdascara para la

imagen en ¢l software ENVI, mediante el siguiente procedimiento:

1. Seleccionar del ment principal del ENVI 4.2 la funcion “Basic Tools > Masking
> Build Mask” (ver FIGURA 4.51);
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Resize Data (Spatisl/Spectral)
Subset Dats vis ROL
Ratate/Fip Data

Layer Stacking

Convert Data (E5Q, BIL, BIP)
Sretch Data

Statistics L
Spatial Statistics »
Change Detection L

Measurement Tool

Band Mth
Spectral Math

Seqmentatian Image

Region Of Interest »

Musaicking [
Masking » Build Mask
Apply Mask
#1 Zoom [4]

Preprocessing

FIGURA N° 4. 51. Ventana del ment principal de ENVI 4.2 donde se despliegan las subsiguientes pestafas y se selecciona
“Buil Mask”.

2. Se despliega una nueva ventana llamada “Mask Definition” donde se selecciona

el “Display #1” y se presiona “OK” (ver FIGURA 4.52);

] envi 42 \ =lE] = ]
[ File BasicTools Classification Transform _Filter Spectral Map Vector Topographic Radar Window Help |

] #1 (RFLAASH (Layer (TM Cal (Band 1:p008:05... | = [ B | &%

File Overlay Enhance Tools Window

FIGURA N° 4.52. Ventana “Mask Definitions” con la opcion “Display #1” seleccionada.
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3. Se abre la ventana “#1 Mask Definitions” y en su menu se selecciona “Options >
Import ROIs...”. Deben de estar marcadas las opciones “Selected Aereas On” y
“Selected Attributes [Logical OR]”, para posteriormente hacer click en “Apply”

cuando vuelva aparecer la ventana anterior (ver FIGURA 4.53);
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File Options
B} Reflectance0853

i+ 0 FLAASH (Layer (TM Cal (Band 1p
e o FLAASH (Layer (THI Cal (Band 1
FLAASH (Layer (TM Cal (Band 10
FLAASH (Layer (TM Cal (Band 10
" | FLAASH (Layer (TM Cal (Band 1p
FLAASH (Layer (TM Cal (Band 10
Import Annotation... Map Info
Import ROIs...
Import ROl Intersection...

Import EVFs... — =

mport Data Range...

Import Displayed Annotation
ale ¥ RGB Color

Mask Finite Values
Mask NaN Values FLAASH (Layer (TM Cal {Band 1pl

Selected Areas "Off" IFLAASH (Layer (TM Cal (Band 1pC
| ¥ Selected Areas"On"

FLAASH (Layer (TM Cal (Band T3(
v Selected Attributes [Logical OR]

Bt
[ ] Sselected Attributes [Logical AND] ==
] #1Scrol (002952) = || - % 220t sce] B}

GE ]m.ﬁ.Mvﬂ

FIGURA N° 4. 53. Ventana “#1 Mask Definitions” donde se despliegan la subsiguiente pestafia y se selecciona “Import
ROls...”.

4.2.3.4 Transformacion de la Fraccién Minima de Ruido (MNF)

Luego de realizada la correccion atmosférica a la imagen se procede a
segregar o minimizar el ruido de la data espectral, para lo cual se utilizara el software

ENVI siguiendo el procedimiento que se describe a continuacion:

1. Seleccionar del menu principal del ENVI 4.2 la funcion “Spectral > MNF
Rotation > Foward MNF > Estimate Noise Statistics From Data” (ver FIGURA

4.54);
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File Basic Tools  Cl

Spectral Libraries

SpectralSlces ,
MNF Rotation » | Forward MNF Estimate Noise Statisics from Data
el Purity Inde > Inverse MNF Transform Previous Noise Statistics
pox o ; .
- Dimensiona Visualizer e Noise Satistics from Dark Data
i »
MepranlEhon s b WANE 1 S
Vegetation Analysis ,

SAM Target Finder with BandMax

Spectral Hourglass Wizard

Automated Spectral Hourglass

Spectral Analyst

Multi Range SFF »

SMACC Endmember Extraction

Spectral Math
Spectral Resampling

Gram-Schmict Spectral Sharpening
PC Spectral Sharpening
N Spectral Sharpening

EFFORT Polishing
FLAASH

Build 3D Cube

Preprocessing y

FIGURA N° 4. 54. Ventana del menu principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona
“Estimate Noise Statistics from Data”.

Se despliega la ventana “MNF Transform Input File” donde se selecciona la
imagen a la cual se le aplic6 la correccion atmosférica FLAASH, que en este caso
seria la “reflectance” y en el campo llamado “Select Mask Band” se coloca el
archivo recién creado de la méascara para posteriormente seleccionar el boton

“OK” (ver FIGURA 4.55);

File Basic Tools Classification Tr:

File Information:

File: C:\Users \Gerarde'\Documenis' Tesis\imagen_|
Dims: 7723 7220 6 [BIL]
Size: [Integer] 669,120,720 bytes
File Type - ENVI Standard
Sensor Type: Linknown
Byte Order : Host (Inte)
Frojection : UTM, Zone 18 Nerth
Picel - 285 Meters
Datum - WGS-B4
Wavelength : 048510 2215 Micrometers
Upper Left Comer. 1.1

Select Input File

Description: Mosaic Result [Thu Dec
05 04:24:59 2007)

‘ Spatial Subset | [Ful Scene ‘

‘ Spectral Subset |[6/6 Bands |
‘ Select Mask Band [Masic Band Mask0853
‘ oK | Gancel ||| Frevius ”o,.,.v|

| st g ||

FIGURA N° 4. 55. Ventana “MNF Transform Input File” donde se llaman los archivos “reflectance” de la imagen y la
mascara recién creada.
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3. A continuacion se abre la ventana “Forward MNF Transform Parameters”, en
donde los unicos datos que se modificaran son los correspondientes a los campos
“Output Noise Stats Filename[.sta]”, “Output MNF Stats Filename [.sta]” y
“Enter Output Filename” donde se colocan los nombres de salida de los archivos

requeridos y su ubicacion para posteriormente hacer click en “OK” (ver FIGURA
4.56)

] ENv42 ‘M‘]

[ File _Basic Tools _ClassificationTransform _Filter Spectral Map Vector Topographic Radar Window Help J

1] Forward MNF Transform Parameters i)

Noise Statistics Information ﬁﬂ“
Shift Diff Subset ||Full Scene

Qutput Noise Stats Filename [sta] Choose

‘-\Imagen_Perija_DSBS‘\M INFAMNF_RUIDO_0853 sta

Qutput MNF Stats Filename [sta] Choose

1 nts\Tesis\Imagen_Perija_0853"MNF\MNF0853 sta

Output Resultto & File 7 Memory

Entter Output Filename Choose | I Compress

[imerts\Tesis\Imagen_Peria_0853\MNF\MNF0E53

Zero Out Masked Values [Yes 1_'_]

Select Subset from Eigernvabues[No 41 |

Number of Qutput MNF Bands |6 =
OK | Queus | Cancel

FIGURA N° 4. 56. Ventana “Foward MNF Transform Parameters” donde se colocan los datos de salida del archivo
MNF.

4. Se inicia el proceso de transformacion del archivo a MNF, mostrando la ventana

“MNF Eigenvalues” al finalizar el proceso (ver FIGURA 4.57).

[g]w\-lu olell & ]

FIGURA N° 4. 57. Ventana “MNF Eigenvalues™ , la cual muestra los autovalores MNF organizados en orden
decreciente de la varianza una vez finalizado el proceso.

112 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO V
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30 a 73 05° Long. Oeste y 9 40'a 10 00” Lat. Norte) METODOLOGIA

UNIVERSIDAD CENTRAL DE VENEZUELA

4.2.3.4 Indice de Pureza del Pixel (PPI)

Luego de obtener el archivo MNF de la imagen, se realiza el proceso de Indice

de Pureza del Pixel utilizando el software ENVI, mediante el siguiente procedimiento:

1. Seleccionar del menu principal del ENVI 4.2 la funcion “Spectral > Pixel Purity
Index > [FAST] New Output Band” (ver FIGURA 4.58);

Spectral Libraries

Spectral Slices 3

MMF Rotation »

Pixel Purity Index 3 [FAST] New Output Band

n-Dimensional Visualizer 3 [FAST] Existing Qutput Band
i 3

Mg et Mew Cutput Band

Vegetation Analysis 3 Existing Output Band

SAM Target Finder with BandMax

Spectral Hourglass Wizard

Automated Spectral Hourglass

Spectral Analyst

Multi Range 5FF 3

SMACC Endmember Extraction

Spectral Math
Spectral Resampling

Gram-5Schmidt Spectral Sharpening
PC Spectral Sharpening
CN Spectral Sharpening

EFFORT Polishing
FLAASH

Build 3D Cube

Preprocessing 3

FIGURA N° 4. 58. Ventana del menu principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona
“Estimate Noise Statistics from Data”.

2. Se despliega la ventana “Fast Pixel Purity Index Input Data File”” y en el campo
“Select Input File” se selecciona el archivo MNF (ver FIGURA 4.59);
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@ a2

[ Fite

Basic Tools _Classification _Transform _Filter _Spectral _Map _Vector Topographic _Radar

=@ = ]
Window _Help |

METODOLOGIA

] Fast Pixel Purity Index Input Data Fle ==
Select put e Fie Ffematon
i C\Users\Gerardo" Documerts\ o5 magen_|
Mask0853 Dims: 7723x 7220x 6 BIL]
Refectance0i5 Sie. [Foating Foin] 1336, 241440 bytes.
i Type < ENVI Sandard
Sersor Type: Urknown
By Order: Host (i)
Projection : UTM, Zone 18 Noth
Poel 1285 Neters
Daun - WGS-34
Wavelengih : None
Usper Lef Comer- 1,1
Desoipton: Forward M Resut
[5un Dec 09.20:10:15.2007]
Spatial Subset [Fll Scene
Spectal Subset [5/6Bands
‘ Select Mask Band |[<hone Seected> Hum-ﬂ
ok [ carea Open-|

FIGURA N° 4.59. Ventana “Fast Pixel Purity Index Input Data File” donde se selecciona el archivo MNF.

Con la finalidad de realizar un subset a la imagen, en la misma ventana “Fast
Pixel Purity Index Input Data File”, se activa el campo “Spatial Subset”,
abriendose la ventana “Select Spatial Subset”, donde se hace click en el boton
“Image” y se despliega la ventana “Subset by Image” para que se pueda recortar
el area a la cual se le aplicara el N. Una vez seleccionada el area de trabajo se
hace click en “OK?”, volviendo a la ventana “Select Spatial Subset”, donde no se

hace ninguna otra modificacion y se presiona el boton “OK” (ver FIGURA 4.60);

(=

B % |
Window  Help ]

oo
[=5=)

[File Basic Tools  ClassificationTransform Filter Spectral Map Vector Topographic Radar

[@ ENVI 4.2

[@ Fast Pixel Purity Index Input Data File

Select input File J (] Subset by Image . -
] Select Spatial Subset =]

Fie: MNF0B53
Dims: 7723 7220 {Floating Point)

Samples [F#Z]  To[7723 NS (4500
Lines [1 Tof7220  nwL[7220

Full Size : 223,040,240 bytes
Subset Size: 129 960.000 bytes

Subset Using

mage | Map | Fie | Fiol/EvE | ser

Subset by Image Input Band |1~ &

o]

1=

(e
S e o
Co Jo]

FIGURA N° 4. 60. Ventana “Subset by Imagine” (derecha) que se abri6 luego de seleccionar el boton “Image” en la
ventana “Select Spatial Subset” (izquierda) , la cual a su vez se activo en el campo “Spatial Subset” en la ventana “Fast
Pixel Purity Index Input Data File”.
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4. Otra vez en la ventana “Fast Pixel Purity Index Input Data File” se pueden

apreciar las variaciones en los rangos del “Spatial Subset” y se hace click en el

boton “OK” (ver FIGURA 4.61);

] ENvI42 (=l=] = ]
[ File_Basic Tools Classification _Transform _Filter Spectral Map _Vector Topographic Radar Window Help |
£] Fast Pixel Purity Index Input Data File =5
Select Input File: File Information
MNFO853 File: C\Users\Gerardo\Documents \Tesis\imagen_|

Mask0853 Dims: 7723 7220 x 6 [BIL]
Reflectanca0851 Size: [Floating Point] 1,338,241 440 bytes

File Type : ENVI Standard
Sensor Type: Unknown
Byte Order : Host {Intel)
Projection : UTM, Zane 18 North
Picel :28.5 Meters
Datum : WGS-84
Wavelength : None
Upper Left Comer: 1.1
Description: Forward MNF Result
[Sun Dec 09 20:10:15 2007]

| soata oot [BETT 2D |

| Spactral Subset W‘

| Select Mask Band |[<None Selected> || Miask Olions ~
|&] Cancl ||| Frevin |E§|

FIGURA N° 4. 61. Ventana “Fast Pixel Purity Index Input Data File” luego de aplicar el subset.

5. Se abre la ventana “Fast Pixel Purity Index Parameters” donde se dejan los
valores de los campos sin modificar y en “Enter Output Filename” se coloca el

nombre de salida del archivo PPl y su ubicacién para finalmente presionar el

boton “OK” (ver FIGURA 4.62);

@] EnvI42 ‘.ﬂl]

[ Fite Basic Tools _ Classification _Transform _ Filter _Spectral Msp Vector Topographic Redar Window  Help |

] Fast Pixel Purity Index Parameters e

Number of terstions {10000
Threshold Factor  |2.50

X Resize Factor |1.0000
Y Resize Factor | 1.0000

Output Resultto @ Fle " Memory

Enter Output Filename Choose

! _Perija_0853\Imagenes_Trabajadas \PPI\PPI[HDR

| 0K Queue | Cancel | Help I|

FIGURA N° 4. 62. Ventana “Fast Pixel Purity Parameters” donde se colocan los parametros de salida del archivo PPI.
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6. Se inicia el proceso, mostrando la ventana “Pixel Purity Index Plot” al finalizar

el proceso (ver FIGURA 4.63).

] el Purity fnces: Picit
|| File Edt Optens  Plot Fumcion  Help

FIGURA N° 4. 63. Ventana “Pixel Purity Parameters Plot” una vez terminado el proceso del PPI.

4.2.3.5 Distribucién en rangos de los PPI seleccionados y su cantidad en pixeles

Posterior al proceso de PPl se realiza la distribucion de los rangos y su
cantidad de pixeles mediante la utilizacion del software ENVI, siguiendo los pasos

que se describen a continuacion:

1. Generado el PPI de la imagen, se abre en el menu de este archivo la funcidon

“Overlay > Density Slice” (ver FIGURA 4.64);

[mwﬂ:s o= 8 ]
3

Claseification.
Contoue Lines...

Hegion of Interest...

FIGURA N° 4. 64. Ment de la imagen PPI donde se despliega la pestafia y se selecciona la funcion “Density Slice”.
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2. Se despliega la ventana “Density Slice Band Choise” donde se selecciona el

archivo PPI para luego hacer click en “OK” (ver FIGURA 4.65);

lg £ 42

@ *1 A (MNFoRs PP

2] Densiy Sice and Choice N i

Sgiect Inpet Densty Sice Band

=B

4 fp Mo bl

oK | cancal ||

FIGURA N° 4. 65. Ventana “Density Slice Band Choice” donde se selecciona el archivo PPI.

3. Se abre la ventana “#1 Density Slice” donde se selecciona el ultimo de los rangos

en la seccion “Defined Density Slice Ranges” y se hace click en el boton
“Apply” (ver FIGURA 4.66);

[E‘l Tonaz =

2] #1 PP ES T = B

1] #1 Denity Sixe
Fie Options  Help

Dt Farge_Feset
e[ [T

Detred Densty Shce Fangss

I
£t Farge | ete ange | Gl arges |

Fooly | | Wiedsw 7 InagaiTion I Send

FIGURA N° 4. 66. Ventana “Density Slice”.
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4.2.3.6 Convertir los PPl en ROI

Luego de generado el archivo PPI, es necesario transformarlo a formato ROI

para lo cual se sigue el procedimiento que se describe a continuacion:

1. Primero se debe de abrir el archivo de la imagen PPI y en el menu de este abrir

“Tools > Region Of Interest > Band Threshold to ROI...” (ver FIGURA 4.67);

| File Basic Tools

f] ENVI42 I.MIJ

File Owverlay Enhance

Link 3
Profiles 3
Polanization Signatures L
Region Of Interest 4 ROI Tool...
i 3
folorapping Restore Saved ROI File
Cursor Location/Value... Save ROIs to File
Pixel Locator... Delete ROIs...

Point Collection...
Build Mask...

Export ROIs to EVF...
Export ROIs to n-D Visualizer

Measurementiiool - Output ROIs to ASCIL..
Line of Sight Calculator...
Reconcile ROL...

Seatal Bucirior Reconcile ROIs via map...

Spectral Pixel Editor...
Animation... Band Threshold to ROL..

2D Scatter Plots... Create Class Image from ROIs...
Create Buffer Zone from ROIs..,
3D SurfaceView...

Compute ROI Separabilty
Outil Bathymeétrie... 1

e

FIGURA N° 4. 67. Ment de la ventana de la imagen PPI donde se selecciona la funcion “Band Threshold to ROIs..”.

2. Se despliega la ventana “Band Threshold to ROI Input Band” donde se
selecciona el archivo PP y se hace click en “OK” (ver FIGURA 4.68);

118 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO V
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) METODOLOGIA

UNIVERSIDAD CENTRAL DE VENEZUELA

] EnVIA2 |.MJ]

Map Vector Topographic Radar Window Help |

|F:ie Basic Tools  Classi

[=[=] & |

Select Input Band: Band Information:

. File: C:\Users\Gerardo \Diocuments' Tesis'Imagen_|
E-fil MNFO8S3 _ Dims: 4200 6900 1 [BSQ]
= MNF Band 1 {Reflectance0853) Size: [Unsigned Int] 57,960,000 bytes.

MNF Band 2 (Reflectance0853) File Type : ENVI Standard

P Sensor Type: Unknown
MNF Band 3 I:ReﬂectanceDEEB} Byte Order - Host (intsi)
MNF Band 4 (Reflectance(853) Projection : ITM, Zone 18 North
MNF Band 5 (Reflectance(853) Pixel 235 Meaters
MNF Band & (Reflectance(853) Datum :WGS-84

1 |||Wavelength : None

Upper Left Comer: 3511,302
Description: Picel Purity Indes
Results. Number of terstions = 10,
000. [Sun Dec 1623:49:13 2007]

e

FIGURA N° 4. 68. Ventana “Band Threshold to ROls Input Band”.

3. Aparece la ventana “Band Threshold to ROl Parmeters” donde es necesario

colocar los valores minimos y méaximos de tolerancia en los respectivos campos,

dejando los demas campos de la misma manera (ver FIGURA 4.69);

EIl nuestro caso €sos Valores fueron:
“Min Thresh Value”: 27
“Max Thresh Value”: 131
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FIGURA N° 4. 69. Ventana “Band Threshold to ROIs Parameters” donde se colocan los valores minimos y maximos.

4. Cada vez que se coloquen nuevos valores se hace click al boton “OK” y se abrird
una ventana llamada “ENVI Question”. Es importante resaltar, que si los valores
de tolerancia no estan alrededor de 10000 puntos, es necesario seguir colocando
valores hasta que el nimero se aproxime a la cifra mencionada anteriormente. Si
el valor es el adecuado sera en ese momento cuando se hara click a “SI” en la

ventana “ENVI Question” (ver FIGURA 4.70);

FIGURA N° 4.70. Ventana “ENVI Question”.
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5. A continuacion de aceptar el valor, se abre la ventana “#1 ROI Tool”. En esta
ventana tiene que estar seleccionado el icono “Off” y el “Thresh (ppi)” (ver

FIGURA 4.71);

1] #1 PRI (MNFORS TP

File RO Type Options Halp

Window: © image  © Sl Zom 7 Of

[P0 tame | Color | Pousis

Foiyad
R e FRIZ | Fad 33U i -

[ e g .Getsl!mlm-'l"mell'.'ew

=T Hede AOMs |

FIGURA N° 4. 71. Ventana “#1 ROI Tool” con el archivo “Thresh (PPI)” seleccionado.

6. En el menu de la ventana “#1 ROI Tool” abrir “File > Save ROIs” (ver FIGURA
4.72);

[@uwu.- =N

1] #1 PRI (MNFOSSTEPP S8

St RO
Restore RO..

Subset Duta via

Export ROk 1o IVF..
Lsport ROk 10 Shapefite..
Export RO 10 e[ Vissaizer..

Output ROf to ASCIL.

Cancel

Seieca M ||| Hede RO

FIGURA N° 4. 72. Menu de la ventana “#1 ROI Tool ”” donde se selecciona la opcién “Save ROIs..”.
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7. Se abre la ventana “Save ROIs to File” donde se selecciona el archivo “Thresh
(PPI1)” y en el “Enter Output Filename” se coloca el nombre de salida del

archivo en .roi con su respectiva ubicacion (ver FIGURA 4.73).

‘Fe Basic Tocls  Classification  Transform  Filter  Spectrsl  Map  Vector Topographic  Radar  Window Help |

] Ena42 IMJJ

] #1 PPI (MNFOBS3):PPI2 SIEER ]

Enhance T

|
n
e 105 o i MR =)
elect Regions to Save:
Thresh (PPI2) (4200x5900) [Red] 3994 points
Mumber of items selected: |1

Select All tems | Clear All kems

Enter Qutput Filename [roi] Choose

Window: O Image

Trreh () _ e

q
fl

‘Imagenes_Tlabajadas' PPI_a_RONROI_de_PPlroi

.

FIGURA N° 4. 73. Ventana “Save ROIs to File”.

4.2.3.6 Visualizador N-Dimensional

Luego de transformado el archivo PPl a ROI, se procede a exportar la imagen
al n-D Visualaizer utilizando el software ENVI siguiendo los pasos que se describen a

continuacion:

1. Con la imagen PPI abierta, se vuelve a la ventana “#1 ROl Tool” y en su ment se

abre “File > Export ROIs to n-D Visualaizer..” (ver FIGURA 4.74);
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] eviaz

=)

Save ROk....

Restore ROks..
Subset Data via Rdls
Export RO to EVF...

Export RO to Shapefile...
Export ROl ta n-0 Visualeer...

Output RO to ASCIL.,

Cancel

FIGURA N° 4. 74. Menu de la ventana “#1 ROI Tool ”” donde se selecciona la opcion “Export ROIs to n-D
Visualizar...”.

2. Se despliega la ventana *“Select Input Data File” donde se selecciona el archivo
MNF con la misma area de trabajo que el archivo PPI y se hace click en “OK”

(ver FIGURA 4.75);

[g;m.r.u —=T

o |

Seloct Irput Fle He rizmanen |
[N (Fie' C \Lisers Cierveis Documents' | pas imagen |
] (e 8200 x 6300 x 6 [BIL]
Sire. [Flting Port] £55 520000 bntes
dt

i Oecher - Hoal [kl
Frogoction | UTM, Zane 18 Nesth
Pasl 725 Heb

Spoctnl Subaet |[06 Bands

K| cancel |

FIGURA N° 4. 75. Ventana “Select Input Data File” donde se selecciona el archivo MNF.
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3. Se abre la ventana “n-D Visualizer Input ROISs” seleccionando el “Thresh
(PP1)” en el “Select Input ROIS™ y se hace click en “OK” (ver FIGURA 4.76);

FIGURA N° 4, 76. Ventana “n-D Visualizer Input ROIs ” con el archivo “Thresh (PPI)” seleccionado.

4. Se despliegan dos ventanas, la “n-D Visualizer” (izquierda) y la “n-D Controls”
(derecha) (ver FIGURA 4.77);

[@ e e =

E] #1 PPLMNFOSS 3PP o [l=1]

Elos o] e |
Fie Class Options _Help
B 0 sesced e

FIGURA N° 4. 77. Ventanas “n-D Visualizer” (Izquierda) y “n-D Controls” (Derecha).
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5. En la ventana “n-D Controls” se seleccionan tres bandas con las cuales se va a

trabajar, cada una de ellas representando un eje (ver FIGURA 4.78);

E] N4z

] n-D Visualizer

E] n-0 Conrols [N |-t |

File Class Options Help |
r -1

0 Selecied Bards

FIGURA N° 4. 78. Ventanas “n-D Visualizer” donde se aprecian los tres ejes con los puntos (Izquierda) y “n-D
Controls” (Derecha) con las tres bandas seleccionadas, las cuales representan los ejes.

6. En el ment de la ventana “n-D Controls” se selecciona la funcién “Options >

Show Axes” para agrupar en clases los puntos que se consideren extremos dentro

de la constelacion de puntos (ver FIGURA 4.79);

FIGURA N° 4. 79. Ventanas “n-D Visualizer” (Izquierda) y “n-D Controls” (Derecha) con su ment desplegado y la
funcion “Show Axes” seleccionada.

125 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO V
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30 a 73 05° Long. Oeste y 9 40' a 10 00° Lat. Norte) METODOLOGIA

UNIVERSIDAD CENTRAL DE VENEZUELA

7. En el menu de la ventana “n-D Controls” se abre “Class > Items 1:20 > Blue
(Color que se le asigna a la nueva clase)” para crear una la nueva clase, a la cual
se le asigna un color (ver FIGURA 4.80). Ubicandose sobre la imagen, esta se va
rotando y a medida que se va determinando de manera individual o grupal los
puntos extremos, este(os) se encierran haciendo un poligono que los contenga, el
cual se cierra haciendo click al boton derecho del mouse. Este paso se repite
hasta que se considere se tomen en cuenta y se agrupen todos los puntos extremos

(ver FIGURA 4.81);

FIGURA N° 4. 80. Ventanas “n-D Visualizer” (Izquierda) y “n-D Controls” (Derecha) con su ment desplegado y el
color que se le asigna a la nueva clase seleccionado.

FIGURA N° 4. 81. Ventanas “n-D Visualizer” (Izquierda) donde se puede apreciar el punto encerrado en el poligono azul
(este tinico punto forma una clase a la cual se le asigno el color azul) y la ventana “n-D Controls” (Derecha).
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Una vez determinadas todas las clases que se consideren estén presentes en la
constelacion de puntos, se procede a exportarlas, para ello se abre “Options >
Export All”” del ment principal de la ventana “n-D Controls”. Las clases quedan

claramente diferenciadas segln el color que se le asigno (ver FIGURA 4.82);

FIGURA N° 4. 82. A la izquierda la ventana “n-D Visualizer”, donde se observan encerradas en circulos rojos algunas de
las clases identificadas y a la derecha el ment de la ventana “n-D Controls” desplegado en la funcion “Options” con
“Export All” seleccionada.

Se despliega la ventana “#1 ROI Tool” donde se muestran todas las clases
determinadas junto con sus caracteristicas. En este momento es posible eliminar
alguna de las clases que se considere que por sus valores es incongruente para
luego seleccionar las restantes y presionar la opcion “Hide ROIs™, revisando que

la opcion de “Window” seleccionada sea “Off” (ver FIGURA 4.83);

FIGURA N° 4. 83. Ventanas “n-D Visualizer” (Izquierda), “n-D Controls” (Derecha) y “#1 ROl Tool” (abajo a la
derecha) donde se muestran las distintas clases reconocidas.

127 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO V
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30 a 73 05° Long. Oeste y 9 40' a 10 00° Lat. Norte) METODOLOGIA

UNIVERSIDAD CENTRAL DE VENEZUELA

10. En el menu de la ventana “#1 ROI Tool” se abre “File > Save ROIs...” (ver
FIGURA 4.84);

FIGURA N° 4. 84. Ventanas “n-D Visualizer” (Izquierda), “n-D Controls” (Derecha) y “#1 ROl Tool” (Abajo a la
derecha), la cual muestra su menu desplegado con la opcion “Save ROIS” seleccionada.

11. Se despliega la ventana “Save ROIs to File”, en la cual se muestran y se
seleccionan todas las clases a exportar, colocando en el “Enter Output” el

nombre de salida y ubicacion del nuevo archivo (ver FIGURA 4.85);

Mumber of tams sslected: [17
Select Al Rer Widow: C Imsge © Sed  Zoam & OF

Enter Output

FIGURA N° 4. 85. Ventanas “n-D Visualizer” (Izquierda), “n-D Controls” (Derecha), “#1 ROl Tool” (Abajo a la
derecha) y “Save ROls to File” (Centro), la cual muestra las clases seleccionadas para exportar y el nombre y ubicacion del
nuevo archivo.
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4.2.3.7 Spectral Angle Mapper

Una vez realizado el “n-D Visualaizer” se procede a aplicar el proceso de
“Spectral Angle Mapper” a la imagen, para lo cual se utilizara el Software ENVI

siguiendo la metodologia que se explica a continuacion.

1. Seleccionar del ment principal del ENVI 4.2 la funcion “Spectral > Mapping
Methods > Spectral Angle Mapper”, manteniendo la ventana del “n-D
Visualaizer” abierta (ver FIGURA 4.86);

FIGURA N° 4. 86. Ventana del menu principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona
“Estimate Noise Statistics from Data”.

2. Automaticamente se abre la ventana ‘“Classification Input File” donde se
selecciona el archivo MNF y se activa el campo de “Spectral Subset” con lo que
se despliega la ventana “File Spectral Subset” para seleccionar las tres (3)
primeras bandas de la imagen. Posteriormente que se tengan las bandas
seleccionadas se hace click en “OK” y se vuelve a la ventana “Classification

Input File” donde se presiona el boton de “OK” (ver FIGURA 4.87);
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FIGURA N° 4. 87. Ventanas “Classification Input File” y “File Spectral Subset” que se despliegan para abrir la imagen
MNF.

3. Se despliega la ventana “Endmember Collection SAM..” y en su ment se abre la
funcion “Import > from ROI/EVF from input file...” (ver FIGURA 4.88);

erithm  Options  Help
o ASCH file...

o ASCI file (previcus template)...

freem Plot Windews.

treem Endmemiber Callection file.

J

FIGURA N° 4. 88. Ventana “Endmember Collections SAM” con su menu desplegado y en el cual se selecciona la opcion
“from ROI/EVF from input file...”.
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4. Seguidamente se abre la ventana “Select Regions for Stats Calculation” en
donde se proceden a seleccionar todas las clases identificadas en el n-D

Visualaizer y se hace click en el boton “OK” (ver FIGURA 4.89);

FIGURA N° 4. 89. Ventana “Select Regions for Stats Calculation” donde se pueden observar seleccionadas las clases que
se determinaron en el “n-D Visualaizer”.

5. Todas las clases seleccionadas quedan cargadas en la ventana “Endmember
Collection SAM...”, donde se procede a seleccionar una de las clases y luego

hacer click en el boton “Apply” (este proceso se repite con todas las clases) (ver

FIGURA 4.90);

FIGURA N° 4, 90. Ventana “Endemember Collection SAM” donde se van seleccionando las clases identificadas en el “n-
D Visualaizer”.
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6. Posteriormente se abre la ventana “Spectral Angle Mapper Parameters” en
donde hay que asegurarse que los datos de salida estén como se muestra en la
grafica de abajo (ver Fig.4.76). En los campos “Enter Output Filename” y
“Enter Output Rule Filename” se coloca el nombre de salida y ubicacion del
nuevo archivo. Del lado derecho de esta ventana se encuentra un recuadro donde
se aprecia la ubicacion espacial de los puntos de la clase (una a una a medida que
se vayan seleccionando en el paso anterior) dentro de la imagen, lo que va ayudar

a determinar la verdadera existencia de la misma (ver FIGURA 4.91);

=7 GEO

1] Spectral Angle Mapper Parametee

Classfication Preview
Set Meamum fAngle fadians)

" Mone % SingleVaue 1 Mubple Values

Meemum Anige fradians) 110

Output Reslt o @ Fle T Memay

Erber Ouiput Flename Chooss Compress

n_Peria_0833\magenea_Trabajadas’SAM (lasal

Ouiput Rule Inages = m

Cutpit Fealttc @ Fle  © Memay

Erter Output Fke Flename Chooee |

n_Pera_0853\magenes_Trabajadas’SAM Clased

OK | Gueus | Cancal | Hap ||| Preview

FIGURA N° 4, 91. Ventana “Endemember Collection SAM” donde se van seleccionando las clases identificadas en el “n-
D Visualaizer”.

7. Cuando se han introducido todos los parametros de manera correcta dentro de la
ventana “Spectral Angle Mapper Parameters” se hace click en el boton “OK”

para correr el proceso y se guarda el archivo (ver FIGURA 4.92);
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FIGURA N° 4, 92. Ventana “Endemember Collection SAM™ donde se van seleccionando las clases identificadas en el “n-
D Visualaizer”.

4.2.3.8 Generacion del Modelo Digital de Elevacion (MDE)(en inglés DEM)

El Modelo Digital de Elevacion es una herramienta muy util para visualizar la

zona de estudio pues permite apreciar la perspectiva 3D de la imagen.

El MDE se lleva realiza con la utilizacion del software ENVI 4.2 siguiendo el

procedimiento que se sigue a continuacion:

1. Seleccionar del menu principal del ENVI 4.2 la funcion “File > Open Image
File” (ver Fig.4.93);

FIGURA N° 4. 93. Ventana del ment principal de ENVI 4.2 donde se despliega la subsiguiente pestafia y se selecciona
“Open Image File”.
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2. Abrir el archivo que contiene la imagen corregida atmosféricamente (reflectance)

(ver FIGURA 4.94);
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FIGURA N° 4. 94. Ventanas que se despliegan al abrir la imagen “Reflectance”.

3. Del menu principal de ENVI 4.2 seleccionar “Topographic > 3D SurfaceView”

(ver FIGURA N° 4.95);

[@ EN42

Fie Rwic Took  Clauficstion Trandlorm Fiter Spectral Map Vectoe [Topesaphes | Radsr  Window  Help
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Create Hill Shade Image
Replace Bad Valuet

30 SurtaceView

Dl Bitheyreadtria

FIGURA N° 4. 95. Ventana del ENVI 4.2 con la pestafia de la funcion “Topographic” desplegada y seleccionada “3D

SurfaceView”.
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4. Se despliega la ventana “Associated DEM Input File” donde se selecciona una

de las bandas de la imagen reflectance y posteriormente se hace click al boton

“OK” (ver FIGURA 4.96);

FLAASH {Layer (TH Cal (Band 1p008! || Dutum © WG584
- Map woangh
i i Lioper Lk Comer 1.1
B i

FIGURA N° 4. 96. Ventana “Associated DEM Input File” con la banda Tres (3) de la imagen reflectance seleccionada.

5. Se despliega la ventana “3D SurfaceView Input Parameters” donde se hace click

en “Spatial Subset” (ver FIGURA N° 4.97);
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FIGURA N° 4. 97. Ventana “3D SurfaceView Input Parameters” donde se hace click en “Spatial Subset”.
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6. Se abre la ventana “Select Spatial Subset” y en esta se hace click en “Image”
(ver FIGURA 4.98);
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FIGURA N° 4. 98. Ventana “Select Spatial Subset” donde se selecciona “Image”.

7. Se despliega la ventana “Subset by Image” donde se selecciona la porcion de la

imagen a la cual se le aplicara el modelaje 3D (ver FIGURA 4.99);

il

FIGURA N° 4. 99. Ventana “Subset by Image” donde se observa encerrado en un cuadro rojo el area al cual se aplicara

em MDE.
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8. Se vuelve abrir la ventana “Select Spatial Subset” con los datos de la nueva area.
Una vez verificados que estén cargados esos nuevos datos se hace click en “OK”

(ver FIGURA N° 4.100);
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FIGURA N° 4. 100. Ventana “Select Spatial Subset” con los nuevo valores del area.

9. Se despliega la ventana “3D SurfaceView Input Parameters” donde se hace click
en “OK?” para dar inicio al proceso (ver FIGURA N° 4.101);
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FIGURA N° 4. 101. Ventana “3D SurfaceView Input Parameters” donde se hace click en “Spatial Subset”.
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10. Se despliega la ventana “3D SurfaceView” que muestra el area de la imagen
luego de aplicado el MDE (ver FIGURA N° 4.102);

@] envia2 ‘Dﬂlﬁ]

[ File Basic Tools Classification Transform _Filter Spectral Map Vector Topographic Radar Window Help |

Eil #1 (R:FLAASH (Layer (TM Cal (Band 1:p008r0.. | = 1= | 0

File ‘Overlay  Enhance’ Tools Window

[

FIGURA N° 4. 102. Ventana “3D SurfaceView” que muestra el resultado del MDE.

4.2.4 Transformacion de imagenes a formato .img para su procesamiento en el
Software ERDAS Imagine

Hasta el momento todos los procesos realizados se han llevado a cabo en el
software ENVI 4.2, por lo que los archivo generados tienen un formato de salida no
compatible para ser trabajadas en el software ERDAS Imagine, es asi que, se hace

necesario transformar el formato de los archivos a utilizar a un formato .img.

La transformacion de los archivos a .img se realiza utilizando el software

ENVI y siguiendo los pasos que se describen a continuacion.

138 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE CAPITULO V
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30” a 73 05° Long. Oeste y 9 40' a 10 00” Lat. Norte) METODOLOGIA

UNIVERSIDAD CENTRAL DE VENEZUELA

1. Seleccionar del menu principal del ENVI 4.2 la funcion “File > Open Image
File” (ver FIGURA 4.103) y abrir el archivo de la imagen -corregida
atmosféricamente (ver FIGURA 4.104);

File | Basic Took _Classification _Transform _Filtes Spectral Map Vector Topographic Radar Window Help

OpenImage File
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Save File As *

Import fram DL Vanable

Export to IDL Variable
Compile IDL Module

IDL CPU Parameters

Tape Utilities »
Scan Directory List

Change Output Directory

Save Session to Script
Execute Startup Script
Restore Display Group

ENVI Queue Manager
ENVI Log Manager

Close All Files
Preferences

Exit

FIGURA N° 4. 103. Ventana del ment principal de ENVI 4.2 donde se despliega la pestafia “File” y se selecciona “Open
Imagine File”.

&) ENVI42 =E] = ]

[[File  Basic Tools Clossification Transform _Filter _Spectral Map Vector Topographic Radar Window _Help |
] #1 (RFLAASH (Layer (TM Cal (Band 1:p008r05... [ = B & ] Available Bands List [ E [
File = Tools ]

File Options

= Reflectance0353

o FLAASH (Layer (TM Cal (Band 10

o FLAASH {Layer (TM Cal (Band 15
FLAASH (Layer (TM Cdl (Band 1p
o FLAASH {Layer (TM Cdl (Band 1p
o FLAASH {Layer (TM Cdl (Band 1p
FLAASH {Layer (TM Cal (Band 1
Map Irfo

) —— ,

" Gray Scale ' RGB Color

@ p [T1004 218 n108) Rad_Ban Tk
G [0 218 w20t Rad_Ban2iF
=B 5= ] &+ zem = =] = J)| ° 004 27 o ]
‘DMSW|
Load RGE | Diplay #1~|

) #1 Scroll (0.03315)

FIGURA N° 4. 104. Ventanas con la imagen corregida atmosféricamente desplegadas.
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2. Una vez desplegada la imagen, seleccionar de su menu la funcion “File > Save

Image As > Image File...” (ver FIGURA 4.105);

{@ 42 =

FIGURA N° 4, 105. Ventana “#1(R: FLAASH(Layer(TM Cal...... )))” donde se despliega la funcion “File” y se
selecciona la opcion “Image File...”.

3. Se abre la ventana “Output Display to Image File”, donde el Gnico parametro
que debe de variar es el “Output File Type”, que en este caso tendra como tipo de
archivo de salida el “ERDAS IMAGINE”. En el “Enter Output Filename” se
coloca el nombre de salida del archivo y su ubicacidon para finalmente hacer click

en el boton “OK” (ver FIGURA 4.106):
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FIGURA N° 4. 106. Ventana “Output Display to Image File” con los datos de salida de la imagen .img.
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4.2.5 Realizacion de la Clasificacion NO Supervisada

El proceso de Clasificacion NO Supervisada se realizo mediante la utilizacién
del software ERDAS Imagine, siguiendo la metodologia que a continuacion se

describe.

1. Seleccionar del menu principal del ERDAS Imagine 8.6. la funcion “Classifier”,
con lo que se despliega la ventana “Classification”, en donde se selecciona la

opcion “Unsupervised Classification...” (ver FIGURA 4.107);
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Viewer Import DataPrep | Composer | Interpreter Catalos Classifier Modeler Vector Radar VirtualGIS | ©OrthoBASE

4 |
< Unsupervized Classification ... )

Threshold ...

Fuzzy Convaltion

Grouping Toal ...

Accuracy Assessment ..

Feature Space Image

Knowledge Classifier ...

Knowledge Engineer

Frame Sampling Tools ...

|
|
|
|
|
Feature Space Thematic ... ]
|
|
|
|

Spectral Analysis .

FIGURA N° 4. 107. Ventana del ment principal del software ERDAS Imagine donde se resalta la funcién “Classifier”.
Abajo se observa la ventana “Classification” donde se encuentra resaltada la funcion “Unsupervised Classification...”.

2. Se despliega la ventana “Unsupervised Classification (Isodata)”, en la cual se

introducen los siguientes de datos:

e Se comienza por colocar en el campo “Input Raster File: (*.img)” el

archivo al cual se le aplicara la clasificacion no supervisada;
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Cuando todos los datos hayan sido introducidos se hace click en el boton

(ver FIGURA 4.108);

“OK”

en el campo “Output Cluster Layer Filename: (*.img)” se ubica el sitio

donde se guardara el nuevo archivo y se le da nombre al mismo en

UNIVERSIDAD CENTRAL DE VENEZUELA

formato .img;

en el campo “Output Signature Set Filename: (*.img)” se ubica el sitio

donde se guardara el nuevo archivo y se le da nombre al mismo en

formato .sig;

en el “Number of Classes:” se colocan el nimero de maximo de clases

con el cual el software hara la clasificacion;

los demas campos se dejan igual.

Import.

d

DataPrep

FIGURA N° 4. 108. En primer plano la ventana “Unsupervised Classification...” luego de introducir todos los datos de

En el momento que esta corriendo el proceso se puede apreciar que

Composer | Interpreter Catalos

Input Raster File: [*img] oLt Signature File
reflectanciaBG3uniimg [z I

|v Output Cluster Layer

|¥ Output Signature Set

Filename: [*.5ig)

= I clashasup.sig

Clustering Options;

Filename: [*ima]

clasnosup.img

" |nitiglize from Statistics Use Signature Means
F

Colar Scheme Options... J

Mumber of Classes

Initializing Options. .. J

Processing Options:

Fo e
Convergence T hreshold. 0.850 3 i P—E
“f 3

] Cancel J

Sklp Factors:
M aimum |terations: s

[ Classify 2erns

]

Batch | 40l

|| Supervised Classification

|

]

Vector

>

leler Radar

@

VirtualGIS

OrthoBASE

Unsupervised Classification ...

Threshald ...

Fuzzy Canvalution ...
Grouping Toal ...
Accuracy Assessment ...

Feature Space Image
Feature Space Thematic ...
Knowledge Classifier
Enowledge Engineer .
Frame Sampling Tools
Spectial Snalysis .

- Help

salida.

aparecen ventanas (ver FIGURA 4.109) que muestran el avance del mismo;
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s ERDAS IMAGINE 8.6

_—

Import.

Composer

1T
InterpretelJ Catalog

Viewer DataPrep Modeler

VirualGIS | OrthoBASE

Percent Dons:~ 50% U 100
IR | o Baicel Help l

Accuracy Assessment ...
Feature Space Image
Featuie Space Themalic
Knowledge Classifier
Knowledge Engineer
Frame Sampling Tools
Spectral Analysis

FIGURA N° 4. 109. En primer plano la ventana “Isodata...”, la cual muestra el porcentaje de avance que tiene el proceso.

tion ...
Juob State: Computing Statistics
=

3. A continuacién se abre el “Viewer #1: clasnosup.img(:Layer_1)”, la cual
muestra como queda la imagen luego de aplicado el proceso de clasificacion no

supervisada (ver FIGURA 4.110);

ERDAS IMAGINE B.6

Vector

OvthoBASE

&

Radar

Viewer Composer | Interpreter |  Catalog Virtual GIS

Stereo

FIGURA N° 4. 110. Ventana “Viewer #1: clasnosup.img(:Layer_1)”, la cual muestra la imagen una vez terminado el
proceso.
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4. En el menu de la ventana “Viewer #1: clasnosup.img(:Layer_1)" se selecciona
la opcion “Raster > Tools” (ver FIGURA 4.111);

FIGURA N° 4. 111. Ventana “Viewer #1: clasnosup.img(:Layer_1)" con la pestafia de la funciéon “Raster” desplegada,
de donde se selecciona la funcion “Tools”.

5. Se despliega la ventana “Raster” donde se muestran sus herramientas y en esta se
selecciona la opcion que abre el archivo .sig generado (ese boton se observa en la

FIGURA 4.112 encerrado en un circulo rojo);

s ERDAS IMAGINE 8.6
(3

r—

o
Viewer Import, DataPrep | Composer | Interpreter gﬁ |ﬁer Modeler \re-;mr Raﬂ VirtualGIS oss
A1 : clasnosup.img (:Layer_1) E”E|E] Raster
View AOL Raster Help I\ D0Oe
oo+
| PR
¢ B RE
v B B 8
& L k= la
12 0 M
E R %
oo E
o B 0O D
Z %
][ TE
|l 2
|
Display/Edit Raster Attributes p

FIGURA N° 4. 112. Ventana “Viewer #1: clasnosup.img(:Layer_1)” (Izquierda) y ventana “Raster” (Derecha), en donde
se selecciona la herramienta encerrada en un circulo rojo.
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6. Se abre la ventana “Raster Attribute Editor-clasnosup.img(:Layer 1) donde se

muestran todos los datos de las clases en que se dividié la clasificacion no

supervisada (ver FIGURA 4.113);

Import Composer | Interpreter Catalog

i

Vector

@

Radar

OrthoBASE

File Edit Help

e 0 B i B Laver Number ]1—3

 How Histoaram Calor Red
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Blug
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i
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0

1]

Clags 1

0.0330352

0.0980332

0.0330332

Clags 2

0.14302

0.14302

014302

Class 3

0.2

0z

02

Clags 4

0.247059

0.247053

00.247053

Class 5

0.258033

0.238033

0.233033

Clags B

0.34302

0.34302

0.34302

Class 7

0.396078

0.336078

0.336078

Clags 8

0.447053

0.447059

0.447053

Class §

= lw o~ m o e o = o

4956094 I 0.435033
|

0.436033

0.439033

JEY Y S R Y (Y ) (Y Y Y P

Clags 10

~

[E%

768367.12, 102613537 (UTM ] WiGs 84y

FIGURA N° 4. 113. En primer plano la ventana “Raster Attribute Editor-clasnosup.img(:Layer_1)".

7. Posteriormente se procede a analizar las clases generadas y se trata de identificar

cuales se pueden relacionar entres si, es decir, representan la misma informacion.

Una vez se logren identificar cuales clases se relacionan y cuales representan un

caracter diferente a las demads, se le asigna un color, para ello se hace click sobre

el color de la clase original, con lo que se despliega el menu de colores de la cual

se selecciona uno para ese caracter (ver FIGURA 4.114). Luego de asignar el

color, se coloca el nombre a la clase, segin lo que se piensa que represente (ver

FIGURA 4.115). Automaticamente al variar el color de alguna de las clases

dentro de la ventana “Raster Attribute Editor-clasnosup.img(:Layer_1)”, el
color cambia dentro de la imagen (ver FIGURA 4.115 y FIGURA 4.116);
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FIGURA N° 4. 114. Ment de colores que se despliega luego de hacer click sobre el color original de alguna de las clases
que se encuentran en la ventana “Raster Attribute Editor-clasnosup.img(:Layer_1)".

Viewer

DataPrep | Composer | Interpreter

Catalog

Radar OrtheBASE

VirtualGIS

Stereo

W File Edit Help
=0 & W B Layer Number: 1 3
Row || Histogram Color | Red Green 1 Blue Opacity -
0 1] 0|5 ombras de Nube
0 ] i 1|Sombras de Nube
0 1] i] 1|Sombras de Nube
1 1] i] 1|Class 3
0.2 0.z 0.z 1| Class 4 1
0.247059 0.247059 0.247059 1|Class &
0233039 0.2593039 0.293039 1|Class &
034302 0.34302 0.34302 1|Class 7
0.336078 0.396078 0.336078 1|Class 8
[0.447053 0.447059 0.447053 1|Class 9
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>

802567.12, 102522337 (UM [ WS 84)

FIGURA N° 4. 115. Ventana “Raster Attribute Editor-clasnosup.img(:Layer_1)" que muestra como se modifica el color
de la clase seleccionada.
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FIGURA N° 4. 116. Ventana “Viewer #1: clasnosup.img(:Layer_1)" (Izquierda) donde se puede observar la
modificacion del color dentro de la imagen una vez modificado en la tabla de clases y ventana “Raster” (Derecha).

8. Luego de caracterizadas las clases el producto final es el que se muestra en la

FIGURA 4.117 y la FIGURA 4.118 ;

s ERDAS IMAGINE 8.6
— 7 @
Viewer Import DataPrep Composer | Interpreter Catalog Classifier Modeler Vector Radar Virtual GIS OrthoBASE
- 0% Ay
: = | X iO
HS2 @ iHam+a x@qaalg~ s +

File Edit Help

20 & 7 B Lwertumber |1

 Row Histowam | Color Fied _ Gieen Blue ~ Opaciv =
i 0 0 Sombra de rube
1| 18 0.0656667 0.482353 0.54502 Sombra de nubs ¢ drenaje
2 0054302 0.558627 0921569 Sombra de fils y dienajs
3 00301961 0603322 0.34302 Sombra de fils y dienajs
A i 0 1 Litolagia dura [zonas elevadas]
5 0.438033 1 i Utologia dura, zonas elevadas
B 0 1 0 Litologia semi-durs, menos resis
7| 0 1 1 1 | Litologia semi-duia, forman tene
g 1 1 0 1 | Litologia semi-blanda,
El 1 0.335216 i 1 | Cologia blanda, s2 encuentia
10/ 0.543137 0.160784 1160764 7| ologia blanda asociada ala ¢ ¥

Y

£

FIGURA N° 4. 117. Ventana “Raster Attribute Editor-clasnosuper.img(:Layer_1)" luego de identificar y agrupar las
clases que se reconocen dentro de la imagen.
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FIGURA N° 4. 118. Ventana “Viewer #1: clasnosuper.img(:Layer_1)" con el apariencia final, luego de realizada la
clasificacion.

4.2.6 Realizacion de la Clasificacion Supervisada

Para la Clasificacion Supervisada se utiliza el software ERDAS Imagine,

siguiendo los pasos que se describen a continuacion:

1. Seleccionar del ment principal del ERDAS Imagine 8.6. la funcion “Viewer”, con
lo que se despliega la ventana “Viewer #1”, en donde se selecciona de su menu la

opcion “File > Open > AOI Layer” (ver FIGURA 4.119);
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DataPrep | Composer | Interpreter Catalog
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& o fdocuments and settingsfusuariojmis documentostesis sensoresfsupervisadacasificacionsup.img

9 ¢ /documents and settingsfusuariojmis documentasjtesis sensoresfsupervisadalclasu.img

Close Other Viewers

Load AOI From File

FIGURA N° 4. 119. Ventana con el ment principal del software ERDAS Imagine donde se resalta la funcion “Viewer”.
Abajo se observa desplegada la ventana “Viewer #1” donde se despliega la pestaia de la “File” y se selecciona la funcién
“Open > AOI Layer...”.

2. Se abre la ventana “Select Layer To Add” donde se selecciona la imagen
reflectance (ver FIGURA 4.120);

Modeler Vector Radar VirtualGIS OrthoBASE

- [3]x]

DataPrep | Composer | Interpreter Catalog Classifier

EDESP 2 HE=+_"E W& M F
Select Layer To Add:
File | Fiaster Options | Muliple |

Lock i [ reflectance

%] (eflectance-853-2.img
2| Reflectance_853.im

File name: |ref|ectamasaa-um.mg

Files of type: [IMAGINE Image [%ima]
truecalor; 7220 Aows # 7723 Columns 6 Band(s)

FIGURA N° 4. 120. Ventana “Select Layer to Add”.
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3. Luego que la imagen se carga en el “Viewer #1” (ver Fig.4.96), del menu
principal del ERDAS Imagine 8.6 se selecciona la funcion “Classifier”,
desplegandose la ventana “Classification” donde se selecciona el comando

“Signature Editor” (ver FIGURA 4.121);

i IR IMAGINE 1. -

8|25 &0 = £

=

Supetvived Clartihcation .,
Thinshokd
Fuzzy Comvolubon
Groupi Tool -
Acciaacy dssnsment
Fealan Space lnage
Feshure Spoce Thematic .,

Frame Sampling Took .
Spochal Anakysia
oo | W |

FIGURA N° 4.121. Ventana “Viewer” (Izquierda) la cual muestra abierta la imagen “Reflectance” y la ventana
“Classification” (Derecha) donde se encuentra resaltada en un circulo rojo la funcion “Signature Editor”.

4. Se despliega la ventana “Signature Editor” (ver FIGURA 4.122);

[~ [2[X]

OrthoBASE

Edit View Evaluste Festurs Classfy Help

DsLes2h S Wik VA

B Sianelure Name [ Color | _Fed | Gresn | Blue | Vebue Order| Count | Piob. P I [H|A| F5 [&

=y T T ey e e e e

N

| 77247825, 1173672.25 (UTH | WGS 84)

FIGURA N° 4.122. En primer plano la ventana “Signature Editor”.
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5. Del menu de la ventana “Viewer #1” se selecciona “AQOIl > Tools” (ver FIGURA
4.123);

its. ERDAS IMAGINE 8.6

e

Viewer Import

OrthoBASE

e

Vector

=

Rardar
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I —
=+ Rk XNAQQ N F
Undo S T— N
cut

Copy

Paste

Delete Raster Mask

Group

Ungroup

Reshape

Invert Palygon
Element Properties. .,
Styles...

Seed Properties...
Copy Selection To AOL..
Lirk

blet Input

I.\*‘(

J501 Taoks

FIGURA N° 4. 123. Ventana “Viewer #1” con la pestafia de la funcién “AOI” desplegada, de donde se selecciona la
funcion “Tools...”.

6. Al desplegarse la ventana “AOI”, en esta se selecciona la herramienta para armar

poligonos (ver FIGURA 4.124);

ERDAS IMAGINE 8.6

]| = | b 50 @
Viewer Import DataPrep | Coi er | Int ter | Cataloy Modeler Vector Ratlar
ol |
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FIGURA N° 4. 124. Ventana “AOI” (Derecha arriba) con la herramienta de dibujar poligonos encerrada en un circulo rojo.
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7. Luego de apoyarse en un mapa geoldgico para identificar la ubicacion de las
distintas formaciones existentes, se procede en el “Viewer #1” a seleccionar la
porcion de la imagen previamente identificada que represente dicha formacion,
para lo cual se construira un poligono (ver FIGURA 4.125). Inmediatamente en
la ventana “Signature Editor” se hace click sobre la herramienta de agregar clase

(ver FIGURA 4.125, herramienta encerrada en un circulo rojo);

Viewer
L

85| 45| | % |

s iewer 41 reflectanclaB3-unl.img (:Layer_4)(Layer_3)(:La.

S DEHEZR U=+ XxAQN"
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Fie Edl View Evshate Festue Classfy Heb

@ D(st)=3 Z M4 VA

Class # || > Colo | Fed | Gieen Ble \a

Sianatuse Name

< 2

|8
[z ate tew Sonatirets) from Act

FIGURA N° 4. 125. Ventana “Signature Editor” (Abajo a la derecha) con la opcion para agregar clases encerrada en un
circulo rojo.

8. La nueva clase queda agregada en el “Signature Editor” y se procede a colocarle

el nombre en el recuadro correspondiente (ver FIGURA 4.126);

s ERDAS WAAGINE 2.6

Viewer

s Viower #1 : reflectanciaB53-uni.img (:Layer_d)(:Layer_3){:|

s DSl =+8a= xQqa

Fle Edr view Evaluate Feature Classiy Help
B 0 shssZ Z M lA VWA

Sianatus Mame Coor | Fed | Green | Blue  \a

>

FIGURA N° 4. 126. Ventana “Signature Editor” (Abajo a la derecha) con la nueva clase agregada.
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9. Los pasos 7 y 8 se repiten continuamente hasta que se logren identificar todos los
rasgos litologicos conocidos y representados en informacion previa. Una vez
determinadas todas las clases se selecciona del menu principal del ERDAS
Imagine 8.6 la funcion “Classifier”, desplegandose la ventana “Classification” y

de esta se activa la funcion “Supervised Classification” (ver FIGURA 4.127);

o
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FIGURA N° 4. 127. Ventana con el ment principal del software ERDAS Imagine donde se resalta la funcion “Classifierr”.
Abajo se observa desplegada la ventana “Classification” donde se selecciona la funcioén “Supervised Classification™.

10. Se abre la ventana “Supervised Classification” donde se colocan los siguientes

datos de entrada y salida:

e Input Raster File: en este campo se coloca el archivo de la imagen que se
viene trabajando (en este caso “reflectance853-uni.img);

e Input Signature File: en este campo se coloca el archivo .Sig creado en el
paso 3 (en este caso “clasifsupdef.sig”);

e Classified File: en este campo se coloca el nombre y ubicacion del archivo

de salida de la clasificacion supervisada;
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Cuando estos campos estén completos se hace click en “OK” (ver FIGURA

4.128);

OrthoBASE
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FIGURA N° 4. 128. Ventana “Supervised Classification” donde se colocan los datos de entrada y salida.

11. El resultado final es el que se observa en las FIGURA 4.129 y FIGURA 4.130.
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FIGURA N° 4. 129. Ventana “Raster Attribute Editor-....” donde se observan las clases establecidas.
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ERENNNEIES

FIGURA N° 4. 130. Ventana “Viewer #1: clasnosuper.img(:Layer_1)" con el apariencia final de la clasificacion
supervisada.

4.2.7 Goereferenciacién de los Mapas Topograficos

Los mapas 5545 y 5645 se Georeferencian utilizando el software ArcGis,

siguiendo el procedimiento que se describe a continuacion.

1. Del ment principal del software ArcGis 9.1 se selecciona la funcion “ArcCatalog
- ArcView” (ver FIGURA 4.131);

Feess & 0= A= e ElEE R N S e

Ry

FIGURA N° 4. 131. Ventana “ArcMap-ArcView” donde se resalta dentro de un circulo rojo en el menu de herramientas la
opcion “ArcCatalog”.
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2. Una vez desplegada la ventana del “ArcCatalog — Arc View” se ubica el archivo
del mapa en .img, en este caso el 5545, y sobre el se hace click al boton derecho,

desplegandose una pequefia ventana en donde se selecciona la opcion

“Properties...” (ver FIGURA 4.132);

3 AreCatahg - Ase¥iew - C-\locuments and Se1tings Wsaarkiis docimestes e Semores Wlapan ARAS_TESS

e 8 oo G Jock finiew e
a3h e X,

FIGURA N° 4. 132. Ventana “ArcCatalog-ArcView” donde se observa la pestafia que se despliega al hacer click con el
boton derecho sobre el archivo “5545.img” y se selecciona la opcion “Properties..”.

Se abre la ventana “Raster Dataset Properties” donde se busca el parametro con

el nombre “Spatial Reference”, el cual debe de tener valores indefinidos y se
hace click en “Edit” (ver FIGURA 4.133);

FIGURA N° 4. 133. Ventana “Raster Dataset Properties” donde se selecciona la opcion “Edit” en la “Property > Spatail
Reference”.
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4. Se despliega la ventana “Propiedades de Spatial Reference” y se hace click en el
boton “Select” (ver FIGURA 4.134);
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FIGURA N° 4. 134. Ventana “Propiedades de Spatial Reference” donde se hace click en el boton “Select”.

5. Seguidamente se abre la ventana “Browse for Cordinate System”, se selecciona
la opcion “Projected Coordinate Systems” y se hace click en “Add” (ver
FIGURA 4.135);
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FIGURA N° 4. 135. Ventana “Browse for Coordinate System” donde se selecciona la opcion “Proyected Coordinate
Systems” y resaltado en rojo el boton “Add”.
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6. Se muestran en la misma ventana los diferentes sistemas de proyeccion de
coordenadas y de estos se elige el “UTM” y se hace click en “Add” (ver

FIGURA 4.136);
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FIGURA N° 4. 136. Ventana “Browse for Coordinate System” donde se selecciona la opcion “UTM” 'y resaltado en rojo
el boton “Add”.

7. Dentro del sistema UTM se escoge el “Wgs 1984” y se hace click en “Add” (ver
FIGURA 4.137);
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FIGURA N° 4. 137. Ventana “Browse for Coordinate System” donde se selecciona la opcion “Wgs 1984” y resaltado en
rojo el boton “Add”.
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8. Posteriormente se busca el huso que le corresponda a la zona de trabajo y se hace

click en “Add” (ver FIGURA 4.138);
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FIGURA N° 4. 138. Ventana “Browse for Coordinate System” donde se selecciona la opcion “WGS 1984” y resaltado
en rojo el boton “Add”.

9. Se vuelve a la ventana “Propiedades de Spatial Reference” y en ella se observan

todos los detalles del huso que se selecciono. Se hace click en “Aceptar” (ver
FIGURA 4.139);
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FIGURA N° 4. 139. Ventana “Propiedades de Spatial Reference” donde se pueden observar todos los detalles del
sistema de coordenadas seleccionado.
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10. Seguidamente se regresa a la ventana principal del ArcGis 9.1, de su ment se

selecciona “File > + Add Data” (ver FIGURA 4.140);

= Sin titule - ArcMap - ArcYiew

b GOC Yew |nsert jelecnon Looks yendow e
D tiowe... ciriel E| I =

S s e Jdesnw
oML |REE[E # @ [0s] | = = | g

Sove
Save A ot J=
+ TS
Add Dot Froen doternst »
1] g andl Prink Sty
[, Frint Praiew...
& prt...
5 B Progetins...
[port from ArcYiew project...
Expert Mg
1 C:\Pocumerts and Se... \mapas.mad
LM, MAPA_AGUA_SUELOS MD
Ext ARAF

Dirplag [Sowca ] Seheien] (g o | > w IO

Gemes = R V0> A~ [aa T e[ =] B sy A e e s
| Aeckd Fren ot o the mas's sctive dats frame L7901 H1 9,09 Unkewn Lieits

FIGURA N° 4. 140. Ventana “ArcMap-ArcView” donde se selecciona de su menu principal la opcion “File > Add
Data..”.

11. Se abre la ventana “Add Data” busca el mapa que se desea referenciar, en este

caso el “5545.img” y se hace click en “Add” (ver FIGURA 4.141);
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FIGURA N° 4. 141. Ventana “Add Data” en primer plano, donde se selecciona el archivo que se desea abrir.
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12. Se elige una de las esquinas del mapa en donde se cruzen las lineas de
coordenadas conocidas y en la barra de herramientas se selecciona la opcion (ver

FIGURA 4.142 y FIGURA 4.143);
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FIGURA N° 4. 142. Ventana “ArcMap-ArcView” con la imagen del mapa ya desplegada y en el extremo derecho de la
barra de herramientas la opcioén “” encerrada en un circulo rojo.
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FIGURA N° 4. 143. Ventana “ArcMap-ArcView” donde se pueden apreciar el punto seleccionado encerrado en un circulo
rojo con sus respectivas coordenadas .
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13. En el cruce de la lineas se coloca la marca, se hace click al boton derecho y se

despliega una pequefa ventana donde se selecciona la opcion “Input X and Y...”

(ver FIGURA 4.144);
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FIGURA N° 4. 144. Ventana “ArcMap-ArcView” donde se observa el cruce de las lineas (de coordenadas conocidas) y la
marca verde que se coloca sobre esta.

14. Se abre la ventana donde se introducen los valores de las coordenadas conocidas y

que representan el punto seleccionado (ver FIGURA 4.145);
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FIGURA N° 4. 145. Ventana “ArcMap-ArcView” donde se observa la pestafia se selecciona la opcion “Input X and Y...”.
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15. Posteriormente se seleccionan otros ocho (8) puntos del mapa, preferiblemente las

esquinas, puntos intermedios en los extremos y la coordenada central del mapa

(ver FIGURA 4.146);
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mapa marcados con una cruz roja y encerrados en un circulo verde.
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FIGURA N° 4. 146. Ventana “ArcMap-ArcView” donde se observan los nueve puntos que se utilizaron para referenciar el

16. Finalmente, una vez referenciado los nueve (9) puntos se selecciona de la barra de
herramientas la opcion “Georeferencing > Update Georeferencing” (ver
FIGURA 4.147);
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FIGURA N° 4. 147. Ventana “ArcMap-ArcView” donde se selecciona de la barra de herramienta la opcion
“Georeferencing” y se abre la pestafia en donde se selecciona la opcion “Upadate Georeferencing”.
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4.2.8 Generacion del mapa geologico

Una vez obtenidos los subproductos anteriores se proceden a crear los
archivos shapefile que contengan los diversos rasgos geoldgicos e informacion
necesaria para la generacion del mapa actualizado. Dichos archivos incluyen
litologia, drenajes y estructuras, y se generan siguiendo el mismo procedimiento

descrito anteriormente en el punto 4.2.3.5
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CAPITULOV

INTERPRETACION DE LA IMAGEN

Con la aplicacion de los procedimientos descritos en el capitulo IV se
generaron una serie de archivos o sub-productos, tales como el reflectance, MNF,
PPI, SAM, N-Dimensional, clasificacion No supervisada, clasificacion supervisada,
ademas de archivos shapefile en donde se identifican y delinearon todos los rasgos
geologicos de importancia, que de manera individual o integrada permitieron la
interpretacion de la imagen, lo que conlleva a la actualizacion de la cartografia

geologica del area de estudio.

Es asi que, de cada uno de esos sub-productos se obtuvo informacion

geoldgica, la cual se presenta a continuacion descrita de manera general.

5.1 IMAGEN FLAASH

El primero de los subproductos generados durante la ejecucion de la fase de
procesamiento de la imagen, es el archivo o imagen corregida atmosféricamente (ver
FIGURA 5.1), el cual se constituyd en la base para el desarrollo de los demas
procedimientos, esto motivado al hecho de que este archivo representa la imagen
libre de los efectos de dispersion y absorcion, lo que le da una aspecto mas real a la

misma.

En la imagen observada abajo (ver FIGURAS.1), se emplea como base la
combinacion de bandas 3-2-1(que es la combinacion que da los colores mas reales),
siendo posible apreciar ciertos cambios de color, que indican variaciones en la

vegetacion, diferenciando ademds aquellas zonas en donde esta es mas tupida y
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abundante con relacion aquellas zonas (intermedias a bajas) donde la vegetacion esta
presente en menor magnitud y se torna con colores marrones, lo que inferimos como
cambios en la litologia. Igualmente, se logran diferenciar a simple vista las zonas de
alto relieve y de bajo relieve, ademds de apreciar claramente aquellas zonas

intermedias. Las zonas bajas las relacionamos con zonas de planicies de inundacion.

] #1 Scroll (0.10100) E=E—

FIGURA N° 5. 1. Imagen corregida atmosféricamente en el software ENVI 4.2, con combinacion de bandas 3-2-1. El area
encerrada en el recuadro blanco representa la zona de estudio.

Un ejemplo de la informacién obtenida con la interpretacion de la imagen
reflectance, es el que se presenta en la siguiente figura (ver FIGURA N° 5.2), donde
se aprecia los cambios en las tonalidades de los colores dentro de la misma, echo que
se atribuye a la variacion en la vegetacion, indicio de la presencia de diferentes tipos
de litologia. Del lado derecho se observa mayor presencia de vegetacion, la cual se
asocia a colores mas verdosos, mientras que del lado izquierdo un tono de color verde
mas claro y marron indican la presencia de una vegetacion de menor abundancia

intercalada con zonas de poca vegetacion.
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Cuaternario :
- Fm. La Villa

FIGURA N° 5. 2. Zona de la imagen reflectance (3-2-1) donde se aprecia la diferencia de colores en la vegetacion,
identificando del lado izquierd, en color marron-verdoso , depdsitos cuaternarios, y del lado derecho la Formacion La Villa, la
cual se observa con un color mas verdoso.

5.2 IMAGEN MNF

El segundo de los subproductos generados es el archivo MNF, en donde se ha
eliminado la incidencia del ruido sobre el dato espectral de la imagen. Previo a la
generacion de este archivo se le aplico la mascara de nubosidad a la imagen
reflectance, con el objetivo de eliminar la incidencia de las nubes en el procesamiento
de la imagen, de ahi que en la imagen MNF se observen los espacios vacios que
ocupaban las nubes en la imagen original. Este archivo es el primordial en los demas

procesos y generacion de los siguientes subproductos

En la imagen MNF que se presenta a continuacion (ver FIGURA 5.3), son
claramente separables por colores las zonas de alto relieve (representadas por colores
azulados, morados y algo rojizos) de las de bajo relieve (representadas por colores
amarillentos y naranja). En este caso, las zonas de alto relieve representan las areas
de relieve abrupto, donde la litologia presente es competente; mientras que las zonas
de bajo relieve representan la litologia de menor competencia. De igual manera, son
claramente apreciables en la imagen las variaciones de colores internas en esas dos

zonas, lo que esta representando los posibles cambios de litologia.
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FIGURA N° 5. 3. Imagen MNF generada en el software ENVI 4.2 a partir de la imagen FLAASH. En esta imagen la
combinacion de bandas utilizada es la 3-2-1 y el recuadro blanco en marca el 4rea de estudio.

Un ejemplo de la utilidad de la imagen MNF para la identificacion de las
diferentes unidades litologicas se presenta a continuacion (ver FIGURA N° 5.4). En
la imagen, los posibles contactos interpretados a partir de la imagen MNF se
encuentran representados por las lineas negras, esas lineas separan los agrupamientos
de puntos donde hay dominio de determinado color, representando un tipo de

litologia.
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FIGURA N° 5. 4. Imagen MNF donde son claramente identificables las variaciones de colores que se encuentran asociados
a cambios en la litologia. El 4rea dentro del recuadro blanco representa la zona de estudio.

Otra de las utilidades de esta imagen vino dada por el aporte hecho en lo que
respecta a la identificacion de drenajes, los cuales fueron apreciables claramente en la
imagen con la combinacioén de bandas 1-2-3, tal como se puede observar en la figura
que se presenta a continuacion (ver FIGURA N° 5.5). Adicionalmente esta

combinacion de bandas resalta las variaciones de litologias (ver FIGURA N° 5.5).

FIGURA N° 5. 5. En la imagen MNF las flechas blancas indican la presencia de drenajes. Igualmente la variacion de colores
indica variaciones en la litologia.
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5.3 IMAGEN PPI

El tercero de los subproductos generados es la imagen PPI, que como se
observa en la imagen de abajo (ver FIGURA 5.3), destacan en color blanco aquellos
pixeles considerados puros dentro de la imagen, los cuales son mayoritarios hacia la

zona central de la imagen.
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FIGURA N° 5. 6. Imagen PPl generada en el software ENVI 4.2, en el recuadro blanco se encuentra el area de estudio.

En la siguiente figura (ver FIGURA N° 5.6) se observa la mayor acumulacién
de pixeles puros en la parte centrooccidental del area de estudio, caracterizandose por

seguir el alineamiento de la zona de alto relieve.
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FIGURA N°5. 7. Imagen PPl con el area de estudio encerrada en el recuadro azul. La linea roja representa el limite entre las
zonas de mayor presencia de pixeles puros de las zonas de menor presencia de pixeles.

5.4 N-DIMENSIONAL

FIGURA N°5. 8. Imagen que muestra las clases obtenidas luego de ejecutado el proceso del N-Dimensional.

El N-Dimensional es un subproducto que sirvid para agrupar en clases los
pixeles puros que conforman la imagen, para posteriormente aplicar el procedimiento

del SAM a las clases identificadas en este proceso (ver FIGURA N° 5.8).
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5.5 IMAGEN SAM
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FIGURA N°5.9. A laizquierda la imagen MNF y a la derecha una de las clases identificadas en el proceso del N-Dimensional,
donde se puede apreciar la cantidad de pixeles puros que representan esa clase y el espacio que ocupan en el area seleccionada.

Con la aplicacion del SAM se pudo determinar cuales de las clases

encontradas con la ayuda del visualizador N-Dimensional existen en realidad,

descartando aquellas que no se encontraban dentro del rango preestablecido.

Posteriormente, aquellas clases que por su condicion angular se comprobd su
existencia, fueron combindndose una a una con la imagen MNF, para ser ubicadas
dentro del area de estudio y ver su correspondencia con la imagen, lo que ayudo en la

determinacion de los puntos reales en la imagen (ver FIGURA 5.9).

5.6 CLASIFICACION NO SUPERVISADA

Al introducir el numero de clases (20) para realizar la division de la imagen
LANDSAT correspondiente a la region de Perija, se obtuvo una variada distincion de
litologias que van desde blandas hasta duras, pasando por clasificaciones intermedias
como lo son litologias semi-blandas o semi-duras. En un principio s6lo dos colores
delimitan dichas clases, el negro absoluto determinando las sombras tanto de nubes

como de filas, y por otro lado, el blanco absoluto determinando las nubes. EI color
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azul se asigna para los drenajes, aunque existen drenajes que se aprecian lo
suficientemente oscuros como para relacionarlos con el negro. El tipo de relieve es
un factor clave para la clasificacion, debido a que el relieve de topografia alta se
asocia con rocas que presentan litologia de mayor resistencia a la erosion y
meteorizacion; a diferencia del relieve con topografia baja el cual se asocia a rocas
que presenten litologia de menor o poca resistencia a los efectos de la erosion y
meteorizacion. Al relieve intermedio se asociaron litologias que se encuentran

comprendidas en la escala de dureza entre duro y blando.

i Vieweer #1 : clasnosuper.img (:Layer_1)
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FIGURA N° 5. 10. Imagen de la clasificacion NO supervisada realizada a la imagen reflectance.
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TABLA N° 2. En esta tabla se aprecia la distribucion de las clases generadas por el software ERDAS Imagine 8.6 y corresponde
con la imagen FIGURA 5. 5.

En el siguiente ejemplo se muestra el resultado de la aplicacion de la
clasificacion No supervisada. En primera instancia se procede a solapar el mapa
geologico de Duerto (1998) sobre la imagen FLAASH con las divisiones de clases
(ver FIGURA 5.11), donde, luego se relacionan los datos del tipo de litologia
recopilados en la bibliografia que conforman las diferentes formaciones presentes en
la zona, con los obtenidos de la interpretacion de la clasificacion No supervisada;
presentando de ésta forma, un resultado preliminar que refleja concordancia en la
ubicacion de las formaciones cartografiadas por dicho autor con el tipo de litologia
que la componen. Seguidamente se verifican los resultados obtenidos en el mapa
solapando el shapefile de las formaciones (ver FIGURA N° 5.12) en la imagen de la
clasificacion No supervisada, observandose una mayor exactitud en la coincidencia

en la ubicacion de las mismas.

En el caso ilustrado en la FIGURA N°5.13, las formaciones Mirador,
Carbonera, La Sierra, La Villa y el Grupo Orocu¢; son so6lo una muestra de la

aplicacion y utilidad de la herramienta que incluye la clasificacion No supervisada.
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FIGURA N° 5. 11. Relacién de la clasificacion No FIGURA N° 5. 12. Relacion de la clasificacion NO
supervisada con el mapa de Duerto (1998) supervisada con el mapa producto.

(Se utilizan estos mapas a manera de establecer una comparacion visual del resultado, la ubicacion de los contactos es relativa,

no es exacta por la diferencia de escala que existe entre estos mapas y la imagen)
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FIGURA N° 5. 13. Se aprecia las diferencias entre las clases que identifican a las formaciones: Mirador (azul claro con
tonos marrones), Carbonera (azul claro con tonos verde), La Sierra (azul claro, azul oscuro, naranja y rosado), La Villa
(rosado) y Grupo Orocué (azul oscuro)

5.7 CLASIFICACION SUPERVISADA

Con la ayuda de el mapa geologico de Perija realizado por Duerto (1998), se

establecié una relacion entre la litologia presente en el mapa con la observada en la
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imagen LANDSAT (solo el territorio venezolano), lo cual gener6 como resultado 13
clases que describen los diferentes tipos de litologia pertenecientes a las formaciones
que conforman el area de estudio. En esta parte también se toman en cuenta las zonas
oscuras (sombras de nube) y las claras (nubes) como dos clases que no se relacionan
con litologias pero que si afectan en el momento de demarcar dichas formaciones.
Dentro de la zona delimitada por el shapefile “area” (la cual representa la

region de estudio) se establecieron las siguientes formaciones como principales

indicadoras de litologia:

» Formacion La Sierra (representada en color amarillo)

» Formacion Carbonera (representada en color rojo)

» Formacion Mirador (representada en color ocre)

» Formacion Coldn-Mito Juan sin diferenciar (representada en color verde

0scuro)

» Grupo Orocué (representada en color cyan)

» Formacion Luna (representada en color verde claro)

» Formacion Quinta (representada en color azul)

» Formacion Rio Negro (representada en color verde claro)

» Grupo Cogollo (representada en color rojo ladrillo)
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FIGURA N° 5. 14. Representacion de las clases que integran la Clasificacion Supervisada.

En la imagen de la clasificacion supervisada se lograron cotejar la ubicacion
de algunas de las formaciones presentes en el area de estudio, con relacion a los
mapas existentes, tal como lo demuestran los tres ejemplos que se presentan a

continuacion:

5.7.1 Ejemplo 1: Formacién La Quinta

El primer ejemplo muestra la ubicacion de la Formacion La Quinta, la cual se
encuentra representada por los dominios de color azul dentro de la imagen de
clasificacion supervisada (ver FIGURA 5.17). Colocando como base la imagen
FLAASH, se puede apreciar que la formacion mencionada anteriormente, se encuentra
ubicada de manera correspondiente con respecto al mapa geologico de Chaplet (1999)

(ver FIGURA 5.15) y al de Duerto (1998) (ver FIGURA 5.16).
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FIGURA N° 5. 15. Laimagen muéstra la Fm.La Quinta =~ FIGURA N° 5. 16. La imagen muestra la Fm.La Quinta
en el mapa de Chaplet (1999), el cual esta superpuesto en el mapa de Duerto (1998), el cual esta superpuesto
sobre la imagen FLAASH. sobre la imagen FLAASH.
(se utilizan estos mapas a manera de establecer una comparacion visual del resultado, la ubicacion de los contactos es relativa,
no es exacta por la diferencia de escalas que existe entre estos mapas y la imagen)
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FIGURA N° 5. 17. La imagen muestra la una seccion de la clasificacion supervisada en donde el dominio del color azul
representa a la Formacion La Quinta (azul oscuro) correspondiendo asi con lo propuesto por Duerto (1998) y Chaplet (1999) .

5.7.2 Ejemplo 2: Formacién La Villa

El segundo ejemplo muestra la ubicacion de la Formacion La Villa, la cual se

encuentra representada por los dominios de color fucsia dentro de la imagen de
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clasificacion supervisada (ver FIGURA 5.19). Colocando como base la imagen
FLAASH, se puede apreciar que la formacion mencionada anteriormente, se encuentra
ubicada de manera correspondiente con respecto al mapa geologico de Duerto (1998)

(ver FIGURA 5.18), aunque ocupando una menor extension areal.
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FIGURA N° 5. 18. Mapa de Chaplet (1999) donde se observa la Fm. La Villa en color rosado.
(se utiliza este mapa a manera de establecer una comparacion visual del resultado, la ubicacion de los contactos es relativa, no es
exacta por la diferencia de escala que existe entre estos mapas y la imagen)

ulo - Archiap - ArcView

Fle Edt wiew Insert Selection Tools Window Help
Editor * ‘ >|[- Task: [Create New Feature LI‘Target:l j‘x@‘|u@ﬁ@|@ 5k} @‘Bﬂmnz- |
DEed& & B | e ‘\-I;|11ssana = ”E‘ & EI| x? J o < | Layer: [clasifsuper.ma BRCRAr.
o 7 ; S 7 : y el
@
@
o
@
*
»
1
&
i
24
&
4
5 Ry
28 4 v b ‘]_I'
a4 »
Drawing = & (0@ O~ A~ 7 [0 Al it Bz o A BB o~
| [743085,18_1089478,82 Meters |

FIGURA N° 5. 19. En la imagen las zonas con dominio de color fucsia representan la Fm. La Villa dentro de la clasificacion
supervisada.
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5.7.3 Ejemplo 3: Formaciéon Mirador

El tercer ejemplo muestra la ubicacién de la Formacion Mirador, la cual se
encuentra representada por los dominios de color rojo dentro de la imagen de
clasificacion supervisada (ver FIGURA 5.22). Colocando como base la imagen
FLAASH, se puede apreciar que la Formaciéon mencionada anteriormente, se
encuentra aproximadamente ubicada de manera correspondiente con respecto al mapa
geologico de Chaplet (1999) (ver FIGURA 5.20) y al de Duerto (1998) (ver FIGURA
5.21).
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FIGURA N° 5. 20. La imagen muéstra la Fm.Mirador FIGURA N° 5. 21. La imagen muestra la Fm.Mirador
en el mapa de Chaplet (1999), el cual esta superpuesto en el mapa de Duerto (1998), el cual esta superpuesto
sobre la imagen FLAASH. sobre la imagen FLAASH.
(se utiliza este mapa a manera de establecer una comparacion visual del resultado, la ubicacion de los contactos es relativa,
no es exacta por la diferencia de escala que existe entre estos mapas y la imagen)

= Sin Hi Arebap - AreWiow
B (0 ow foet Section Lok Wedem b
B | M| 4|~ [ = I =[x 1| G - [ -

shat TR0 OO0 Metrs

FIGURA N° 5. 22. En la imagen se observa a la Fm. Mirador representada por el dominio de color rojo dentro de la
clasificacion supervisada.
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5.8 COMBINACION DE BANDAS

De la combinacion de las bandas que componen la imagen LANDSAT, se
pueden obtener ciertas combinaciones que resalten algunas caracteristicas en
especifico dentro de la imagen, es asi que durante la fase de generacion de los
shapefile de los distintos rasgos geologico se efectud la combinacion de las mismas,

resultando las de mayor utilidad las que se mencionan a continuacion:

5.8.1 Combinacién de bandas 3-2-1

Esta combinacion es la que mas se acerca a los colores reales (ver FIGURA
5.22) y constituyo la combinacion base del analisis, siendo de mucha utilidad para la
divisién de formaciones (ver FIGURA N° 5.2) y para la diferenciacion de las zonas
de alto relieve de las de bajo relieve (ver FIGURA 5.22). Dicha combinacién
consistio en colocar en el caidn 1 (espectro color azul), la banda N°3; en el cafion 2
(espectro color verde), la banda N°2; y en el cafidon 3 (espectro color rojo), la banda

N°l.
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FIGURA N° 5. 23. La imagen muestra el archivo FLAASH abierto con la combinacion 3-2-1 y en esta se observa como
resaltan aquellas zonas donde hay cambios de vegetacion, llegandose a diferenciar zonas de alto relieve y de relieve intermedio.
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5.8.2 Combinacién de bandas 4-5-3

Esta combinacion fue de mucha utilidad para la identificacion y ubicacion de
drenajes, accidentes topograficos y estructuras dentro del area de estudio debido a que
se logran apreciar con mayor claridad los cauces, relieve topografico y anomalias en
¢l (ver FIGURA 5.23). Adicionalmente, con esta combinacion fue posible establecer
contactos entre litologias, pues en ella se aprecian cambios de color que indican tales
variaciones. Dicha combinacion consistié en colocar en el caién 1 (espectro color
azul), la banda N°4; en el candn 2 (espectro color verde), la banda N°5; y en el

cainon 3 (espectro color rojo), la banda N°3.
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FIGURA N° 5. 24. Imagen FLAASH con la combinacion de bandas 4-5-3. Se puede observar como con esta combinacion
resaltan los drenajes, la topografia y variaciones litologicas. Formacion La Villa (diferenciada en el color verde claro).

5.8.3 Combinacion de bandas 4-5-6

Al igual que la combinacién anterior, esta fue de mucha utilidad para la
identificacion y ubicacion de drenajes (ver FIGURA 5.25), aunque con esta

combinacion se resaltan notoriamente los accidentes topograficos y estructuras dentro
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del area de estudio (ver FIGURA 5.26). Por otro lado, esta combinacién permitid
establecer diferencias entre zonas humedas y zonas de alto relieve, donde la litologia
se diferencia claramente por sus colores. Dicha combinacion consistid en colocar en
el candn 1 (espectro color azul), la banda N°4; en el cafion 2 (espectro color verde),

la banda N°5; y en el cafidn 3 (espectro color rojo), la banda N°6.
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FIGURA N° 5. 25. Imagen FLAASH con la combinacién 4-5-6, en donde se puede apreciar resaltan principalmente los

drenajes.
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FIGURA N° 5. 26. Imagen FLAASH con la combinacion 4-5-6, en donde resalta la topografia y las estructuras.
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5.8.4 Combinacién de bandas 3-4-5

Con esta combinacion se aprecian los cambios de vegetacion, resultando de
mucha utilidad para identificar las variaciones de las litologias que componen la zona
baja del area de estudio, ademds de resaltar la topografia de las zonas altas, lo que
facilitd la wvectorizacion de los drenajes que se encuentran en esas zonas.
Adicionalmente, esta combinacion es 1til para el reconocimiento e identificacion de
estructuras y diferenciacion de las zonas por su contenido de vegetacion, pues la
intensidad del color verde indica zonas de mayor presencia de vegetacion (ver
FIGURA N° 5.27). Dicha combinacion consistid en colocar en el cafion 1 (espectro
color azul), la banda N°3; en el cafidon 2 (espectro color verde), la banda N°4; y en el

cafion 3 (espectro color rojo), la banda N°5.
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FIGURA N° 5. 27. Imagen FLAASH con la combinacion 3-4-5, en donde resalta los cambios de vegetacion.
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5.9 MODELO DIGITAL DE ELEVACION

El modelo digital de elevacion constituy6 una herramienta muy valiosa para la
definicion de los rasgos estructurales como: corrimientos, fallas locales y pliegues
(anticlinal Rio Negro) dentro del area de estudio, debido a que proporciona una visién

en tres (3) dimensiones de la misma.

Con la utilizacion del modelo digital de elevacion se pudo establecer una clara
diferencia entre las zonas de alto y bajo relieve, logrando ubicar hacia la parte este de
la zona de estudio un area de relieve intermedio, donde se encuentran localizados un
grupo de cerros que ocupan gran parte de esa zona y que en la imagen reflectance (y
en otras imagenes) fue inferido como una zona baja a intermedia, caracterizada por
ser bastante himeda (ver FIGURA N° 5.28). Entre ese grupo de cerros es posible

identificar los cauces de los rios y su respectivas planicies de inundacion.

FIGURA N° 5. 28. MDE donde se pueden observar la zona de cerros hacia la parte este del area de estudio y una zona de
planicie hacia el sur-centro. Hacia el sureste se puede apreciar un hundimiento imposible de determinar con vistas en planta o
2D.
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Por otro lado, hacia la parte sur-central de la zona de estudio se identifico una
zona de bajo relieve, mientras que un poco mas hacia el sureste del area se visualiza
un hundimiento que no es posible apreciar con la vision en 2D (ver FIGURA N°

5.28).

FIGURA N° 5. 29. Ejemplo del MDE que muestra los corrimientos presentes en la zona y su cierto paralelismo.

El MDE fue una herramienta muy util en la observacién y ubicacion de los
corrimientos presentes en la zona, tal y como se aprecia en la imagen superior (ver

FIGURA N° 5.29) y en la imagen inferior (ver FIGURA N° 5.30).

FIGURA N° 5. 30. Ejemplo del MDE que muestra los corrimientos presentes en la zona y su cierto paralelismo.
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5.10 PRINCIPALES CARACTERISTICAS HIDROLOGICAS Y
GEOLOGICAS DEL MAPA GENERADO

5.10.1 Drenajes

Uno de los sub-productos generados durante el procesamiento de la imagen es
el archivo shapefile de los drenajes (ver FIGURA 5.31), el cual fue creado
vectorizando los mismos y una vez obtenido este shapefile se realizd un analisis
general del conjunto de drenajes representado en la propuesta de mapa realizada y del
cual se desprende la diferenciacion de al menos tres secciones, a nombrar como

seccion este, seccion central y seccion oeste.

La seccion este del mapa se encuentra caracterizado por la escasa presencia de
drenajes en la zona sur, destacando el Cafio Televambio, el cual cuenta con una
orientacion preferencial este-oeste. Hacia la parte norte de esta seccion la cantidad de
drenajes es mucho mas densa y en ella se pueden identificar dos rios principales, el
Rio Negro (més Al norte) y el Rio Yasa (mas al sur). Ambos rios tienen una
orientaciéon preferencial noroeste-sureste y destaca su pseudo paralelismo. Es
importante sefialar, que por la cantidad de nubes presentes en la zona sur de la

imagen, se dificult6 la identificacion de drenajes en dicha area.

En la seccion central del mapa, se puede apreciar cobmo se conserva el
paralelismo entre el Rio Tucuco y el Rio Sucumo, los dos drenajes principales que
componen esta area. Dichos drenajes se encuentran hacia la zona sur de la seccion y
poseen una orientacion preferencial que es casi norte-sur, aunque a medida que se
avanza hacia el norte la orientacion de ambos drenajes va cambiando hasta quedar
casi este-oeste. Los patrones de drenajes de los principales rios afluentes se presentan
con cierto grado de paraleslismo entre si, destacando hacia el sur de la seccion la

presencia de unos pocos drenajes ramificados.
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La seccion oeste, es un poco menos densa que la seccion central en cuanto a la
cantidad de drenajes presentes en la misma y se encuentra definida por un drenaje
principal de orientacion preferencial noreste-suroeste, cuyos principales afluentes son
un grupo de drenajes orientados con direccidon noroeste-sureste, con los cuales se
intercepta formando angulos fuertes, llegando a ser casi perpendiculares entre si.

Este grupo de afluentes se presentan arreglados de forma paralela entre ellos.

A manera muy general, se tiene que existe gran concordancia en lo que se
refiere a la orientacion y ubicacion de los drenajes identificados en la imagen satelital
y los drenajes propuestos en mapas anteriores, teniendo en cuenta la existencia de
desplazamientos relativos con respecto al sitio por donde se ubico el drenaje. En el
caso de la seccion este, se logra apreciar un considerable cambio con respecto al
ancho del cauce de cada una de las vertientes que lo componen, siendo mucho mas
amplio lo cartografiado en el mapa geologico de Chaplet (1999), lo que indica una
posible mayor superficie de inundacion al momento de que se tomo la informacion.
En lo que respecta a la seccion central, presenta vertientes que concuerdan con las
mostradas en el mapa geoldgico de Chaplet (1999), a diferencia del cauce principal

donde éstas desembocan, el cual no se encuentra cartografiado en dicho mapa.

Los drenajes interpretados son en parte, resultado de zonas de nubosidad que
de alguna u otra forma cortan la trayectoria de un drenaje en particular. En la region
de la superficie de maxima inundacién (seccion este de la imagen), se aprecian
algunos cauces abandonados producto de épocas de sequia. Dichos cauces, marcan el
gran aporte de sedimentos por parte de los drenajes provenientes de la Serrania de los

Motilones en época de lluvia.
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FIGURA N° 5. 31. Shapefile con drenajes interpretados y en el se pueden apreciar algunas de las caracteristicas descritas
anteriormente.

5.10.2 Estructuras

Las estructuras presentes en el area de estudio (ver FIGURA 5.32) estan
representadas principalmente por los corrimientos que dominan la parte central; el
primero (Cil) ubicado hacia el oeste del mapa, el segundo (Ci2) ubicado en la parte
central y un tercero (Ci3) ubicado mas hacia el este, presentan una misma direccion
preferencial noroeste-sureste; demostrando de esta manera pseudoparalelismo entre
ellos. Estos grandes corrimientos controlan toda la parte estructural de esta zona de la
Sierra de Perija, formando una region plegada y fallada entre la Serrania de los
Motilones y la superficie de maxima inundacion. Existen fallas (Fil, Fi2, Fi3, Fi4)
que presentan direcciones con cierto grado de perpendicularidad a los corrimientos,
las cuales se encuentran ubicadas entre los corrimientos Cil y Ci2. Las fallas Fil y
Fi2, ubicadas en la parte norte del mapa presentan una direccion preferencial este-
oeste; a diferencia de ellas, las fallas Fi3 y Fi4, que se encuentran en la parte sur del

mapa presentan una direccion noroeste-sureste.
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Las fallas interpretadas son producto de:

» Zonas de nubosidad que interrumpen el lineamiento continio de una falla en
particular.

Fallas observadas que no se presentan cartografiadas en los mapas geologicos de
Duerto (1998) y Chaplet (1999).

Fallas presentes en los mapas geoldgicos de Duerto (1998) y Chaplet (1999) que
no fueron apreciadas debido a discrepancias con las apreciaciones de dichos

autores; o por la densa nubosidad presente en la zona.

La morfologia de la Serrania de los Motilones es controlada por un anticlinal

(Anticlinal Rio Negro) que se encuentra ubicado hacia el oeste del mapa, paralelo al

corrimiento (Cpl), el cual es producto de la compresion generada por las capas que

componen el frente de dicho corrimiento.
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FIGURA N° 5. 32. Shapefile con las estructuras interpretadas por nosotros y las propuestas por otros autores.
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5.10.3 Litologia

Los contactos litoloégicos estan demarcados de acuerdo a las formaciones
presentes en la zona; las cuales se determinan a través de la clasificacion supervisada
y la cartografia de las mismas en los mapas geologicos de Duerto (1998) y Chaplet
(1999), la cual sirvi6 de guia para la realizacion del mapa geologico 1:50.000

presentado.

La delimitacion de las formaciones que componen el mapa propuesto en este
trabajo, se determind utilizando la imagen MNF en la cual se percibe de manera
superficial la forma de las formaciones presentes; seguida de la comparacion de las
firmas espectrales de sectores en particular donde se logran apreciar las diferencias o
similitudes basadas en la vegetacion, tipo de suelo y su composicién mineralogica de
dos o mas zonas de interés que pertenezcan a una o varias formaciones en particular;

de este modo se logra demarcar con exactitud los limites entre ellas.

A continuacién se muestra ejemplos graficos que permiten visualizar el
procedimiento utilizado en la demarcacion de los limites de las formaciones
explicado anteriormente: en la siguiente figura se aprecian los diferentes tipos de
firmas espectrales que permiten diferenciar los limites de las extensiones geograficas
de las formaciones La Luna, Colon Mito-Juan (sin diferenciar) y el grupo Cogollo;
donde se logran discriminar a la Formacion La Luna en las bandas 2, 5 y 6 con
respecto a la Formacion Colén Mito-Juan (sin diferenciar); esto es debido a que ésta
Formacion, posee una vegetacion, humedad y mineralogia diferente a la Formacion
La Luna. Asi mismo, el grupo Cogollo presenta diferencias en sus firmas espectrales

con respecto a las otras dos formaciones.

En la FIGURA N°5.33 se muestran las firmas espectrales pertenecientes a las

formaciones: La Luna, Colon Mito-Juan (sin diferenciar) y el grupo Cogollo.
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FIGURA N° 5. 33. Firmas espectrales que representan a las formaciones La Luna (verde oscuro), Colon Mito-Juan (sin
diferenciar) en fucsia y el Grupo Cogollo (verde claro).

Al comparar los resultados obtenidos con el mapa geoldgico de Chaplet
(1999) se logra apreciar que existe discrepancia con respecto a las extensiones
territoriales de algunas formaciones, sobre todo en la parte este de la imagen, donde
el Cuaternario ha extendido sus limites abarcando parte de lo establecido como Grupo
El Fausto por el mencionado autor, esto se atribuye al gran aporte de sedimentos por
parte del Rio Sucumo, donde en su desembocadura se encuentra la superficie de
maxima inundacion que cubre el afloramiento de dicho grupo, disminuyendo de esta
forma su extension actual. Otra discrepancia se basa en el hecho de que Chaplet
(1999) cartografio el Grupo El Fausto abarcando una gran extension alargada
pseudoparalela al corrimiento situado en la parte este de la zona central de la imagen,
donde, a través de firmas espectrales, se corrobord la presencia de la Formacion La
Sierra que concuerda con la cartografia realizada de dicha Formacioén en el mapa

geoldgico de Duerto (1998). La extension de la Formacion La Sierra en el mapa
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geologico de Chaplet (1999) es de menor envergadura y se encuentra ubicada mas

hacia el oeste.

En la FIGURA N° 5.34 se aprecia las firmas espectrales correspondientes a la
Formacion La Sierra y Grupo El Fausto, que reflejan diferencias significantes en las
bandas 2, 3, 4, 5 y 6 que representan vegetacion, humedad y mineralogia; cabe
destacar que en las bandas 2 y 3, la Formacion La Sierra, presenta valores por debajo
del Grupo Cogollo, en cambio para la banda 4 se muestra una variacion contraria,

siendo los valores de la Formacion La Sierra mayores que el Grupo Cogollo.
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FIGURA N° 5. 34. Firmas espectrales que representan a las formaciones La Sierra (amarillo) y el Grupo El Fausto (verde).

Las extensiones de las formaciones Mirador, Carbonera, Grupo Orocué
presentan variaciones con respecto a la cartografia del mapa geoldgico de Duerto
(1998). El Grupo Orocué abarca una mayor extension, mientras que las formaciones
Mirador y Carbonera presentan una ruptura en la continuidad de su extension, la cual,

segun la comparacion de sus firmas espectrales, pertenece al Grupo Orocué.
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En la FIGURA N° 5.35 se logra apreciar las diferencias que presentan las
firmas espectrales que pertenecen a las formaciones Carbonera, Mirador y Grupo
Orocué en las bandas 4, 5 y 6, donde el Grupo Orocué presenta valores inferiores a

las demas formaciones; siendo caso contrario, la Formaciéon Mirador.
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FIGURA N° 5. 35. Firmas espectrales que representan a las formaciones Carbonera (anaranjado), Mirador (crema) y el
Grupo Orocué (aquamarina).

Con la ayuda de la imagen MNF vy las firmas espectrales se logré diferenciar y
cartografiar las formaciones pertenecientes al Grupo Cogollo; siendo éstas las
formaciones Lisure y Apdn que se encuentran demarcadas entre las formaciones Rio
Negro y Colén Mito-Juan (sin diferenciar); coincidiendo con las cartografiadas en el
mapa geologico de Chaplet (1999), a diferencia del mapa geologico de Duerto
(1998), donde el Grupo Cogollo estd representado como una sola unidad. En la
FIGURA N° 5.36 se muestran las diferencias que presentan las Formaciones Apon y
Lisure en las firmas espectrales. Cabe destacar, que a pesar de la similitud que poseen

ambas en la banda 4, se logra diferenciar las litologias afines que determinan su
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asociacion al Grupo Cogollo debido a las marcadas diferencias que se aprecian en el

resto de las bandas.

& Siganturs Mean Plot

<
TAGLI0. B9, 1I019YS.02 (UTM | WS 84)

FIGURA N° 5. 36. Firmas espectrales que representan y diferencian al Grupo Cogollo en: Formacion Lisure (marrén) y
Formacion Apoén (verde oliva).
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CAPITULO VI

CONCLUSIONES

Los softwares ARGIS, ERDAS y ENVI, son programas que se presentan como
herramientas para la realizacion y modificacion al detalle de imagenes y mapas de
zonas en particular; debido a esto, se puede contar con actualizaciones cartograficas
de areas de dificil acceso o de relativa lejania al lugar de trabajo. Cabe destacar, que
los trabajos previos realizados en la zona de interés (mapas geologicos, estructurales,
topograficos, de aguas, etc.), sirvieron de referencia estableciendo una relacion con
los resultados finales debido a que se parte de una sélida base de informacion

geologica.

Procesos como la clasificacion No Supervisada y la Supervisada realizada en
el software ERDAS, permiten conocer y relacionar la topografia y el relieve, asi como
también las diferencias que puedan existir entre la vegetacion, tipo de suelo y sus
desiguales composiciones (sin poder diferenciar con exactitud tipo de roca, tamafio de
grano, ni composicion mineralogica). Estas ventajas permiten diferenciar los tipos de
materiales que conforman el area donde fue tomada la imagen satelital. Esto se

realiza mediante las firmas espectrales que poseen cada uno de dichos materiales.

La clasificacion No Supervisada realizada en este trabajo presento 20 tipos de
clases, donde se aprecia la presencia de una gran variedad de cuerpos litoldgicos que
van desde litologias menos resistentes hasta mas resistentes, presentando escalas
intermedias entre ellas. Esta clasificacion representa el primer paso para el
reconocimiento de la zona de estudio, sirviendo para familiarizar el conocimiento
obtenido en la recopilacion bibliografica con el contenido de material presente en el

area de interés.
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En la clasificacion Supervisada se empled una de las herramientas mas
importantes y determinantes para la obtencion de los resultados, como lo son las
firmas espectrales. La comparacion de dichas firmas permitid la reduccion de clases,
debido a que poseen caracteristicas similares que permiten agruparlas; siendo de este
modo, ahora de 13 tipos de materiales. Estas clases obtenidas se relacionaron tanto
con la recopilacion bibliografia como con los trabajos previos realizados en la zona,

los cuales incluyen a los mapas geologicos de Chaplet (1999) y Duerto (1998).

El software ARGIS posee herramientas efectivas y determinantes en la
generacion de mapas; una de ellas es la creacion de shapefiles que sirven para separar
los diferentes elementos que componen un mapa geoldgico. El concepto de crear
varios shapefiles que representen a distintos elementos es poder analizar con detalle a
cada uno; de esta forma se obtiene una mayor eficacia en el producto final. De este
modo, se procedi6 a realizar 8 shapefiles que representan a los drenajes, fallas
propuestas, fallas inferidas, corrimientos propuestos, corrimientos inferidos,

anticlinal, buzamiento y formaciones presentes en el area de estudio.

El shapefile asociado a los drenajes muestra tres secciones que en general
representan la descripcion del sistema formado; la seccidon este presenta dos drenajes
principales (Rio Yasa y Rio Negro), conformando un sistema alargado con cierto
grado de paralelismo entre ellos; es la seccidn con menos drenaje mostrado debido a

la densa nubosidad mostrada en la imagen para la fecha en que fue tomada.

La particularidad de la seccidon central, es que el sistema se encuentra
controlado por la actividad estructural dominante del area de estudio, y se logra
apreciar debido a los cambios bruscos de direccion que sufren rios Tucuco y Sucumo
aunado al paralelismo presentado por los tributarios, conformando de esta forma un

patron general de drenaje reticulado.
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El sistema montafioso que conforma la parte oeste de la zona, define a la
tercera seccion, debido a que los tributarios del rio Yasa son los dominantes de la

zona, presentando paralelismo entre ellos.

La parte estructural esta representada por los shapefiles que incluyen las fallas
y corrimientos tanto inferidos como propuestos en el presente trabajo. Grandes
corrimientos controlan la parte central de la zona, donde se aprecia el apilamiento de
las capas con algunas fallas producto de la compresion generada por los corrimientos
Cpl y Cp2. A esto, se asocia la presencia del Anticlinal Rio Negro que conforma la

Serrania de los Motilones, la cual se presenta de forma paralela al corrimiento Cpl.

La utilizacion del Modelo Digital de Elevacion constituyd una herramienta
muy efectiva en la descripcion de la topografia, y en el reconocimiento y ubicacion de
estructuras, que con la interpretacion de la imagen en dos (2) dimensiones no
resultaba del todo facil reconocer. Con esta herramienta se logro corroborar la

alineacion de los corrimientos interpretado.

De manera simultanea se logré comparar los resultados generados en los
shapefiles con los datos geoldgicos cartografiados en los mapas geologicos de Duerto
(1998) y Chaplet (1999); donde se encontraron algunas discrepancias atribuidas a
diferentes factores asociados a: diferencia de escalas, diferencias de criterios basados
en el tipo de herramientas empleadas para la obtencion de los datos que conforman la
cartografia de la zona; en el caso de los autores citados, la accesibilidad a la zona de
estudio pudo influir en la toma de datos y muestras que permitan corroborar la
presencia de los diferentes aspectos geoldgicos que conforman la zona; a diferencia
de la interpretacion personal empleada producto de la utilizacion de las herramientas
que componen los programas ejecutados para la obtencion del producto final, siendo
éste un Mapa Geolodgico-Estructural de la zona de Guarani presentado a escala
1:50.000; el cual presenta la actualizacion cartografica geoldgica de la Sierra de

Perija mediante la utilizacion de imagenes satelitales LANDSAT 7 ETM.
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Finalmente con los resultados de la investigacion realizada en este trabajo se
concluye que se logré cumplir con el objetivo principal, generando el mapa
actualizado a escala 1:50.000 del area comprendida entre las coordenadas 9°40" a
10°00" latitud oeste y 72°30°a 73°05" longitud norte, solventando la dificultad que se

tiene la realizacion de estudios geoldgicos en zonas de dificil acceso.
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RECOMENDACIONES

> Utilizar la imagen que presente la menor nubosidad posible, esto radica en la
fecha de la toma de la misma. Se debe verificar entonces, que la imagen
seleccionada presente la suficiente claridad posible para poder apreciar con

mejor exactitud los aspectos geoldgicos a resaltar.

> Utilizar la combinacion de las herramientas como la imagen MNF, firmas
espectrales, clasificacion Supervisada y No supervisada para la obtencion de
la ubicacidén de las formaciones en el mapa producto; asi como también el
empleo de la combinacion de bandas para una mejor apreciacion de las

estructuras y drenajes.

> De manera general, se recomienda la utilizacion de los programas ENVI,
ARGIS y ERDAS para la obtencion del anélisis de la geologia presente en una
region especifica que presente dificil acceso y que requiera estudios o

actualizaciones de la cartografia geologica.

> No se debe sustituir la geologia de campo por la geologia interpretada del

andlisis de las imagenes de tipo LANDSAT 7 ETM.

> Debido a la incompatibilidad de los programas ARGIS Y ERDAS, se debe
tener en cuenta que su funcionamiento ha de ser por separado por los
problemas que presentan con las licencias; esto produjo cierto grado de retraso

en el trabajo.

> Realizar la instalacion de dichos programas en Windows XP, debido a la

incompatibilidad con el nuevo software Windows Vista.

200 | Caires y Jaimes, 2008



ACTUALIZACION DE LA CARTOGRAFIA GEOLOGICA DE LA SIERRA DE PERIJA MEDIANTE LA UTILIZACION DE RECOMENDACIONES
IMAGENES SATELITALES LANDSAT 7 ETM (Coordenadas 72 30" a 73 05° Long. Oeste y 9 40' a 10 00" Lat. Norte)

UNIVERSIDAD CENTRAL DE VENEZUELA

> El uso de mapas de menor o igual escala a la del producto que se planee,
debido a que se obtendra mayor detalle que conllevarad a mejor precision en

los resultados finales.
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